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1 What�s New in This Release
What�s New in Siebel Assignment Manager Administration Guide, 
Version 7.7
Table 1 lists changes described in this version of the documentation to support version 7.7 of the 
software. For default values and usage comments for each of the predefined assignment object 
properties, see Object Types Reference.

Table 1. New Product Features in Siebel Assignment Manager Administration Guide, Version 7.7

Topic Description

Delegated administration of 
assignment rules

See �Delegated Assignment� on 
page 50 and Chapter 6, 
�Assignment Rule Administration for 
Delegated Assignment�.

This new feature allows organizations to create a hierarchy of 
assignment rules so that partner organizations can receive 
leads or service requests and then apply their own 
assignment logic to the assignment rules.

Dynamic candidates

See �Dynamic Candidates� on 
page 47 and �Configuring 
Assignment Objects for Dynamic 
Candidates� on page 93.

This new feature allows administrators to dynamically bind 
candidates to assignment rules. Prior to version 7.7, 
candidates were statically assigned.

Expanded rule group support

See �About Different Modes of 
Running Assignment Manager� on 
page 22.

This enhancement provides the ability to configure 
Assignment Manager to load rules associated with a rule 
group without specifying a server key map. Assignment 
Manager can process a set of rules within a given rule set as 
opposed to all rules in a default set.

Better integration with Siebel 
Workflow

See �Assignment Manager 
Integration� on page 172.

This new feature provides Assignment Manager the ability to 
return results as a property set and allows Assignment 
Manager and Siebel Workflow to share inputs and outputs 
(supports rerouting of objects).

Ability to exclude a set of 
candidates from assignment

See �About Excluding Candidates 
from Assignment� on page 164.

This enhancement allows configuration so Assignment 
Manager can exclude (ignore) a particular candidate or 
candidates using the ExcludePersonList and ExcludeOrgList 
request-level server parameters.
Siebel Assignment Manager Administration Guide Version 7.7 ■ 9
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Ability to exclude expired 
(terminated) employees from 
assignment

See �About Excluding Expired 
(Terminated) Person Candidates 
from Assignment� on page 165.

This enhancement allows configuration so Assignment 
Manager can exclude (ignore) certain employees�such as 
inactive employees or employees on a leave of absence�for 
rule evaluation using a component-level server parameter. 
After assignment rules are released, the employees are 
ignored even if they are explicitly added to an assignment 
rule as candidates. 

Changes to the logging events and 
subevents used by Assignment 
Manager

See �Configuring Assignment 
Manager Event Logs� on page 168.

Assignment Manager uses four events, with four subevents 
for each event, for logging messages during startup and 
assignment of object rules. This enhancement allows more 
control of what Assignment Manager logs.

Prior to version 7.7, there were only two events with one 
subevent for each event.

Improved cache file management

See �About Assignment Manager 
Rule Cache Files� on page 25.

Assignment Manager uses several cache files (by server and 
rule group) and re-creates (updates) these cache files only if 
the rules are released.

Prior to version 7.7, there was only one cache file that often 
re-created itself even though none of the rules had changed.

Siebel ARM and FDR 
instrumentation

See System Monitoring and 
Diagnostics Guide for Siebel 
eBusiness Applications.

The Assignment Manager server component is enabled for 
Siebel Application Response Measurement (Siebel ARM) and 
Siebel Flight Data Recorder (FDR). Siebel ARM captures 
timing data useful for monitoring the performance of the 
Siebel application, and records this information to binary 
files. Siebel FDR is a feature of the Siebel application 
infrastructure that records system and server component 
data at run time.

Table 1. New Product Features in Siebel Assignment Manager Administration Guide, Version 7.7

Topic Description
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2 Assignment Manager Concepts
This chapter explains how Assignment Manager works and provides a high-level overview of how you 
can configure Assignment Manager to meet your organization�s needs. The topics include:

■ �Assignment Manager Concepts Overview� on page 11

■ �Assignment Manager Components Overview� on page 13

■ �Assignment Operation Modes� on page 44

■ �Dynamic Candidates� on page 47

■ �Delegated Assignment� on page 50

Assignment Manager Concepts Overview
Siebel Assignment Manager allows sales, service, and marketing organizations to assign the most 
qualified people to specific tasks. Assignment Manager accomplishes this function by matching 
candidates (that is, employees, positions, and organizations) to predefined and user-configurable 
assignment objects. To assign the most qualified candidate to each object, Assignment Manager 
applies assignment rules that you define to each candidate. For you to define assignment rules, you 
select:

■ Assignment object or objects to which each assignment rule applies

■ A rule group to which each assignment rule belongs

■ Candidates�person (employee or position), organization, or both�for each assignment rule

■ Criteria for each assignment rule

■ Values for each assignment criterion

For rules that match attributes of an assignment object with attributes of the candidates, you define:

■ Skills to match assignment rules or objects to employees, positions, and organizations

■ (Optional) Expertise levels to weigh skill scores (to measure competency in a certain area for 
each candidate) 

■ (Optional) Scores for each assignment rule, criteria, and value and a personal score for each 
individual candidate 

If you want to distribute the workload rules evenly between the candidates or if your business logic 
includes limits on the maximum amount of work that can be handled at one time, you define:

■ Workload rules to balance work among the candidates
Siebel Assignment Manager Administration Guide Version 7.7 ■ 11
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For example, in a sales organization, you can create an assignment rule that scores positions 
(candidates) based on territory definitions (criteria) for an opportunity (object). In a service 
organization, you can create an assignment rule that scores employees (candidates) based on 
product expertise (criteria) for a service request or product defect (object). Using the sum of scores 
at the assignment rule level, Assignment Manager assigns the best candidate for each rule and the 
best candidates for the object.

You can also customize the way Assignment Manager makes assignments by:

■ Defining how attributes are matched by using:

■ Different comparison methods

■ Making criteria required (compulsory) or optional

■ Inclusion and exclusion methods

■ Scores weighted based on expertise levels

■ Wildcard values

■ Defining how assignment rules are matched by using:

■ Assignment rule groups

■ Assignment rule sequencing

■ Defining how candidates are assigned by using multitiered assignment

■ Creating and configuring your own components, including:

■ Assignment objects

■ Assignment criteria

■ Assignment attributes

■ Running Assignment Manager in different operation modes to process assignments:

■ Interactively, in real time using Assignment Manager (AsgnSrvr) server component

■ Dynamically, when object rows are created or attributes on object rows are changed by 
connected or mobile users

■ Assigning objects in batches using the Batch Assignment (AsgnBatch) server component

■ Defining which servers are used to run selected groups of rules

■ Checking availability before assigning employees to objects
Siebel Assignment Manager Administration Guide Version 7.712 ■
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Assignment Manager Components 
Overview
Table 2 lists the Assignment Manager components and topics and where to find more information 
about each specific component.

Table 2. Assignment Manager Components

Component For More Information, See...

Assignment Manager screens and 
views

�Assignment Manager Administration Views� on page 14

Assignment objects �About Assignment Objects� on page 14

Assignment candidates �About Assignment Candidates� on page 16

Assignment rules �About Assignment Rules� on page 19

Assignment rule groups �About Assignment Rule Groups� on page 22

Server key maps �About Server Key Maps� on page 23

Assignment rule sequencing �About Assignment Rule Sequencing� on page 26

Assignment criteria and attributes ■ �About Assignment Criteria and Criteria Methods� on page 27

■ �About Column-Based Attributes Versus Row-Based Skills� 
on page 31

■ �About the Required Attribute for Assignment Criteria� on 
page 32

■ �About Assignment Criteria Values� on page 34

Assignment skills �About Assignment Skills� on page 37

Assignment scoring �About Assignment Scoring� on page 39

Assignment workload criteria �About Assignment Workload Criteria� on page 40

Activity-Based Assignment �About Activity-Based Assignment� on page 42

Availability-Based Assignment �About Availability-Based Assignment� on page 42

Multitiered Assignment �About Multitiered Assignment� on page 43
Siebel Assignment Manager Administration Guide Version 7.7 ■ 13
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Assignment Manager Administration Views
Assignment Manager functionality is administered with two administration screens:

■ Administration - Assignment. The assignment administrator (AA) uses the assignment 
administration views (Navigate > Site Map > Administration - Assignment) to create and 
administer assignment rules.

The AA creates rules and criteria, associates rules to particular rule groups (or the default rule 
group), and adds candidates for assignment to each rule. If using the delegated assignment 
feature, the AA also creates child rule groups and makes rules inheritable to the owners of those 
child rule groups.

AAs have visibility for rules only in their organizations but have unrestricted access to rule 
administration within those organizations.

For information about tasks performed by AAs, see the topics in Chapter 5, �Assignment Rule 
Administration.�

■ Administration � Delegated Assignment. Delegated administrators (DAs) use the delegated 
assignment administration views (Navigate > Site Map > Administration - Delegated 
Assignment) to inherit and refine assignment rules.

DAs inherit the rules and further specify assignment rule behavior and candidates using the 
delegated assignment views. DAs can also choose to delegate rule responsibility by creating child 
rule groups and making rules inheritable to the owners of those child rule groups. The refined 
rules can again be inherited and modified by other delegated administrators at a lower level in 
the hierarchy, and so on.

In the Administration � Delegated Assignment screen, rule group owners have visibility for their 
rule groups (and subtrees).

For information about tasks performed by DAs, see Chapter 6, �Assignment Rule Administration 
for Delegated Assignment.�

About Assignment Objects
In Siebel Assignment Manager, objects represent assignment entities to which candidates are 
matched based on assignment rules. The concept is analogous to business objects in Siebel 
eBusiness Applications. A number of predefined assignment objects are available for use by 
Assignment Manager for the most commonly-used business entities in Siebel eBusiness Applications. 
Some of the predefined assignment objects are: 

■ Account

■ Activity

■ Campaign

■ Campaign Contact

■ Contact

■ Opportunity
Siebel Assignment Manager Administration Guide Version 7.714 ■
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■ Order (Sales Credit Assignment)

■ Product Defect

■ Project

■ Project Team

■ Service Request

For more information about the predefined assignment objects, see �Creating Assignment Objects� on 
page 92 and Object Types Reference.

NOTE: The predefined assignment objects are intended for use as a guide and may not be applicable 
to your business needs. It is recommended that you review (and change) the configuration of these 
objects before using them.

If your deployment requires other objects, or if you need to modify predefined objects, you can 
create new objects and configure existing objects using Siebel Tools.

CAUTION: It is recommended that you contact Siebel Technical Support for assignment object 
creation. If you create your own assignment objects, you run the risk of Assignment Manager 
assigning incorrect assignments.

You must associate every assignment rule with at least one assignment object. To indicate an 
assignment object for an assignment rule, you choose an assignment object from the Objects to be 
Assigned multi-value group (MVG). For information about properties for each of the predefined 
assignment objects, see �About Assignment Object Properties� on page 15 and �Creating Assignment 
Objects� on page 92.

About Assignment Object Properties
Using Siebel Tools, you configure assignment object property values in the Siebel repository to 
control and customize the way objects are assigned. Some properties specify the basic definition of 
an assignment object, such as the name of the primary table in which object rows for the assignment 
object are stored, the name of the employee team table, the name of the employee primary column, 
and so on. Other properties control the behavior of Assignment Manager at run-time. For example, 
the Replace Team Members property controls whether candidates who no longer qualify for an 
assignment rule (or rules) should be removed from the team. 

For descriptions of and usage comments for each of the predefined assignment object properties, 
see Object Types Reference, and search for the following object types:

■ Assignment Object 

■ Assignment Attribute

■ Assignment Attribute Column

■ Assignment Criteria

■ Assignment User Prop

■ Dynamic Candidate

■ Dynamic Candidate Attribute
Siebel Assignment Manager Administration Guide Version 7.7 ■ 15
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To view or change the default values for each of the predefined assignment object properties, see 
Object Types Reference. 

NOTE: The default values provided in the Siebel repository for objects are provided as a guide and 
may not be applicable to your business requirements. Therefore, it is recommended you review the 
configuration of the predefined objects before using them.

For more information about configuring assignment object properties, see �Configuring Assignment 
Objects� on page 92.

About Assignment Candidates
In Siebel Assignment Manager, candidates represent the people or organizations who are evaluated 
as potential assignees for objects. Depending on the assignment rule you use, and the object to 
which a candidate is assigned, candidates can be positions, employees, or organizations, and can be 
assigned as individuals or as members of a team. When processing rules, Assignment Manager 
determines potential candidates either statically from an assignment rule or dynamically from an 
attribute on the object row.

Static means that candidates do not change before releasing rules (unless you intentionally associate 
other, different candidates). You associate candidates statically with an assignment rule by adding 
candidates to the Employee Candidates, Position Candidates, or Organization Candidates view tabs 
within the assignment rule. Alternatively, you can associate all people or all organizations as 
candidates for a rule. The following subtopics describe the different types of assignment candidates 
as well as primary assignees.

For information about dynamic candidates and dynamic candidate behavior, see �Dynamic 
Candidates� on page 47.

Employee Candidates
Employees represent candidates distinguished by their skills and product expertise, and are typically 
used as candidates in service organizations. For example, a service organization would want to 
assign employees with the proper skills and expertise to objects, because these employees possess 
specific skills that are related to the service request or activity. Assignment Manager can also take 
into account a specific employee�s work schedule, calendar, and regional schedule when determining 
assignments by creating rules based on an employee�s availability.

Position Candidates
Positions represent candidates distinguished by their job functions, and are typically used as 
candidates in sales organizations. For example, a sales organization would want to assign positions 
to objects, because these positions are responsible for a region or territory. 
Siebel Assignment Manager Administration Guide Version 7.716 ■
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By assigning objects to positions, you can have one sales representative inherit the opportunities, 
accounts, and contacts from another representative by reassigning the employee responsible for a 
specific position.

NOTE: An assignment object can be either position-based or employee-based, but not both. 
Assignment Manager does not support assignment of employees and positions to the same 
assignment object.

Organization Candidates
An organization represents a group of positions that has limited visibility to particular application 
data. For example, your company can create separate and distinct organizations to distribute specific 
information to organizational groups both inside and outside of your enterprise. Both internal and 
external users are granted access only to the information that they should see (such as accounts, 
opportunities, and contacts) and data they need to see (such as price lists, products, and literature).

By assigning objects to organizations, you can maintain better security and promote proper business 
practices by controlling data access and visibility between different organizations. For example, you 
can limit your distributors� data access by giving them visibility to product information, but restrict 
their visibility to price lists for the products. To do this, you can create a separate organization for 
your distributors that does not have access to the price list data. In this case, the price lists are not 
available to your distributors even if they are assigned to the products.

Some objects allow the assignment of a single organization, whereas other objects allow the 
assignment of multiple organizations to the same object. For more information about which 
candidates can be assigned to each of the predefined assignment objects, see Table 3 on page 18. 

Teams Versus Individual Candidates
A team represents a group of employees or positions. Assigning a team allows you to assign a group 
of individuals that possess various skills or job functions to a particular object.

In sales organizations, teams are typically assigned to objects. For example, you can assign a sales 
representative and a sales consultant to an opportunity. Or you can assign a team of sales 
professionals�two district representatives, a regional manager, and a sales engineer�to work a 
single, large sales opportunity.

An individual represents a single employee or a position. Assigning individuals allows you to assign 
exclusive ownership to an individual who possesses a specific skill or expertise for a particular object.

In service organizations, individuals are typically assigned to objects. For example, you can assign 
a customer service representative with expertise in disk drives to all service requests that are 
marked for this area.

Assignment objects can be team-based, individual-based, or both. That is, the same assignment 
object can be team-based for employees and individual-based for organizations.
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Table 3 shows which candidates can be assigned to some of the predefined assignment objects. This 
table also shows which assignment objects are restricted to a single assignee, and assignment 
objects that are capable of incorporating a team of assignees. S indicates the ability to allow only a 
single owner or assignment; M indicates the ability to allow multiple owners or team assignments.

If you need to modify the default properties�for example, if you want to assign accounts to 
employees�you can do so by configuring the assignment object properties using Siebel Tools.

Primary Assignees
A primary on an assignment rule represents the candidate (employee, position, or organization) that 
is assigned as the primary owner of the assignment object if the candidate passes the criteria for 
that object. The primary is the main or first owner of an assignment object.

When assigning a team of assignees to an object row (depending on the candidate or organization 
source chosen for the assignment rule), you can configure Assignment Manager to assign one of the 
assignees as the primary. This assigned primary is usually the highest-scoring assignee from the 
highest-scoring assignment rule.

However, you can also define a particular candidate as the primary assignee on a specific assignment 
rule by picking an employee, position, or organization from the Primary Employee, Primary Position, 
or Primary Organization pick dialog box from the Assignment Rules List. A primary on an assignment 
rule represents the candidate (employee, position, or organization) that is assigned as the primary 
owner of the assignment object if the candidate passes the criteria for that rule.

NOTE: For assignments that allow only single assignees, the single assignee also becomes the 
primary assignee.

Table 3. Team Versus Individual Assignments Listed by Assignment Object

Candidate

Assignment Object Employee Position Organization

Account M M

Activity M

Campaign M M

Campaign Contact S S

Contact M M

Opportunity M M

Product Defect S

Project M M

Project Team M

Service Request S M
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For more information about primary assignees, see Step 7 and Step 8 in �Assignment Methodology� 
on page 57.

About Assignment Rules
Siebel Assignment Manager uses assignment rules to match assignment objects to candidates. 
Multiple assignment rules can be active for each assignment object. An assignment rule can also 
apply to multiple objects.

Each assignment rule has an activation and an expiration date that you can use to denote a range 
of dates for when the rule should be active. If you specify an activation date and no expiration date, 
the rule is active from the date denoted by the activation date onwards. If you specify an expiration 
date and no activation date, the rule is active until the date denoted by the expiration date. If you 
do not specify neither the activation date or the expiration date, the rule is always active.

NOTE: Assignment Manager uses the database time to determine whether a rule is active or not.

Assignment rules use scores to rate candidates and select potential assignees. Candidates that 
qualify for an assignment rule have the assignment rule score added to their total score. For 
example, if you have an assignment rule with the Score field set to 20 points, each candidate that 
meets the rule's criteria has 20 points applied to his or her total score.

Each assignment rule also has a candidate passing score value. After the total score for a candidate 
is calculated, Assignment Manager compares this score with the candidate passing score for the 
assignment rule. If a candidate�s score is less than the candidate passing score, the candidate does 
not meet the criteria and is not assigned. For information about how the total score for a candidate 
is calculated for each assignment rule, see �About Assignment Scoring� on page 39.

The following subtopics describe some of the assignment rule fields.
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Assignee Filter Field
Table 4 shows the filters used by Assignment Manager to determine which potential assignees are 
assigned to the object from each assignment rule. 

NOTE: If you do not use scores, the candidate passing score on the assignment rule and all 
qualifying candidate scores are treated as zero. Therefore, every qualifying candidate (every 
candidate that passes all required criteria) is assigned depending on the assignee filter.

The assignee filter determines how candidates are evaluated as potential assignees to the object.

Candidates Source Field
For each assignment rule, the administrator determines whether Assignment Manager takes 
candidates from the rule (statically) or dynamically from the object row by indicating the candidates 
source. 

Person Candidates Source

■ From Rule. The candidates are the people (positions and employees) defined for an assignment 
rule and are statically assigned. This is the default value for person candidates.

■ All People. The candidates are all the people (positions and employees) in the database and are 
statically assigned.

■ Teams. The person dynamic candidate teams you define in Siebel Tools (the value of the Team 
Type property in the Dynamic Candidate object) appear in the Person Candidates Source list of 
values (LOV) field in the assignment rule. You choose one of these values to indicate that 
candidates for the assignment rule should come dynamically from the relevant attribute on the 
object row. Two teams�Activity Account Team and Activity Asset Team�are provided as seed 
data, but you can add your own teams using Siebel Tools.

Table 4. Assignee Filter Field Values

Assignee Filter Description

All, Above Minimum Use assignees with an assignment score greater than or equal to the 
assignment rule�s candidate passing score. Assigns one or more 
assignees.

All, Must Assign Same as the All, Above Minimum value, except that the highest-scoring 
candidate is a potential assignee even if all candidates fail to meet the 
candidate passing score. Assigns one or more assignees.

One, Best Fit Use the highest scoring assignee with an assignment score greater than 
or equal to the candidate passing score. Assigns one assignee.

One, Random Choose a random assignee whose score is greater than or equal to the 
candidate passing score required for this assignment rule. Assigns one 
assignee.
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Organization Candidates Source
■ From Rule. The candidates are the organizations defined for an assignment rule and are 

statically assigned. This is the default value for organization candidates.

■ All Organizations. The candidates are all the organizations in the database and are statically 
assigned.

■ Teams. The organization dynamic candidate teams you define in Siebel Tools appear in the 
Organization Candidates Source list of values (LOV) field in the assignment rule. You choose one 
of these values to indicate that candidates for the assignment rule should come dynamically from 
the relevant attribute on the object row. There is no organization dynamic team seed data 
provided; you need to configure your own teams according to your business needs.

For more information about determining person and organization candidates, see Step 3 in 
�Assignment Methodology� on page 57. For more information about defining dynamic candidate teams 
for each assignment object, see �Configuring Assignment Objects for Dynamic Candidates� on page 93.

Check Employee Calendar Field
For each assignment rule, the administrator can designate whether Assignment Manager checks the 
employees� calendars when determining assignment eligibility. By checking the Check Employee 
Calendar field in the Assignment Rules List view, Assignment Manager checks for employee 
availability.

This feature is used only for employee-based assignment objects, and requires the installation of the 
Siebel Field Service application as it depends on a field service component, the Appointment Booking 
System. You must first configure the Activity and Service Request assignment objects using Siebel 
Tools before this feature is available. For more information about the Check Employee Calendar 
feature, see �About Availability-Based Assignment� on page 42.

Exclusive Field
For each assignment rule, the administrator can designate whether that rule is exclusive.

If a rule is exclusive and has assignees, then all assignees from other rules are discarded. If there 
are multiple exclusive rules, the exclusive rule with the highest scoring assignee is chosen as the 
only exclusive rule. If there are no exclusive rules, then the primary rule is the rule with the highest 
scoring assignee and the primary assignee is the highest scoring assignee. In this case, no assignees 
from the other rules are discarded; however, if the assignment object does not allow for more than 
one assignee, then only the primary assignee is assigned.

You make an assignment rule exclusive by checking the Exclusive flag in the Assignment Rules List 
view.

For more information about exclusive rules, see Step 7 in �Assignment Methodology� on page 57.
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About Assignment Rule Groups
Assignment Manager allows you to group assignment rules, splitting them up by business function 
or other categories. An assignment rule group can include multiple assignment rules, however, an 
assignment rule can belong to only one rule group. You must associate each assignment rule with a 
rule group. 

TIP: If you do not want to create your own rule groups, you can associate all assignment rules to 
the Default Rule Group. The Default Rule Group is provided in the Assignment Manager seed data. 
Rules upgraded from previous versions of Assignment Manager to version 7.7 are automatically 
associated with the Default Rule Group, if you have not already assigned a specific rule group.

Prior to the introduction of rule groups, Assignment Manager processed all active rules (for a 
particular assignment object), so it was impossible to execute a subset of rules in the database. With 
rule groups, you can split rules and execute only a certain set of rules. For example, you may have 
one set of business rules for assigning repair activities and another set of rules for assigning other 
activities, such as an appointment activity. Given this, you could create two rule groups with five 
rules each. Then, when you are assigning a particular activity, you specify the rule group you want 
Assignment Manager to process. Only the five rules from that rule group are processed during 
assignment of the activity.

NOTE: Typically, you want to split rules into rule groups based on business logic. Otherwise, all 
applicable rules may not get loaded and that can lead to incorrect assignments.

For more information about assignment rule groups, see �Creating Assignment Rule Groups� on 
page 128. If you plan to use delegated assignment, see also �About Hierarchical Rule Groups� on 
page 51 and �About the Rule Group Explorer� on page 53.

About Different Modes of Running Assignment Manager
You can choose one of two modes�default mode or rule group mode�to run Assignment Manager 
depending on what rules you want processed.

■ Default Mode. In this mode, all active rules for all rule groups are loaded and processed. For 
interactive assignment (AsgnSrvr) and batch assignment (AsgnBatch), if the Assignment Key 
parameter is not passed when submitting the request, all rules are processed. 

NOTE: By default, interactive and dynamic assignment run in default mode.
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■ Rule Group Mode. In this mode, you can process rules of one particular rule group when you 
assign an object row. 

■ Interactive assignment (AsgnSrvr). There are two ways in which you can run Assignment 
Manager in rule group mode�with or without using server key mappings.

❏ Using server key mappings to run Assignment Manager. Use server key mappings 
when you want to split your rules across different servers. You can explicitly define what 
rule groups to load on what server, and only rules from that particular rule group are 
executed. At the time of the assignment request, you can specify one of the rule groups 
as the Assignment Key parameter for AsgnSrvr along with the request.

For more information on server key mappings, see �About Server Key Maps� on page 23.

❏ Without using server key mappings to run Assignment Manager. Assignment 
Manager supports the use of the rule group mode even if you do not want to split your 
rules across multiple servers. In this case, you do not create server key mappings. 
Instead, when you submit the request and you specify the rule group in the Assignment 
Key parameter for AsgnSrvr. Even if there are no server key mappings, each AsgnSrvr 
process loads all active rules. AsgnSrvr determines at request time whether to execute 
all rules or only rules from a particular group based on whether or not the Assignment 
Key is passed.

■ Batch Assignment (AsgnBatch). At the time of the assignment request, you specify the 
rule group in the Assignment Key parameter for AsgnBatch to run in rule group mode. 

■ Dynamic assignment. Rule group mode is not supported in dynamic assignment. Only 
default mode is supported. All active rules are loaded and processed.

About Server Key Maps
For each Siebel Server, you use server key maps to define multiple rule groups that you want that 
server to load and process. This allows you to use different servers for different business purposes. 
After you define server key maps in the assignment administration views, each assignment server 
(AsgnSrvr) process looks for the server name in the key mappings during startup and only loads rules 
from those rule groups. The AsgnSrvr also registers the rule group row IDs as keys. When you submit 
a request to a server, you must submit the AsgnKey parameter as a row Id of one of the rule group 
row Ids assigned to that server. 

Server key mapping uses an internal key-based routing mechanism to route requests to a particular 
server, however, this is done in the background and is not apparent. You can specify multiple servers 
to load the same rule group. In this case, the Siebel Server Request Broker component routes 
requests, based on load balancing metrics, to one of the assignment servers that loaded that rule 
group. 

If you want to exclusively mark certain rule groups for use with server key maps, you can set the 
Key Based flag to true for these rule groups (using the Key Based list column on the assignment Rule 
Groups List view). These rule groups are not loaded by any Assignment Manager component 
operating in default mode.
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The server key mapping feature is supported only in certain environments when using specific 
functionality as follows:

■ Script or workflow process calling a business service

You can invoke Assignment Manager through a business service from within a workflow process, 
or from a script, using one of the following predefined business services:

■ Server Requests business service. Use this generic business service to submit requests 
to a particular component using the server request broker. With this business service, you 
can use the Assignment Manager server mapping feature. If you are using this business 
service to invoke rules based on rule groups, pass the AsgnKey parameter as the input 
parameter, and pass the ReqKey parameter as a request parameter (in the child property set 
for the component). Then, set both the AsgnKey and ReqKey parameters to the rule group 
Id of the relevant rule group.

■ Synchronous Assignment Manager Requests business service. This business service 
has one method available: Assign. This method sends a request to the Assignment Manager 
server component using the AsgnObjName and ObjRowId parameters. All active rules in the 
database are processed. 

Use this business service:

❏ To submit requests to assign a single object row

❏ With the Default Group (when no server key maps are defined)

For more information about business services, see Siebel Business Process Designer Administration 
Guide. For more information about scripting, see Object Types Reference.

■ Interactive assignment

In the default configuration, interactive assignment runs in default mode. However, interactive 
assignment can be customized to use the server key mappings feature using the SetAsgnKey 
InvokeMethod on the business component base class CSSBCBase. Using a script, a workflow 
process, or a business service, you call the InvokeMethod to pass the row Id of one of the rule 
groups as the parameter. After which, interactive assignment uses this parameter as the AsgnKey 
and ReqKey parameters when submitting requests to the AsgnSrvr component. You call 
InvokeMethod only once for one session, but subsequent requests in the same session reuse the 
rule group row Id. However, when the session is logged out or the server is restarted, you must 
call InvokeMethod again to set the AsgnKey parameter. Otherwise, Assignment Manager reverts 
to running in default mode. 

NOTE: When operating Assignment Manager in default mode, rules from rule groups that have 
the Key Based flag checked are not loaded.
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■ Batch assignment and dynamic assignment do not read server key mappings

NOTE: You cannot run Default Mode and Server Key Mappings mode on the same assignment server 
because the two tasks are mutually exclusive functionalities. For example, you cannot use the same 
assignment server to run resource assignment (used for professional service automation and does 
not use rule groups) and credit assignment (used for sales and does use rule groups). You should 
run assignment for each on different servers.

TIP: Siebel Incentive Compensation and Siebel Marketing are specifically designed to use the server 
key mapping and rule group features. For more information about each of these Siebel products, see 
Siebel Incentive Compensation Administration Guide and Siebel Marketing Installation and 
Administration Guide.

About Assignment Manager Rule Cache Files
The rule cache file contains the most recent copy of assignment rule, criteria, candidates, skill, and 
skill item information before the last time assignment rules were released. A cache file is recreated 
every time assignment rules are released or when skills have expired.

Depending on the mode in which you run Assignment Manager, the following cache files are used:

■ rulecache.dat

This file contains information about all active rules in the database. When running Assignment 
Manager in default mode, this file is used by each of the three assignment operation modes�
interactive, batch, and dynamic assignment.

■ rulecache_SERVERNAME.dat (where SERVERNAME is the name of the Siebel Server)

This file contains information about the rules in the rule groups assigned to a particular Siebel 
Server and is used when server key mappings are defined.

■ rulecache_RULEGROUPID.dat (where RULEGROUPID is the Assignment Key parameter)

When batch assignment runs in rule group mode, you can specify whether it uses the default 
mode cache file (rulecache.dat) or a separate cache file by way of the Independent Rule Group 
Cache server parameter. If you set this parameter value to FALSE, it uses the default mode cache 
file (see rulecache.dat above). If you set this parameter to TRUE, it creates a separate cache file, 
rulecache_RULEGROUPID.dat (where RULEGROUPID is the Assignment Key parameter you 
passed along with the request). There can be multiple cache files of this type because you can 
use batch assignment in rule group mode for different rule groups. This rule group cache file is 
a smaller file, therefore providing better performance than the default mode cache file (because 
the rulecache_RULEGROUPID.dat file only has information about some rules for some rule groups 
while the rulecache.dat file has information about all active rules for all rule groups). 

NOTE: The default value of the Independent Rule Group Cache parameter is set to TRUE because 
this setting gives better performance. So, if batch assignment is running in default mode (that 
is, the Assignment Key parameter is not supplied), then the value of this parameter is ignored.
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About Assignment Rule Sequencing
When you assign sequence numbers to assignment rules, Assignment Manager evaluates those rules 
in ascending order of the sequence numbers. Assignment rule sequencing provides a means for you 
to prioritize the rules that apply to any given assignment object by order of importance, thereby 
limiting the number of rules that Assignment Manager processes for assignment. For example, you 
might want to run Assignment Manager only for your higher priority rules first, and then if those rules 
pass, stop processing additional rules because candidates are already successfully matched.

If none of the rules have a sequence number, or if all of the rules have the same sequence number, 
then Assignment Manager processes all the rules. However, if some of the rules in the group have 
sequence numbers and other rules do not, the rules with no specified sequence number are 
considered to have a sequence number of 0 and are evaluated first. Therefore, it is recommended 
that you give every rule a sequence number if you use sequencing. 

After processing every assignment rule within a sequence number, Assignment Manager checks to 
see if each rule was successfully assigned. When a rule results in successful assignment, Assignment 
Manager processes the rest of the rules having the same sequence number and then stops 
processing. Subsequently, the rules with higher sequence numbers do not get processed.

As shown in Table 5, Assignment Manager identifies the beginning and end of a segment within a 
sequence by the change in sequence number. For example, Assignment Manager first evaluates rules 
with a sequence number of 1, then evaluates rules with a sequence number of 2, and so on. It does 
not matter, however, how rules within a segment are evaluated.

At runtime, Assignment Manager evaluates the rules in the first segment (Segment 1) first, then 
stops to find out whether an assignment has been made. If it has assigned, Assignment Manager 
does not continue. If it has not assigned, then Assignment Manager continues to the next sequence 
(Segment 2).

If Assignment Manager is running in default mode and there are multiple rule groups defined, then 
Assignment Manager evaluates the rules as if they are part of one big group.

Table 5. Example of a Rule Sequence

Segment Assignment Rule Sequence #

1 Assign Sales Rep West 1

Assign Sales Rep North 1

Assign Sales Rep East 1

2 Assign Sales Rep West 2

Assign Sales Rep North 2

3 Assign Sales Rep West 3

Assign Sales Rep North 3

Assign Sales Rep East 3
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For example, if there are two rule groups loaded by the same Assignment Manager server with the 
sequences shown in the following table:

Then, this is the order Assignment Manager evaluates those rules:

A1
A1
A1
B1
B1
A2
A2
B2
B2
A3
A3
B3
B3
B3

Sequence numbers can be assigned to assignment rules when creating new assignment rules or can 
be added to assignment rules at a later time.

About Assignment Criteria and Criteria Methods
Assignment criteria are the fundamental building blocks for assignment rules. The assignment 
business logic you determined is translated into assignment criteria. Criteria are the conditions that 
the candidates must satisfy in order to qualify for assignment to a particular work item. For example, 
if you want an assignment requirement that employees speak German before a service request is 
assigned, then you should use the Language criterion. Assignment criteria are usually defined along 
with criteria values. Language is the assignment criterion and German (or DEU, which is the language 
code for German) is the criterion value. There may be several criteria values for the same criteria 
(1:M relationship). For example, if you want activities of type Repair or Break-fix handled by a certain 
employee, create a criterion called Activity Type with two criteria values, Repair and Break-fix. An 
assignment rule can include none, one, or many criteria. 

Rule Group A Rule Group B

1 1

1 1

1 2

2 2

2 3

3 3

3 3
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For more information about criteria values, see �About Assignment Criteria Values� on page 34. 

Assignment Criteria Comparison Methods
Table 6 provides the types of comparison methods each criteria uses to determine if candidates meet 
the criteria.

Depending on the comparison method, candidates that meet the criteria have the criteria score 
added to their total score as follows:

■ The total score from all criteria of the Compare to Object type that pass is added to all qualifying 
person and organization candidates.

■ The person candidates get the score from the Compare to Person and Compare Object to Person 
criteria and values they pass.

Table 6. Assignment Criteria Comparison Methods

Comparison 
Method Description1

1. Attributes (object or candidate) can be either attributes or skills depending on the criterion value.

Compare to Object Compares criteria values to object attributes. The criterion passes if the 
objects possess the criteria values. 

For example, Account Zip Code = 94040.

Compare to Person Compares criteria values to attributes of person candidates (employees or 
positions). Person candidates that possess the attributes required by the 
criterion qualify for this criterion.

For example, language = ENU.

Compare Object to 
Person

Compares object attributes to attributes of person candidates (employees 
or positions). Person candidates that possess the attributes required by the 
object qualify for this criterion. 

For example, product means compare the product of the opportunity and 
the product skills of the person or position.

Compare to 
Organization

Compares criteria values to organization attributes. Organizations that 
possess the attributes required by the criterion qualify for this criterion. 

For example, type = gold-level partner.

Compare Object to 
Organization

Compares object attributes to organization attributes. Organizations that 
possess the attributes required by the object qualify for this criterion.

For example, zipcode means compare the zipcode of the service request 
and the zipcode of the organization.
Siebel Assignment Manager Administration Guide Version 7.728 ■



Assignment Manager Concepts ■  Assignment Manager Components Overview
■ The organization candidates get the score from the Compare to Organization and Compare 
Object to Organization criteria and values they pass.

NOTE: Assignment rules can be created with no criteria. A rule of this nature functions to make sure 
all data items of a particular object type are assigned, that is, all objects of the defined type pass. 
Use these rules carefully as a rule defined with no criteria can make assignments that are not 
required.

You should be especially careful creating rules with no criteria using batch assignment. This mode 
can produce a very large number of assignments, because all objects in the database that have rules 
with no criteria pass and are assigned in this mode. This can result in a backlog of requests that may 
cause the whole environment to stop working if the database or file system runs out of space. 
Therefore, assignment rules with no criteria should be used sparingly with batch assignment.

Assignment Criteria Inclusion Methods
Assignment criteria also use an inclusion method to: 

■ Determine how many criteria values must be met to pass the criterion

■ Determine how the score of the criterion values are added to the candidate�s score
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Table 7 shows the types of inclusion methods for assignment criteria.

Table 7. Assignment Criteria Inclusion Methods

Inclusion 
Method Comments

Include At least one value needs to match:

■ For Compare to Object, the object attribute must match at least one listed 
criteria value.

■ For Compare to Person, the person attribute must match at least one listed 
criteria value.

■ For Compare Object to Person, at least one value of the person attribute 
must match one value of the object attributes.

■ For Compare to Organization, the organization attribute must match at 
least one listed criteria value.

■ For Compare Object to Organization, at least one value of the organization 
attribute must match one value of the object attributes.

Assignment Manager stops processing criteria when one value is matched and 
the score of the matching criterion value is added to the candidate's score.

Include All All values must match:

■ For Compare to Object, the object attribute must match all listed criteria 
values.

■ For Compare to Person, the person attribute must match all listed criteria 
values.

■ For Compare Object to Person, all values of the person attribute must 
match all values of the object attribute.

■ For Compare to Organization, the organization attribute must match all 
listed criteria values.

■ For Compare Object to Organization, all values of the object attribute must 
match all values of the organization attribute.

If the criterion is met, all the criteria value scores are added to the candidate's 
score. However, if just one of the criteria are not met, then Assignment 
Manager stops processing the rule.
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About Column-Based Attributes Versus Row-Based 
Skills
When you define an assignment criterion, the data you use for matching the object and candidate 
can come from two different types of sources, either attributes or skills. 

■ An attribute is data that usually resides on a column on the base table. For example, Employee 
Salary resides on a column in the S_EMP_PER employee table and is an attribute. Similarly, 
Service Request Severity is an attribute on the Service Request object, because it is stored on 
the Service Request record.

Some attributes exist outside the base table. For example, Account Zip Code is an attribute on 
the account, but does not exist on the Account table itself. Instead, Account Zip Code exists on 
the common address table known as S_ADDR_ORG. It does not exist on the account table 
However, there is a link between a given account record and all the addresses that belong to it.

Include All 
Matching

This inclusion method matches in the same manner as the Include inclusion 
method, that is, at least one value needs to match.

However, unlike the Include method, Assignment Manager continues to 
process this criterion until all criterion values are exhausted. As a result, the 
scores from all passing criterion values are added to the candidate's score.

TIP: The Include All Matching inclusion method matches like the Include 
inclusion method but scores like the Include All inclusion method.

Exclude None of the values must match:

■ For Compare to Object, the object attribute must not match any of the 
listed criteria values.

■ For Compare to Person, the person attribute must not match any of the 
listed criteria values.

■ For Compare Object to Person, no values of the person attribute can match 
any values of the object attribute.

■ For Compare to Organization, the organization attribute must not match 
any of the listed criteria values.

■ For Compare Object to Organization, no values of the organization 
attribute can match any values of the object attribute.

Note that for this inclusion method, criterion value scores are ignored. If the 
criterion is met, only the criterion score is added to the candidate's score.

Table 7. Assignment Criteria Inclusion Methods

Inclusion 
Method Comments
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■ Skills are row-level extension attributes to objects (Opportunities, Service Requests, and so on) 
and candidates (employees, positions and organizations). These are data stored in special child 
and grandchild tables of the base tables known as skill and skill item tables. For example, 
Language is an employee skill defined in the employee skill table (S_EMP_SKILL) and the 
employee skill item table (S_EMP_SK_IT). The S_EMP_SK_IT table is actually a child table of the 
S_EMP_SKILL table. You can define skill and skill item tables for every assignment object through 
properties using Siebel Tools. Skills and skill items are defined in a similar manner to criteria and 
criteria values. If an employee has expertise for two products, Product A and Product B, you 
define one skill (Product) and define two skill items under the same skill (Product A and 
Product B).

Skills provide a way to create new attributes for a candidate or an object without extending the 
database schema. Objects also have skill and skill items. For example, you can define a Product 
skill with a Product A skill item for an activity to indicate that candidates must have the same 
product skill for assignment to that activity.

■ Data could reside on an object or a candidate in the form of an attribute and a skill. For example, 
you can link an opportunity to a product by way of the: 

■ Products subtab and associating the product to the opportunity

or

■ Skills subtab and creating a Product skill and a skill item for the product you want to associate

While matching assignment criteria, Assignment Manager looks for column-based attributes first, 
and if they are not found, Assignment Manager looks for a skill value in designated skill tables.

Assignment Manager evaluates criteria by comparing two string, number, or date literals using a 
comparison method. One of these literals sets the requirement, and the other literal must match the 
first literal for the criterion to pass.

For information about the assignment criteria comparison methods, see �Assignment Criteria 
Comparison Methods� on page 28.

About the Required Attribute for Assignment Criteria
You make assignment criteria required by selecting Always from the picklist in the Required field in 
the Criteria list for the assignment rule. The Required property on the assignment criterion gives you 
the ability to make certain conditions for the criterion mandatory. If candidates meet this criterion, 
the candidate�s score is increased, providing that candidate a better chance of being assigned.
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Required Assignment Criteria
A required criterion means that the criterion must be met. For the Compare To Object type criteria, 
if the object does not have the attribute to satisfy the criterion, the rule fails and none of the 
candidates from that rule qualify for assignment. For person-based criteria (criteria with either a 
Compare To Person or a Compare Object to Person comparison method), if the criterion is not met, 
that person candidate fails and does not qualify for that assignment rule. Therefore, further person-
based criteria are not evaluated for that person candidate. For organization-based criterion (criterion 
with a Compare To Organization or a Compare Object to Organization comparison method), if the 
criterion is not met, that organization candidate fails and does not qualify for that assignment rule. 
Therefore, further organization-based criteria is not evaluated for that Organization candidate.

For example, an assignment rule can have a required Service Request Severity assignment criteria 
with a Compare to Object comparison method and a criteria value of 1-Critical. In this case, if the 
object to be assigned has a service request severity of 1-Critical, the object qualifies for the 
assignment rule. An object without a service request severity value or one that has a different service 
request severity value does not qualify for the assignment rule.

Required When Available Assignment Criteria
In some cases, your requirements may dictate that a particular criterion should be applied only if the 
object or the candidate has the attribute available. If the attribute is available, the criterion should 
be satisfied mandatorily. It is in these instances you use Required When Available as the required 
property on the assignment criterion. You can make criteria required when available by selecting 
When Available from the picklist in the Required field.

For example, an assignment rule can have a required when available Service Request Severity 
assignment criteria with a Compare to Object comparison method and a criteria value of 1-Critical. 
In this case, if the object assigned has a service request severity of 1-Critical, the object qualifies 
for the assignment rule. An object that has a lower service request severity value does not qualify 
for the assignment rule. However, an object without a service request severity value qualifies for the 
assignment rule (because the criteria value is null, or not available).

NOTE: If an assignment criterion uses a Compare Object to Person or a Compare Object to 
Organization comparison method, and the attribute value is not found on person, the criterion fails.

Nonrequired Assignment Criteria
Use nonrequired assignment criteria to further determine a suitable match between candidates and 
assignment rules. You can make criteria nonrequired by selecting Never from the picklist in the 
Required field. Use nonrequired criteria that include scores to apply scores to candidates. These 
scores are added to the total scores of the candidates for this assignment rule if they pass the 
criteria. By using nonrequired criteria with scores, you can add a higher score to candidates that 
satisfy this criteria, while keeping candidates that do not satisfy the criteria.

If a candidate fails a nonrequired criterion, no score is added to the candidate; however, the 
candidate does not fail. Person candidates are evaluated for rest of the person-based criteria and 
organization candidates are evaluated for the rest of the organization-based criteria.
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If an assignment rule does not include any required criteria and an object has not been selected for 
the rule, you must define the assignment rule with nonrequired criteria that apply to objects that 
you want to assign.

For example, you should use service-related criteria (such as Service Request Priority) for an 
assignment rule that are applied to service-related objects (such as Service Request). If you create 
an assignment rule with Server Request Priority as nonrequired criteria, Assignment Manager does 
not qualify any accounts for the criteria because Service Request Priority does not apply to accounts.

If an assignment rule uses only nonrequired assignment criteria, then the assignment rule passes 
even if the minimum score for the rule is not satisfied, because the assignment criteria are not 
required. To avoid this behavior, you can alter Assignment Manager so that assignment rules pass 
only when the minimum score for the rule is satisfied, even if the assignment criteria are not 
required.

To require that an assignment rule satisfies the minimum score for the rule to pass, you can use the 
UseRuleMinScore server parameter. If you set this parameter to TRUE, each assignment rule score 
must be equal to or greater than the rule minimum score to pass. And, candidates must have a total 
score from the rule greater than or equal to the rule minimum score in order to qualify for that rule 
as well.

When using the AsgnSrvr and AsgnBatch commands (from the command-line interface), you can 
change the value for the UseRuleMinScore server parameter. For dynamic assignment, you change 
the default value of the UseRuleMinScore parameter in the Assignment Request (In Process) 
workflow policy program. 

About Assignment Criteria Values
For assignment criteria that use the Compare to Object, Compare to Person, or Compare to 
Organization comparison method, each criteria includes one or more values. Criteria values are 
details associated with criteria that are compared to an object or candidate.

A criterion can have multiple values. A criterion value represents the actual string, number, or date 
literal that is used in matching. There are predefined criteria values available dynamically based upon 
the criterion selected, or you can create your own criteria values. Criteria values can be based on 
MLOVs, picklists (a popup pick applet from where you can choose a record), or simple free text fields. 
Depending on the Inclusion method, candidates that meet the criteria value have the criteria value 
score added to their total score. Criteria values can be defined as constants or can use wildcard 
characters to include a wider selection of potential matches between assignment rule and object.

A criterion can consist of only one attribute, such as a service request priority, or can consist of 
multiple attributes, known as a composite criterion. For example, Account City State Country is a 
composite criterion because it has three attributes: City, State, and Country. For more information 
about attributes, see �Assignment Attributes� on page 35.
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Figure 1 shows a Language Code criterion that uses four languages as criteria values (German, 
Spanish, Italian, and French). Assuming this assignment rule�s candidate passing score is 10 points, 
and each language is worth 5 points, candidates for this assignment rule that possess expertise in 
at least two of these languages qualify for the assignment rule. 

Assignment Attributes
Assignment attributes are logical attributes of the object or candidate that can be used for matching. 
For example, Service Request priority, Account City, and Employee Salary are assignment attributes. 
Each criteria value can include one or more assignment attributes. For example, the Account City 
State Country criterion has three attributes: one each for City, State, and Country. This type of 
criterion is known as a composite criterion. Each of the assignment attributes appear as list columns 
in the criteria value applet. 

Figure 1. Sample Assignment Criteria Values
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Figure 2 shows a Product Line Wildcard assignment criteria that uses the Compare to Person 
comparison method. The assignment criteria also uses the Include All inclusion method and includes 
two criteria values. Each criteria value includes two assignment attributes. In this case, only 
candidates that possess an Expert expertise in monitors and graphic cards qualify for the assignment 
criteria. Furthermore, 25 points are added to the qualifying candidates score.

Assignment Attribute Columns
Assignment attributes can have one or many attribute columns. The parent assignment attribute is 
an abstract logical attribute to test for a value match, and attribute columns provide mapping of 
assignment attributes to workflow policy component columns. Workflow policy component columns 
define the column and the table name from where Assignment Manager retrieves the data for the 
attribute from the database. The same assignment attribute can be used for different assignment 
objects. For example, consider the Account State criterion. You can apply this criterion to many 
assignment objects. For account objects, it means the physical state in which the account resides. 
For opportunity objects, it might be the state value for the accounts associated with a specific 
opportunity. In these instances, you define multiple assignment attribute columns for the Account 
State attribute and define the assignment object and the workflow policy component column to 
indicate where to get the data from. 

An assignment attribute can have multiple attribute columns for the same assignment object. For 
example, for the Opportunity assignment object, Account City could either mean the primary city 
associated with the opportunity itself or the primary city associated with the account associated to 
the opportunity. In this instance, the Account City assignment attribute has two attribute column 
records for the Opportunity assignment object. And you should define the Sequence property on the 
assignment attribute column object. The sequence determines the order in which the data is 
retrieved in the event there are multiple attribute columns for the same attribute for the same 
assignment object.

Figure 2. Sample Assignment Attributes
Siebel Assignment Manager Administration Guide Version 7.736 ■



Assignment Manager Concepts ■  Assignment Manager Components Overview
About Assignment Skills
Skills are extensions to attribute data stored in designated skill and skill item tables. By default, sales 
objects do not use skills.

The Siebel application provides predefined skills, however, you can create new skills using Siebel 
Tools. You can also enable and configure skills at the criteria level using Siebel Tools. After skills are 
enabled, Assignment Manager matches skills based on the assignment criteria comparison method 
in the same manner in which attributes are matched. Assignment Manager applies scores and other 
filters to find the best candidate after a match has been made.

For information about the predefined skills and creating new skills, see �Creating New Skills� on 
page 118. For more information about enabling and configuring skills, see �Assignment Criteria 
Configuration� on page 107. For more information about how skills are matched, see �About 
Assignment Criteria and Criteria Methods� on page 27.

Expertise Codes
Assignment Manager uses expertise codes to rank skills to find the most suitable candidate. For 
example, you do not want to assign a novice to a service request that requires an expert. Using 
expertise codes allows you to prevent assigning objects to underqualified candidates.

Expertise codes are predefined for the following skill types (or assignment criteria):

■ Language Code

■ Product

■ Product Line

■ Product Line Wildcard

■ Product Wildcard

The three predefined expertise codes are Novice, Intermediate, and Expert. Expertise codes are 
stored in�and can be modified, added to, or deleted from�the List of Values data administration 
view. Expertise codes apply only to skills and are global; after they are defined, assignment criteria 
share the same set of expertise codes.

After you select an expertise code for a skill, Assignment Manager matches assignment rules based 
on the assignment criteria comparison method. If the expertise code belongs to a skill that uses the:

■ Compare to Object criteria. The assignment rule passes if the skill�s expertise code is equal 
to, or higher than, the object�s expertise code.

■ Compare Object to Person criteria. The assignment rule passes if the candidate�s expertise 
code is equal to, or higher than, the object�s expertise code.

■ Compare Object to Organization criteria. The assignment rule passes if the organization�s 
expertise code is equal to, or higher than, the object�s expertise code.

■ Compare to Person criteria. The assignment rule passes if the candidate�s expertise code is 
equal to, or higher than, the skill�s expertise code.

■ Compare to Organization criteria. The assignment rules passes if the organization�s expertise 
code is equal to, or higher than, the skill�s expertise code.
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For more information about assignment criteria comparison methods, see �About Assignment Criteria 
and Criteria Methods� on page 27.

Weighting Factors
Optionally, you can apply weighting factors to expertise codes. While you can use expertise codes to 
eliminate underqualified candidates, using weighted expertise codes allows you to weigh skill scores 
to find the most suitable candidate by further eliminating overqualified candidates. For example, you 
may not want to assign an expert to a service request that can be handled by a novice.

Using weighted expertise codes allows you to prevent assigning objects to overqualified candidates 
by applying a weight to the skill score. Each expertise code has a defined value, which is its weighting 
factor. The expertise code with the highest defined weighting factor represents the maximum 
weighting factor (Max Weighting Factor). 

The weighting applied to a skill or criteria score is the percentage defined by an expertise code�s 
weighting factor over the maximum weighting factor. For an example, see Table 8 on page 39. 

Weighted scores are calculated differently based on the comparison method chosen for the 
assignment rule:

■ For the Compare to Person, Compare to Object, and Compare to Organization comparison 
methods, the weighted score is determined as follows:

Score=Criteria Score + Skill Score*(Weighting Factor/Max Weighting Factor)

■ For the Compare Object to Person and Compare Object to Organization comparison methods, 
because neither of these comparison methods can define skill scores, the weighted score is 
determined as follows:

Score=Criteria Score*(Weighting Factor/Max Weighting Factor)

NOTE: When using the Compare Object to Person or the Compare Object to Organization 
comparison method, weighting factors are only applied if the expertise code is defined for both 
the object assignment skill item and the candidate skill item. If the expertise code is not defined 
for both, the weighting factors are ignored.

Assignment Manager applies the weighted skill scores and other scores to find the most suitable 
candidate when a match is made.

Weighting factors for expertise codes are stored in�and can be modified, added to, or deleted from�
the List of Values data administration view. For procedures, see �Defining Weighting Factors� on 
page 141. Weighting factors for expertise codes apply only to skills and are global; after they are 
defined, assignment criteria share the same set of weighting factors for expertise codes.
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Weighting factors weigh expertise codes by applying a specified percentage to the skill score. Table 8 
shows sample weighting factors that can be used for the three types of predefined expertise codes.

In this example, candidates with an intermediate expertise for the matched skill are favored over 
other candidates, because they receive 100% of the skill score. This may be desired if your 
organization has many more service representatives with an intermediate expertise than service 
representatives with an expert expertise. In this case, you make sure that service requests that 
require only an intermediate expertise are assigned to service representatives with an intermediate 
expertise.

NOTE: Use weighting factors to adjust relative scoring for expertise; do not define separate criteria 
and scores for different expertise levels.

About Assignment Scoring
Siebel Assignment Manager determines which candidates are assigned to objects by applying scores 
to potential candidates. Assignment Manager then ranks the candidates based on their scores and 
selects assignees based on the assignee filter.

Assignment Manager calculates the total score for each candidate from each assignment rule from 
the:

■ Assignment rule score

■ Assignment criteria score

■ Assignment criteria values score (according to the appropriate inclusion method)

■ Workload criteria score

■ Employee, position, or organization score (depending on the candidate)

Before implementing Assignment Manager, you should carefully consider the value for each score. 
Use scores to assign weights to your criteria. If there are multiple criteria, assign a higher score to 
the more important attributes. This is especially useful for finding the best match when not all criteria 
are required.

Table 8. Sample Weighting Factors for Expertise Codes

Expertise 
Code

Weighting 
Factor Percentage of Skill Score

Novice 2 If skill is matched, adds 40% of score for the skill (or criteria value)

Intermediate 5 If skill is matched, adds 100% of score for the skill (or criteria value)

Expert 3 If skill is matched, adds 60% of score for the skill (or criteria value)
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You can also configure Assignment Manager to save the scores of candidates who are assigned to an 
object. Saved candidate scores can be accessed by other Siebel application modules and used to 
produce items such as analysis reports for employee utilization. The scores can also be exposed to 
users for review and sorting. The scores of each candidate are stored in the appropriate team table 
by specifying the Employee Team Score Column, Position Team Score Column, and Organization 
Team Score Column. Team member scores are written independently for each type of candidate 
(employees, positions, and organizations).

For more information about specifying the team score columns, see Object Types Reference. For 
information about exposing scores for user review and sorting, see �Configuring Assignment Objects 
for Team Scoring� on page 105.

Addition of Scores for the Same Candidate Across Rules
The same candidate (employee, position, or organization) can qualify from different assignment 
rules with different scores. By default, Assignment Manager treats passing candidates from different 
rules as if they were different candidates. However, it is possible to merge (add) the scores for the 
same candidate across assignment rules and take the total score in the calculation of the primaries. 
This is accomplished using the AddScores task-level server parameter for the AsgnSrvr and 
AsgnBatch commands (interactive and batch assignment, respectively) and a workflow policy 
program argument for dynamic assignment. If the AddScores parameter is passed as TRUE, 
Assignment Manager adds the scores for each candidate across rules and uses that to determine the 
primary candidate. 

NOTE: The AddScores parameter is applicable to static and dynamic candidates, but only if no rules 
are marked as exclusive. That is because you explicitly define the rule from which you want the 
primaries to come for exclusive rules.

About Assignment Workload Criteria
The workload criterion is a special criteria type used to balance the load between candidates. You 
can create workload criteria by adding workload rules in the Assignment Workload view for 
employees and positions, or the Assignment Organization Workload view for organizations. Workload 
criteria are generally used with service assignments. You can also define your own workload rules 
using the Workload Distribution Rules view.

NOTE: When creating your own workload rules, keep in mind that performance may be affected if 
Assignment Manager is accessing a nonindex column or retrieving the total number of records. 

The workload criteria apply a workload score to candidates based on their current workload. The 
workload score is calculated as follows:

Workload score = Score * (1 � (current workload/maximum workload))

NOTE: The candidate�s current workload excludes the workload of the current object being assigned.
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Candidates with a lighter workload receive a higher score than candidates with a heavier workload. 
The workload score is then added to the candidate�s score to generate a total score. Candidates that 
have workloads in excess of the maximum workload are eliminated from the assignment rule. This 
criteria prevents employees from being overloaded. Multiple workload criteria can be used for each 
assignment rule.

NOTE: As with other criteria, workload criteria have a Required attribute, which functions in the 
same manner as it does for regular criteria. 

Figure 3 shows a workload criterion that:

■ Adds 100 points to candidates with a workload of 0 items (100* (1-(0/2))

■ Adds 50 points to candidates with a workload of 1 item (100* (1-(1/2))

■ Adds 0 points to candidates with a workload of 2 items (100* (1-(2/2))

■ Eliminates candidates with a workload of more than two items if the criteria is marked as 
Required

For information on defining workload see �Defining Assignment Workload� on page 142.

Workload criteria can be enabled for multilingual list of values (MLOV) capabilities with additional 
configuration. MLOV allows workload criteria to be stored in a form that can be retrieved and 
displayed in a variety of supported client languages. For more details on this feature, see Configuring 
Siebel eBusiness Applications. 

Figure 3. Sample Workload Criterion
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About Activity-Based Assignment
Assignment Manager can assign emails as email activities created during inbound and outbound 
email processing. Communications Server (Communications Inbound Manager server component) 
works in conjunction with Siebel eMail Response and Siebel Workflow to create activities for inbound 
emails. Communications Server (Communications Outbound Manager server component) creates 
activities for outbound emails. For more information, see Siebel Email Response Administration 
Guide (Workflow section) and Siebel Communications Server Administration Guide.

NOTE: Setting up assignment rules to assign email activities requires customization in Siebel Tools 
for Applets, Workflow Policy Object Column, and Assignment Attribute. For related implementation 
information, see Using Siebel Tools, Configuring Siebel eBusiness Applications, and Object Types 
Reference. 

About Availability-Based Assignment
Assignment Manager has the ability to assign employees based on their calendar availability and can 
find out whether candidates are working at the required time�and whether their calendar is free or 
not�before assigning an item to a candidate or team. This feature is used on employee-based 
assignment objects only, and requires the installation of the Field Service option as it depends on a 
Field Service component, the Appointment Booking System (ABS), to check employee availability. It 
is, however, not limited to use in the Field Service application and can be used in any application that 
has employee-based objects. In general, this feature is meant for use with employee-based objects 
that have an associated time duration, such as Activities and Service Requests.

To use this feature, certain properties of the assignment object require configuration in Siebel Tools. 
The Activity object is, by default, partially preconfigured for use with availability assignment; the 
Service Request object, however, is not. Both objects require configuration in Siebel Tools to activate 
availability-based assignment. See �Configuring Assignment Objects for Availability-Based Assignment� 
on page 100 for further information on these procedures. Assignment Manager can also be configured 
to create an Activity in the calendar of the candidate assigned to the object.

After an object is configured for availability-based assignment, an assignment rule activates this 
feature by means of a check box on the Assignment Rule detail applet. You can further customize 
Assignment Manager for availability-based assignment, by configuring assignment object user 
properties. 

For more information about checking employee availability, see �Check Employee Calendar Field� on 
page 21. For more information about availability-based assignment, see �Assigning Employees to 
Assignment Rules Based on Availability� on page 149. For more information about customizing 
Assignment Manager user properties, see �Configuring Assignment Object User Properties� on page 96. 
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About Multitiered Assignment
By default, Assignment Manager independently matches people and organizations to assignment 
objects. Activating Assignment Manager to use multitiered assignment, however, allows assignments 
based on the relationship between a person and their organization or an organization and its people. 
Without multitiered assignment�or appropriate assignment rules�it is possible for Assignment 
Manager to assign an unrelated organization or person to an assignment object. Multitiered 
Assignment has the following modes of assignment operation: 

■ Independent�Assigns people and organizations that qualify, regardless of whether they are 
related or not.

■ Person-Oriented�Assigns people that qualify, then assigns only qualified organizations that the 
assigned people belong to. 

■ Organization-Oriented�Assigns organizations that qualify, then assigns qualified people from 
those organizations. 

■ Organization and Person-Oriented�Identifies qualified people and organizations, then assigns 
only those that have both a qualified person and related qualified organization.

NOTE: Use caution when the Organization and Person-Oriented mode is used with assignment 
rules that use the One, Best Fit assignee filter because inconsistencies can occur. The One, Best 
Fit assignee filter assigns only the highest scoring position or organization. If the highest scoring 
position does not have a qualifying organization, or if the highest scoring organization does not 
have a qualifying position, the object remains unassigned, even if a lower scoring position and 
its related organization both qualify for the assignment rule.

This logical assignment feature is well-suited to sales organizations.

You use Siebel Tools to activate multitiered assignment by configuring the Assignment Mode 
assignment object property.

NOTE: You should not configure multitiered assignment to assign people and corresponding 
organizations when running interactive assignment. This is because when using interactive 
assignment, you manually choose assignees and only the person or the organization candidates are 
shown, not both.
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Assignment Operation Modes
This topic lists the assignment operation modes available for running Assignment Manager and where 
you can find more information about these modes:

■ Interactive (see �About Interactive Assignment� on page 44)

■ Dynamic (see �About Dynamic Assignment� on page 44)

■ Batch (see �About Batch Assignment� on page 45)

■ Mobile (see �About Mobile Assignment� on page 45)

■ Contact Denormalization (see �About Contact Denormalization� on page 46)

■ Product Denormalization (see �About Product Denormalization� on page 47)

Depending on the assignment mode, you invoke Assignment Manager by using the server 
administration views, the command-line interface, or both. For more information on how to establish 
each mode, see Chapter 7, �Running Assignment Manager.�

About Interactive Assignment
Running Assignment Manager in interactive mode allows users to make real-time assignments.

NOTE: Mobile users running Assignment Manager in interactive mode do not make real-time 
assignments, because interactive assignments made by mobile users are not applied to the server 
until they resynchronize.

By clicking the Menu button on any selected object and choosing Assign, Interactive Assignment 
allows you to view the list of assignees generated by Assignment Manager. You can then override the 
assignment and select another assignee from the list in real time.

About Dynamic Assignment
Dynamic assignment allows users to create assignments as other users and server programs create 
records or change assignment object attributes in existing records. For example, if a user creates a 
new opportunity or changes the revenue amount (or address) of an opportunity, dynamic assignment 
detects the change and automatically invokes Assignment Manager to reassign the opportunity to a 
different territory or sales team, if indicated.

The dynamic assignment process is as follows: a user makes a change that requires assignment; a 
database trigger fires (triggers are setup by the Generate Triggers server component) and inserts 
records in the S_ESCL_REQ table (escalation request table); the Workflow Monitor Agent polls this 
escalation table periodically for records and assigns the object (internally invoking Assignment 
Manager within its own process). By default, the Server Request Broker and the Assignment Manager 
server components are not explicitly used in dynamic assignment. 
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Workflow Monitor Agent
To run dynamic assignment, a Workflow Monitor Agent task must be running. A Workflow Monitor 
Agent detects when a user changes data related to objects. For more information about Workflow 
Monitor Agent, see Siebel Business Process Designer Administration Guide.

Generate Triggers
The Generate Triggers server component generates the database triggers used by Workflow Manager 
to detect changes. Generate Triggers reads the Workflow Policy Object and Assignment Object 
definitions in the Siebel repository and generates the appropriate database triggers to monitor 
changes.

About Batch Assignment
You can use batch assignment to assign multiple records of an object in a single batch. For example, 
you can assign orders that are created during the business day at the end of business using batch 
assignment so that the assignments are made before start of business the next morning. Another 
example is when you change assignment rule definitions�you can use batch assignment to reassign 
objects using the new assignment rules. Batch assignment is optimized to process a large number 
of items efficiently. You can identify the records for batch assignment using an SQL WHERE clause. 
This WHERE clause is usually based on columns in the base table of the assignment object. For 
example, an example of a WHERE clause is:

WHERE OWNER_EMP_ID = NULL

This clause identifies all service requests that are not as yet assigned to a owner.

You should monitor the performance of batch assignment and increase or decrease the number of 
running tasks to obtain the optimal performance.

You can set up batch assignment to run Assignment Manager in Contact Denormalization mode.

About Mobile Assignment
Mobile Assignment allows mobile users to make interactive and dynamic assignments. Changes to 
the mobile client�s database are queued and are applied to the server the next time the client 
synchronizes.

Assignment Manager automatically performs interactive assignments made by the mobile user after 
synchronization. Changes to assignment rules and objects are updated, and affected objects are 
reassigned dynamically.

NOTE: Mobile users running Assignment Manager in interactive mode do not make real-time 
assignments, because interactive assignments made by mobile users are not applied to the server 
until they resynchronize.
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About Contact Denormalization
You use Contact Denormalization when you want to allow assignees automatic access to detail 
contact information that is associated with an account or opportunity. In Contact Denormalization 
mode, Assignment Manager denormalizes positions from the Accounts and Opportunities team tables 
by copying these positions to the associated contacts in the Contact team table, even if the assignees 
are not assigned to the contacts: 

■ Positions from the team table of all accounts associated with the contact to the contact team.

■ Positions from the team table of all Opportunities associated with the contact to the Contact 
team. 

If you want the contact access list to reflect the positions in both the account and opportunity team 
tables, you must associate the contact with an account and then associate the contact with an 
opportunity. If a team member is removed from the account or opportunity�s team table, then the 
position on the associated contact�s access list can also be removed by Contact Denormalization 
(dependent on the properties of the Contact Denormalization assignment object.) Similarly, if the 
account team has manually assigned team members and you want the same team members on both 
the contact team and account team, you must run Contact Denormalization after the account 
assignment.

NOTE: Positions marked Indirect by Contact Denormalization in Contact Access list are not dropped 
by contact assignment, that is, contact assignment does not drop the positions that were added by 
Contact Denormalization. 

Contact Denormalization checks the Lock Assignment column on assignment objects before 
denormalizing. If this flag is checked, Contact Denormalization does not denormalize the contact 
record. For more information about the Lock Assignment feature, see �Setting the Lock Assignment 
Default Value for Activity Assignment Objects� on page 202.

NOTE: Both Account and Contact and Contact and Opportunity have a many-to-many relationship. 
The Account and Contact many-to-many relationship is a new feature as of the version 7.0 release.

Assignment Manager also assigns a primary position to the contact when running in Contact 
Denormalization mode using the following methodology:

1 If the Set Primary Position property on the assignment object is TRUE (checked) and a primary 
position is not currently selected, then Assignment Manager sets the creator�s primary position 
as the new primary position.

2 If a primary position is not selected for the creator, then Assignment Manager sets the default 
position as the new primary position.

3 If a default position is not defined, then Assignment Manager does not set a primary position.

However, Contact Denormalization does not remove positions marked as the Primary, even if the 
positions no longer exist on an associated account or opportunity (with the Denorm Flag set).

The Contact Denormalization object is reserved to run Assignment Manager in Contact 
Denormalization mode. Assignment Manager does not evaluate the Contact object against any 
assignment rules in Contact Denormalization mode, and therefore does not assign candidates to 
objects. For this reason, do not create assignment rules for the Contact Denormalization object.
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For more information about Contact Denormalization, see Chapter 7, �Running Assignment Manager,� 
and �Activating Contact Denormalization� on page 182.

About Product Denormalization
In Product Denormalization mode, Assignment Manager denormalizes organizations from the Price 
List table into the Product table by copying these organizations to the products associated with the 
price lists.

NOTE: Product to Price List is a many-to-many relationship.

Assignment Manager also assigns a primary organization to the product when running in 
denormalization mode using the following methodology:

1 If the Set Primary Organization flag is checked and a primary organization is not currently 
selected, then Assignment Manager sets the creator�s primary organization as the new primary 
organization.

2 If a primary organization is not selected for the creator, then Assignment Manager sets the 
default organization as the new primary organization.

3 If a default organization is not defined, then Assignment Manager does not set a primary 
organization.

The Product Denormalization object is reserved to run Assignment Manager in Product 
Denormalization mode. Assignment Manager does not evaluate the Product object against any 
assignment rules in Product Denormalization mode, and therefore does not assign organizations to 
objects. For this reason, do not create assignment rules for the Product Denormalization object. 
Additionally, you should run Product Denormalization only in batch mode. For more information about 
running Batch Assignment, see �Running Assignment Manager in Batch Mode� on page 184.

Dynamic Candidates
Dynamic candidates are potential assignees for objects and behave in the same manner as static 
candidates. That is, dynamic candidates support criteria-based attributes and skills (such as 
Language), workload criteria, and so on. Assignment Manager determines potential dynamic 
candidates from an attribute on the object row (as opposed to coming statically from an assignment 
rule) when processing rules.

For example, if you associate an activity with an asset, and that asset has a team of employees, you 
can configure Assignment Manager to automatically consider these employees (team) for an activity 
and have the same employees available as potential candidates for other activities. These employees 
are known as dynamic candidates. The team of employees associated with the activity is known as 
the team table because this is the database table where the candidates are stored.

To define dynamic candidates, you use the Person Candidate Source and Organization Candidate 
Source list of values (LOV) field on the assignment rule. 
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In summary, the following points explains how static candidate assignment differs from dynamic 
candidate assignment:

■ For static candidate assignment, candidates for each assignment rule are loaded when the server 
processes start up.

■ For dynamic candidate assignment, candidates are loaded when a request is submitted from the 
attribute team table on the object row.

For more information about candidates source, see �Candidates Source Field� on page 20.

About Single- Versus Multiple-Owner Dynamic 
Candidate Types
Depending on the relationship an attribute has with an object row, dynamic candidates can be of the 
single-owner type or multiple-owner type. 

If there is a one-to-one relationship, dynamic candidates are of the single-owner type. For example, 
in the asset team example discussed in �Dynamic Candidates� on page 47, the dynamic candidates 
are of the single-owner type because only one asset can be associated with an activity. This is 
illustrated in the top half of Figure 4. 
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If there is a one-to-many relationship, dynamic candidates are of the multiple-owner type. For 
example, if an opportunity is associated with multiple accounts and each account has a team of 
positions, the position dynamic candidates are of the multiple-owner type. This is illustrated in the 
bottom half of Figure 4.

Using Siebel Tools, you create the dynamic candidate definitions for each assignment object by 
creating records for the Dynamic Candidate object (a child of the Assignment Object object). The 
dynamic candidate properties define the table and column names involved in performing the join 
from the assignment object primary table to the team table to retrieve the dynamic candidates. 

For more information about dynamic candidates, see �Dynamic Candidates� on page 47. For more 
information about creating dynamic candidate definitions, see �Configuring Assignment Objects for 
Dynamic Candidates� on page 93.

Figure 4. Example of Single- Versus Multiple-Owner Dynamic Candidate Types
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About Team-Based Assignment Criteria
A team-based criterion is a criterion based on a column on the attribute team table. You can define 
a team-based criterion only for an assignment rule that has dynamic candidates.

The columns in the team table describe the relationship between a candidate and an attribute. For 
example, the Relationship Type column in the Asset team table can have values such as Primary, 
Secondary, Tertiary, and so on to describe that a certain employee is primary (or secondary, tertiary, 
and so on) for the asset team. You can create assignment criteria based on these team table 
columns, known as team-based criteria. Assignment Manager supports team-based criteria only for 
the Compare To Person and Compare To Organization comparison methods. 

Using Siebel Tools, you create records in the Dynamic Candidate Attribute object to map columns in 
the team table to team-based assignment criteria by specifying the column name in the team table 
and the assignment criterion that is based on this column.

NOTE: Assignment Manager supports team-based criteria based only on columns on the team table.

Using Siebel Tools, you define team-based criteria as you would any other criteria. When you define 
the assignment criteria record, you click the Team flag to indicate that it is a team-based criterion. 
You can define only one assignment criteria attribute record per team-based criterion. You must also 
define the data type of the attribute for the assignment attribute record. Because Assignment 
Manager retrieves the data for the team-based criteria from the dynamic candidate attribute 
configuration, you need not specify assignment attribute column records for team-based criteria. 
Assignment Manager ignores these.

You define team-based criteria for rules that have dynamic candidates as you would any other 
criteria, that is, you apply a comparison method (only Compare to Person or the Compare to 
Organization supported) and define the criteria values.

However, a rule defined for dynamic candidates does not necessarily need team-based criteria. An 
assignment rule can have any of the following:

■ Static candidates and regular criteria

■ Dynamic candidates and regular criteria

■ Dynamic candidates and team-based criteria

■ Dynamic candidates and a combination of regular and team-based criteria

NOTE: Assignment Manager does not support composite team-based criteria. For a description of 
composite criteria, see �Assignment Attributes� on page 35.

Delegated Assignment
Delegated assignment allows assignment administrators (AAs) to enforce core business logic using 
rule inheritance, while allowing delegated administrators (DAs) the ability to further refine that logic. 
In addition, inheritors of rules can refine those same rules and specialize them for their unique 
circumstances.
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Delegated assignment provides AAs the ability to delegate rule administration to other 
administrators and partners to route leads, activities, accounts (and other objects) to employees or 
positions. These delegates are known DAs. A DA can, in turn, delegate assignment rule 
administration to other DAs. This hierarchical assignment feature is well-suited to sales organizations 
and organizations that work closely with partners.

NOTE: Prior to Siebel 7.7, the assignment administrator was the only person responsible for 
administering assignment rules.

The topics covered are:

■ �About Hierarchical Rule Groups� on page 51

■ �About the Rule Group Explorer� on page 53

■ �About Assignment Rule Inheritance and Templated Criteria� on page 54

For a scenario for using delegated assignment, see �Examples for Using Delegated Assignment� on 
page 75. For information about administering assignment rules for delegated assignment, see 
Chapter 6, �Assignment Rule Administration for Delegated Assignment.�

About Hierarchical Rule Groups
A rule group is a group of categorized assignment rules. You can think of a rule group as similar to 
a territory. Delegated assignment provides a hierarchical (tree) distribution of rule groups as shown 
in �The Rule Group Explorer� on page 53. The logic defined in the rules in rule groups at the top of 
the hierarchy is enforced down the hierarchy, but can be refined.The following subtopics describe 
rule group hierarchy in further detail.

Parent and Root-Level Rule Groups
A parent rule group is a rule group that appears directly above another rule group in the hierarchy. 
A root-level rule group is a rule group without a parent. For example, in Figure 5 on page 52, RG 2 
is the parent of RG 4, but RG2 is not a root-level rule group. Only RG1 is a root-level rule group�
that is because it is the only rule group in the hierarchy that does not have a parent rule group (and, 
subsequently, is at the top of the hierarchy).
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Figure 5 provides a sample rule hierarchy that shows how parent and root rule groups relate to other 
rule groups in the same hierarchy.

Figure 5 show the following relationships:

■ Rule groups that have no parent are root-level rule groups. There is only one root-level rule 
group for each hierarchy and that root-level rule group appears at the top of the hierarchy (RG1). 

NOTE: Only assignment administrators (not delegated administrators) can create root-level rule 
groups.

■ Rule groups that are parents to no other rule groups (rule groups with no child rule groups) are 
considered leaf rule groups and appear at the bottom of the hierarchy (RG3, RG4, and RG5).

■ Rules at the leaf nodes are processed first by Assignment Manager. If none of those rules, pass 
Assignment Manager processes rules in the set of rule groups above the leaf nodes, and so on, 
until the root-level rule group is processed. This makes certain that if a rule is inherited from one 
rule group to another, the inherited rule is passed first.

NOTE: The Default Rule Group is a root-level rule group (has no parent) as well as a leaf node (has 
no child).

Owners and Designees
Assignment Manager uses ownership as a means to determine if a particular rule is eligible for 
inheritance by a rule group. Each rule group must have an owner, and a rule group defaults to the 
creator (as owner) when a new rule group is created. 

NOTE: The concept of ownership is an integral part of delegated assignment functionality; however, 
if you do not use delegated assignment, ownership serves no functional role.

Figure 5. Relationships Between Parent and Child Rule Groups in a Hierarchy
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Owners can delegate their responsibility to designees with the same rights as an owner. A designee 
is an individual who can view and edit rule groups (and the rules within those rules groups) on behalf 
of an owner. The owner and the designees of a rule group are collectively known as delegated 
administrators (DAs).

Rule Group Visibility and Permissions
The AA sees only the rule groups (and the rules within those rule groups) for his or her specific 
organization (unless given permission to the All Rule Groups Across Organizations view). DAs have 
visibility only to the rule groups for which they are an owner (or designee) and each of their rule 
groups� subtrees. An owner of a particular rule group cannot be the owner (or designee) of a rule group 
lower in the hierarchy (subtree), but can be an owner (or designee) for rule groups in other hierarchies.

TIP: DAs can only inherit rules from a parent rule group and can refine inherited rules to specialize 
them, but cannot remove any of the logic specified in the original rule.

For more information about rule group hierarchies, see �About the Rule Group Explorer� on page 53.

About the Rule Group Explorer
The relationships between parent and child rule groups is a hierarchy. The Rule Group Explorer (see 
Figure 6) is a graphical representation of the rule group hierarchy (tree) and provides a convenient 
way to navigate the entire rule group hierarchy.

Figure 6 shows the following relationships:

■ Root-level rule groups

Figure 6. The Rule Group Explorer

Root-Level Rule Groups

Child Rule Groups
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■ Child rule groups and their characteristics:

■ Rule Groups (lists all child rule groups for the current rule group)

■ Rules

■ Designees

■ Inheritable Rules

Rules in rule groups at the bottom of a hierarchy are processed first, moving up one level each time 
no rule in the previous level passes. Within each level in the hierarchy, the rules are processed by 
ascending order of sequence number.

Administrators (AAs and DAs) use the Rule Group Explorer to create and maintain rule group 
hierarchies. AAs have organization visibility, so they see the rules for their specific organization or 
organizations. Typically, AAs use the Rule Group Explorer views in the assignment administration 
screen but can also use the views in the delegated assignment administration screen. DAs must use 
the My Rule Group Explorer view in the delegated assignment screen and can see only rule groups 
for which they are an owner or designee, and the rule groups and rules that appear below (subtree).

DAs can only create a new rule group below one for which they are the owner or designee, and this 
new rule group is considered a child rule group. DAs can also create grandchild rule groups, great-
grandchild rule groups, and so on.

For more information about rule groups, see �About Hierarchical Rule Groups� on page 51.

About Assignment Rule Inheritance and Templated 
Criteria
Rule inheritance allows assignment administrators (AAs) to enforce business logic, while allowing 
delegated administrators (DAs) to further refine that logic. In addition, inheritors of rules can refine 
those same rules and specialize them for their unique circumstances.

Templated criteria are special criteria that can be applied to inherited rules. Assignment Manager 
does not process templated criteria until an inheritor of an assignment rule chooses to apply a 
template to the inherited rule.

To use templated criteria, administrators (AA or DA) must first create criteria templates for 
inheritable rules by checking the Template field in the Criteria list for the criteria they want as 
templates. When an assignment rule is inherited, the inheritor has the option to either apply the 
templated criteria into an actual criterion--by checking the Create From Templates button in the 
Criteria view tab--or to create a new criterion for the inherited rule.

NOTE: Assignment Manager ignores criteria that have the Template field checked on an assignment 
rule until such time as that rule is inherited and the templated criteria is applied to the inherited rule. 

TIP: It is recommended that AAs create templated criteria to assist DAs in rule creation. This 
reduces the need for DAs to fully understand the steps required and implications of creating new 
logic.
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For more information about creating criteria templates for assignment rules, see �Adding Criteria 
Templates to Assignment Rules� on page 158. For more information about applying templated criteria 
to assignment rules, see �Applying Templated Criteria to Inherited Assignment Rules� on page 160. For 
examples of delegated assignment rule inheritance and adding and applying templated criteria to 
assignment rules, see �Examples for Using Delegated Assignment� on page 75. 
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3 Assignment Methodology, 
Strategies, and Scenarios
This chapter provides common strategies and scenarios that you can use to develop effective 
assignment rules for your sales and service organizations. It includes the following topics:

■ �Assignment Methodology� on page 57

■ �Assignment Strategy Considerations� on page 61

■ �Assignment Strategy for Sales Organizations� on page 61

■ �Example of Creating Sales Assignment Rules Based on Territories� on page 62

■ �Example of Creating Sales Assignment Rules That Combine Criteria� on page 64

■ �Scenarios for Using Multitiered Assignment with Sales Assignment Rules� on page 66

■ �Assignment Strategy for Service Organizations� on page 68

■ �Example of Creating Field Service Assignment Rules Using Availability� on page 70

■ �Scenario for Assigning Candidates Dynamically� on page 73

■ �Examples for Using Delegated Assignment� on page 75

Assignment Methodology
Siebel Assignment Manager uses the following methodology to assign candidates to assignment 
objects.

1 Find assignment rules for the object. Find active assignment rules for evaluation for the 
object being assigned. Assign objects to assignment rules in the Objects to be Assigned field in 
the Assignment Rules List view. If there are no active rules for the assignment object, default 
assignees are assigned. In rule group mode, all the active rules for the assignment object 
belonging to the rule group of the request are processed.

NOTE: Assignment Manager evaluates rules in ascending order of the sequence number. For 
more information about the order in which rules are evaluated, see �About Assignment Rule 
Sequencing� on page 26.

2 Evaluate assignment criteria for the object. After determining the rules for processing, 
Assignment Manager processes rules in ascending sequence number order. For each rule, 
Assignment Manager first evaluates each criterion with the Compare to Object comparison 
method.

NOTE: If criteria marked as Required do not satisfy the object�s attributes, then Assignment 
Manager stops evaluating the assignment rule. 
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3 Determine a list of candidates from each assignment rule. For each assignment rule that 
satisfies Step 2, Assignment Manager determines a list of person and organization candidates 
relevant to the assignment rule, depending on the Person Candidate Source and Organization 
Candidate Source fields on the assignment rule.

■ Static candidates from rule. If the Person Candidate Source is indicated as From Rule, 
then:

❏ If the assignment object uses position-based assignment, the candidate list includes the 
positions registered in the Position Candidates view.

❏ If the assignment object uses employee-based assignment, the candidate list includes 
the employees registered in the Employee Candidates view.

■ All People. If the Person Candidate Source is indicated as All People, the candidate list 
includes all registered employees or positions in the Siebel database.

■ Dynamic candidates. If the Person Candidate Source is the name of a team (such as 
Activity Account Team or Activity Asset Team), Assignment Manager obtains the candidate 
list from the team table related to the object row.

The list of organization candidates for each rule are determined using the same method.

4 Evaluate each candidate against assignment rule criteria. Evaluate each candidate against 
the criteria using the selected comparison method as described in �About Assignment Criteria and 
Criteria Methods� on page 27. Workload distribution rules are also processed for each candidate.

NOTE: Candidates fail if they do not match any required criterion and are not evaluated further 
against this rule.

5 Score each qualified candidate for each assignment rule. Scoring of each candidate for an 
assignment rule is based on the sum of:

■ Assignment rule score

■ Score of each assignment criterion that is satisfied

■ Each assignment criterion value that is satisfied depending on the inclusion method as 
explained in �About Assignment Criteria and Criteria Methods� on page 27 

Some assignment criteria values (skills) are weighted by expertise.

❏ To rank expertise codes, use the Order field in the List of Values view. For procedures, 
see �Creating Expertise Codes� on page 140. 

❏ To define expertise weight, use the Weighting Factor field in the List of Values view. For 
procedures, see �Defining Weighting Factors� on page 141. 

For more information about skills, see �About Assignment Skills� on page 37. For more 
information about expertise, see �Expertise Codes� on page 37. For more information about 
weighting factors, see �Weighting Factors� on page 38.

■ Score for the candidate

For static candidates, this value is specified in the Employees Candidates view, Position 
Candidates view, or Organization Candidates view. For dynamic candidates, this value is 
specified in the Score Column property in the Dynamic Candidate object.
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■ Criterion that is calculated as the prorated score

Score based on the current workload of candidates compared to the maximum workload 
allowed. For more information about workload criteria, see �About Assignment Workload 
Criteria� on page 40.

If the Assignment Rule form has the Check Employee Calendar box selected, Assignment 
Manager uses the availability-based assignment feature to submit employee availability 
information to the Field Service Appointment Booking System (ABS), which reviews qualified 
candidates� calendars and work schedules to see who is available to undertake the 
assignment at the required time. Employees who are not available at the requested time for 
the specified duration are eliminated.

At this point, the score for the assignment rule is calculated from either the highest scoring 
person candidate or organization candidate depending on the value in the Assignment 
Scoring Mode property for the assignment object. 

For more information about employee availability, see �About Availability-Based Assignment� 
on page 42. For more information about the Assignment Scoring Mode property, see Object 
Types Reference.

6 Apply the assignee filter to scored candidates to generate a list of potential assignees. 
Use the assignee filters to eliminate candidates and determine a final list of assignees. The 
choices are:

■ All, Above Minimum

■ All, Must Assign

■ One, Best Fit

■ One, Random

For more information about each of these filters, see �Assignee Filter Field� on page 20.

7 Evaluate exclusive assignment rules and determine the primary assignment rule. If no 
exclusive assignment rule exists or none of the exclusive rules passed, the assignment rule with 
the highest score is the primary assignment rule. If all assignment rules do not have a score or 
more than one rule has the same highest score, then the assignment rule with the lowest row ID 
is used to break the tie in the process of finding the primary assignment rule. If AddScores is set 
to TRUE, scores for each candidate are merged across rules and the candidate primaries are 
calculated based on the total scores.

If at least one assignment rule marked as exclusive passes, the exclusive assignment rule with 
the higher score is chosen as the primary rule. Only the assignees in this assignment rule are 
kept and all the assignees from other assignment rules are ignored. 

If no rules passed or more than one exclusive assignment rule yields the same highest score, 
Assignment Manager assigns the object to:

■ The default employee for employee-based assignments

■ The default position for position-based assignments
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■ The default organization for organization-based assignments

NOTE: When two or more exclusive assignment rules have the same score and the Keep Man 
Asgn Primary Position assignment property is set to TRUE, then the manually assigned primary 
position is retained and the default position is added to the team as a nonprimary.

8 Determine the primary assignees. Determine the primary assignees from the primary 
assignment rule:

■ For objects that use employee-based assignments, set the primary assignee to the primary 
employee selected in the Primary Employee field of the Assignment Rule form applet for the 
primary assignment rule. If the selected primary employee is not an assignee that satisfies 
Step 6 on page 59, or if there is no primary employee specified on the rule, then select the 
highest-scoring employee for the primary assignment rule that satisfies Step 6 on page 59.

■ For objects that use position-based assignment, set the primary assignee to the primary 
position selected in the Primary Position field of the Assignment Rule form applet for the 
primary assignment rule. If the selected primary position is not an assignee that satisfies 
Step 6 on page 59, or if there is no primary position specified on the rule, then select the 
highest-scoring position for the primary assignment rule that satisfies Step 6 on page 59.

■ For objects that use organization-based assignments, set the primary organization to the 
primary organization selected in the Primary Organization field of the Assignment Rule form 
applet for the primary assignment rule. If the selected primary organization is not an 
assignee that satisfies Step 6 on page 59, or if there is no primary organization specified on 
the rule, then select the highest-scoring organization for the primary assignment rule that 
satisfies Step 6 on page 59.

NOTE: The primary employee, position, or organization must pass the minimum score required 
for this assignment rule for assignment as the primary assignee. The only exception is when the 
Assignee Filter is All, Must Assign, in which case the highest-scoring candidate is a potential 
assignee if all candidates fail to meet the minimum score. For more information about assignee 
filters, see �Assignee Filter Field� on page 20. 

9 Filter out certain assignees based on multitiered mode. By default, the assignment mode 
is set to independently assign qualifying people and organizations. Three other assignment 
modes are available, which allows filtering of unwanted, but qualifying, people and organizations 
based on the relationship that exists between them. Then recalculate primaries, if necessary; for 
example, if primaries were filtered out by multitiered filtering. See �About Multitiered Assignment� 
on page 43 for further information.

10 Generate assignments. Write assignees to the database to finalize the assignment.

■ Write the primary assignment rule and primary assignees to the object�s primary table.

■ For team-based objects, write assignees to the object�s team table.

NOTE: For interactive assignments, assignees appear in the appropriate list applet after 
calculation. The candidate that Assignment Manager determines as the primary appears 
highlighted in yellow. The user can then choose the candidate or candidates for assignment, or 
the user can override and assign a different primary by selecting a different record.
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Assignment Strategy Considerations
To use Assignment Manager for your organization, you must develop and document a clear set of 
strategies that can be consistently applied by Assignment Manager or system administrators.

For each assignment object, you should consider how to develop assignment rules that:

■ Optimally match the attributes of assignment objects to criteria values of the assignment rules. 
This is commonly used for traditional territory assignment where territories are managed 
exclusively through assignment administration. Employees, positions, or organizations 
associated with these rules are potential assignees. Sales organizations typically use this 
method.

■ Optimally match the attributes of assignment objects to employee skills. Expertise is managed 
using employee, position, or organization skills. Service organizations typically use this method.

■ Reflect a blend of the attributes outlined in the two methods described above. For example, sales 
organizations can benefit from assignment rules using employee skills as well as territory rules.

Assignment Strategy for Sales 
Organizations
Sales organizations typically need to distribute opportunities and accounts to the proper people 
within the organization. Assignment of sales opportunities must take place quickly so that sales 
representatives can respond to potential revenue-generating opportunities. Information must also 
be readily available to salespeople to close the maximum number of sales possible.

Assignments in sales organizations are commonly made to positions responsible for a territory. 
Mobile salespeople who are not connected to a network can share information and work as a 
collaborative sales force on sales opportunities. Sales organizations can therefore use the talents of 
their salespeople within their entire organization.

Siebel Assignment Manager allows you to create territories for positions using a wide variety of 
criteria. By assigning objects to positions, you can have one sales representative inherit the 
opportunities, accounts, and contacts from another sales representative by reassigning the employee 
responsible for a specific position.

After you have created the territories using assignment criteria, a major territory realignment can 
negatively affect your system resources. If the realignment is large, Assignment Manager may create 
a volume of transactions for mobile clients, which increases synchronization time drastically. To avoid 
this, you can run a database extract server task (DbXtract) again and have the mobile clients 
initialize their databases. Because the time required to run a database extract server task for 
multiple clients may be significant, try to coordinate territory realignments with database extracts 
to occur during a time of low system utilization. For more information about database extracts, see 
Siebel Remote and Replication Manager Administration Guide. For more information about running 
server tasks, see Siebel System Administration Guide.
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Because sales organizations typically distribute their accounts and opportunities based on territories, 
create assignment rules based on these territories. Assignment Manager includes two additional 
views, Territory List view and Territory Detail view, originally designed for sales organizations. 
However, these views function exactly as the Assignment Rule view and Assignment Criteria view, 
respectively. The Territory List view has been simplified to allow users to define their sales territories. 
For this reason, some of the assignment options covered in this chapter do not appear in the Territory 
List view.

NOTE: The Territory List and detail views may eventually be phased out from the assignment 
administration screens. If your configuration currently uses these views, note that they can migrate 
to the existing Assignment Rule views with no loss of functionality or data. For further information 
about these views, contact Siebel Technical Support.

Example of Creating Sales Assignment Rules Based on 
Territories
This topic gives one example of how a sales organization can strategically assign salespeople based 
on territories. You may use this feature differently, depending on your business model. 

Your sales organization wants to create four territories based on geographic location. In this case, 
you may want to create four assignment rules: US NW, US NE, US SE, and US SW, as shown in 
Figure 7. Assignment Manager then assigns your salespeople depending on the geographic location 
of the sales opportunity.

NOTE: For detailed instructions on performing each step in the following procedure, see Chapter 5, 
�Assignment Rule Administration.�

To create sales assignment rules based on territories

1 Create assignment rules as sales territories.

In this example, in the Assignment Rule view you create four assignment rules, one for each 
territory as shown in Figure 7.

2 Determine the assignment criteria.

In this example, in the Assignment Criteria view, you define Account State as the criteria for each 
assignment rule, because the assignment rules are based on territories.

Figure 7. Example of Creating Sales Territories

One of the assignment rules 
representing a sales territory (US 
NW) highlighted in the Assignment 
Rules List view.
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3 Define the criteria values.

In this example, in the Assignment Criteria view, you use the states that make up each territory 
as criteria values.

The following figure shows an example of defining a sales territory using assignment criteria and 
values as described in Step 2 and Step 3.

4 Add the Positions.

In the Assignment Positions view, add the sales positions responsible for each territory. As an 
example, you add Division Manager - West and Field Sales Representative to the US NW 
assignment rule.

NOTE: To specify a primary position, you must set the primary at the rule level (in the Primary 
Position field in the Assignment Rule view) and also assign a specific position within that rule 
(Assignment Rules > Positions). For more information on the primary position, see �Creating 
Assignment Rules� on page 130. For more information about assigning positions, see �Adding 
Positions to Assignment Rules� on page 150.

5 Release the assignment rules.

In the Assignment Rules view, click the Release button. You can then run Batch Assignment to 
assign objects affected by the assignment rules. For more information about running Batch 
Assignment, see �Running Assignment Manager in Batch Mode� on page 184.

After these assignment rules are released, Assignment Manager assigns salespeople based on the 
geographic location of the sales opportunity. For example, a sales opportunity in California is 
assigned to a Western Field Sales Representative. 

NOTE: After an account or opportunity has been assigned to a sales team, the list of Territory 
definitions used by Assignment Manager for this item is added to the item record in the Territories 
field. This list is not modifiable in the standard user Account or Opportunity detail views.
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For an example of how a sales organization can strategically distribute salespeople by using 
assignment rules based on territories and revenue, see �Example of Creating Sales Assignment Rules 
That Combine Criteria� on page 64. For general information about sales assignment strategies, see 
�Assignment Strategy for Sales Organizations� on page 61.

Example of Creating Sales Assignment Rules That 
Combine Criteria
This topic gives one example of how a sales organization can distribute its salespeople in the same 
geographic location based on revenue potential. You may use this feature differently, depending on 
your business model.

You can create territories that use the same geographic location but different revenue potentials. In 
this example, you may want to create two assignment rules: US SW High Revenue and US SW Low 
Revenue as shown in Figure 8. Assignment Manager then assigns your salespeople, depending on 
both the geographic location and the revenue potential of the sales opportunity.

NOTE: For detailed instructions on performing each step in the following procedure, see Chapter 5, 
�Assignment Rule Administration.�

To create sales assignment rules that combine criteria

1 Create assignment rules.

In this example, create two assignment rules, one for each territory, as shown in Figure 8.

2 Determine the assignment criteria.

In this example, select Account State and Revenue as the criteria.

3 Define the criteria values.

In this example, use the states that make up each territory as the Account States criteria values. 
For the Revenue criteria values, select different assignment attributes for each assignment rule:

■ For the US SW High Revenue assignment rule, type 100,001 in the Revenue Low assignment 
attribute.

Figure 8. Example of Creating Assignment Rules with Combined Criteria

Two assignment rules, one 
for each territory, created 
for opportunity objects.
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■ For the US SW Low Revenue assignment rule, type 100,000 in the Revenue High assignment 
attribute.

NOTE: The columns that appear in the Values list applet change dynamically depending on the 
criteria selected in the Criteria list applet.

The following figure shows an example of defining the US SW High Revenue assignment rule as 
described.

4 Add the positions for this assignment rule.

In this example, you add a different sales position for each assignment rule:

■ For the US SW High Revenue assignment rule, add Division Manager - West.

■ For the US SW Low Revenue assignment rule, add Western Field Sales Representative.

The figure shown in Step 3 shows an example of defining the US SW High Revenue assignment 
rule as described.

5 Release the assignment rules. 

In the Assignment Rules view, click the Release button. You may then run Batch Assignment to 
assign objects affected by the assignment rules. For more information about running Batch 
Assignment, see �Running Assignment Manager in Batch Mode� on page 184.

After these assignment rules are released, Assignment Manager assigns salespeople based on 
the geographic location and revenue potential of the sales opportunity. For example, a sales 
opportunity in Nevada with a revenue potential of over $100,000 is assigned to the western 
division manager. However, a sales opportunity in New Mexico with a revenue potential of 
$100,000 or lower is assigned to a western field sales representative.

For an example of how a sales organization can strategically assign salespeople based only on 
territories, see �Example of Creating Sales Assignment Rules Based on Territories� on page 62. For 
general information about sales assignment strategies, see �Assignment Strategy for Sales 
Organizations� on page 61.
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Scenarios for Using Multitiered Assignment with Sales 
Assignment Rules
Multitiered assignment is a logical assignment feature that considers the relationships between 
people and organizations before assigning an object, which makes this feature well-suited to sales 
organizations. To activate multitiered assignment, you must first use Siebel Tools to configure 
assignment objects. Then, after assignment objects are configured, multitiered assignment can 
function in various modes. 

The following scenarios show how multitiered assignment functions in various modes. Each scenario 
is based on the same sales opportunity and the same assignment rules.

Independent Assignment. If multitiered assignment is disabled, Assignment Manager assigns the 
object independently, resulting in the following scenario:

■ All people and organizations not matching assignment rule criteria are filtered out.

■ For each person that matches, assign that person to the object.

■ For each organization that matches, assign that organization to the object.

■ The European and Asian sales representatives independently are assigned to the same 
opportunity as well as the Europe and North America organizations, as shown in the following 
table:

Person-Oriented Assignment. If multitiered assignment is set to person-oriented mode the 
following situation occurs:

■ All organizations and people not matching assignment rule criteria are filtered out.

■ For each person that matches, assign that person to the object.

■ Evaluate organization candidates for the assigned people�s organizations. If the organization 
matches, assign that organization to the object.

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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■ The European and Asian sales representatives are assigned, but only the Europe organization is 
assigned, as shown in the following table:

Organization-Oriented Assignment. If multitiered assignment is set to organization-oriented 
mode the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are filtered out.

■ For each organization that matches, assign it to the object. 

■ Evaluate each person candidate for the assigned organization�s people. If a person matches, 
assign that person to the object.

■ The Europe and North America organization are assigned, but only the �European Sales 
Representative� is assigned, as shown in the following table:

Organization and Person-Oriented Assignment. If multitiered assignment is set to organization 
and person-oriented mode, the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are filtered out.

■ For people and organizations that satisfy the assignment rule criteria, assign only those that have 
both a corresponding organization and person that meet the criteria (similar to a logical AND 
statement).

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European 
Sales 
Representative

Europe

North American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N
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■ Only the European sales representative and the Europe organization are assigned, as shown in 
the following table:

For more information about multitiered assignment and its assignment modes, see �About Multitiered 
Assignment� on page 43. For information about configuring multitiered assignment, see �Configuring 
Assignment Objects for Multitiered Assignment� on page 104.

Assignment Strategy for Service 
Organizations
In a service organization, service requests can often be resolved by the first customer service 
representative (CSR) who services the customer. However, when the request cannot be resolved, or 
when the service request is logged through the Internet, ownership must be transferred to a service 
representative who possesses the expertise to handle the request.

In this environment, it becomes critical to assign employees with the proper expertise and skills to 
service requests. Therefore, you should assign employees to objects because some employees 
possess specific skills that are different from those of other CSRs or field service engineers. When 
service representatives are on vacation, are promoted, or assume different responsibilities, work 
assigned to these employees must be reassigned based on the skills and workloads of other 
employees in the service organization.

Use the following strategy to develop assignment rules for your service organization:

■ Determine the different assignment objects to be assigned.

Service organizations need to assign ownership of a wide variety of tasks. These tasks may 
include service requests, activities, and accounts. In addition, a product development 
organization may need to assign ownership of product defects to engineers. For instance, you 
may decide to assign only service requests and product defects, because the associated activities 
are manually assigned by owners of those objects.

■ Determine if multiple assignment objects are assigned using the same assignment rules.

Multiple assignment objects can be assigned using the same assignment rules. For example, if 
you are assigning accounts and service requests in the same manner, you can use the same 
assignment rules by associating those rules with multiple assignment objects.

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N
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■ For each assignment object, determine which of the objects is assigned using the same 
assignment rules.

The Compare to Object comparison method allows you to assign different groups of objects using 
different rules. Typically, complex service environments assign different groups of service 
requests using different rules, such as segmenting the service requests based on service request 
priority.

■ Determine the strategy for each group of objects to be assigned using the same assignment 
rules.

Use the skill criteria to minimize the number of assignment rules. One assignment rule can match 
different candidates to various objects based on the object characteristics and candidate skills. 
To determine optimal assignment, determine the criteria that you want to evaluate for each 
candidate to make sure that the candidate possesses the proper skills to handle the task. This is 
the primary type of criteria you use most frequently for implementing assignments in a customer 
service environment. These criteria are defined using the Compare Object to Person comparison 
method in the Assignment Criteria view.

■ Define workload rules.

Determine the various methods of calculating workloads for employees in your organization. 
Each workload rule is associated with a specific assignment object. For instance, you can define 
two workload rules to calculate:

■ Open Service Requests for an employee

■ Critical Service Requests submitted through Siebel eService

■ Define assignment rules, assignment criteria, assignment criteria values, and assignment 
workloads.

Using the strategy, rules, and criteria discussed above, define the assignment rules and the 
corresponding detail using assignment administration views. In defining rules, criteria, values, 
and workloads, you can specify scores for each component. These scores are aggregated in 
determining the total score for each candidate of an assignment rule.

■ Define candidates.

Using the All People value in the Person Candidates Sources field or the assignment rule 
Employee Candidates view, define the eligible employees for assignment. You may further 
restrict or weight employees who have different skills using the Compare to Person assignment 
criteria.

■ Define employee skills.

After the assignment rules and the corresponding details have been defined, a customer service 
manager must update the employee skill information (such as product expertise, language skills, 
and geography). Assignment Manager uses these attributes when evaluating Compare to Person 
and Compare Object to Person assignment criteria.

■ Release assignment rules.

In the Assignment Rules view, click the Release button. You can then run Batch Assignment to 
assign objects affected by the assignment rules. For more information about Batch Assignment, 
see �Running Assignment Manager in Batch Mode� on page 184.
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Figure 9 shows a sample assignment rule for assigning support representatives to a service request.

The assignment rule shown in Figure 9:

■ Matches any service request:

■ For Pentium III 600 products

■ With a priority of High

■ Uses two criteria with the following values:

■ Product Wildcard. A list of products that include the value CPU Pentium III 600

■ Service Request Priority. A list of service requests whose priority level is High

Example of Creating Field Service Assignment Rules 
Using Availability
This topic gives one example of creating an assignment rule that evaluates a service request object 
and assigns the object to the highest scoring employee based on the employee�s skill level and 
availability. You may use this feature differently, depending on your business model.

The service request object�which is often associated with a job, a finite time period, and a specific 
owner�is an example of an object that can be assigned using Assignment Manager�s availability-
based assignment feature.

Figure 9. Assignment Rule for a Service Organization
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To use the availability assignment feature, certain setup procedures must be performed in the Field 
Service application before creating the assignment rule. For more information about this feature and 
its requirements, see �About Availability-Based Assignment� on page 42. Several configurations must 
also be made to the assignment object before using the availability feature. See �Configuring 
Assignment Objects for Availability-Based Assignment� on page 100.

NOTE: The following procedure assumes that a service region (California Service Region), 
employees (West Coast Service Representative and West Coast Service Manager), and a product 
(Pentium III Desktop) are already defined. For information about defining service regions, see Siebel 
Field Service Guide.

To set up the Field Service application for availability assignment

1 Verify a schedule exists with valid hours.

Navigate to the All Schedules view (Administration - Service > Schedules). For this example, 
select the 12x5 Support schedule in the Schedules List and click the Schedule Hours view tab. 
Make sure the hours listed are valid. The following figure shows this view.

2 Set up a Service Region.

Navigate to the Administration - Scheduling screen Service Regions view. For this example, select 
the California Service Region. In the Schedule field, select 12x5 Support.

3 Set up the parameter set for the Service Region.

With California Service Region selected, navigate to the Parameters Sets view (in the Scheduling 
Administration screen). For this example, select the West Coast Parameters used by the 
California Service Region and click the Parameters tab. Update the following parameter records:

■ ABS Days to Start=0 

■ ABS Days to End=20

■ ABS Logging Level=4
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4 Set up server key mappings.

Navigate to the Server Key Mappings view in the Scheduling Administration screen. For this 
example, create a new record and save it with the following field values:

■ Server=Siebel Server

■ Process #=0

■ Service Region=California Service Region

■ Component=ApptBook

5 Associate employees to the service region.

Navigate to Administration - User > Employees. For this example, select the West Coast Service 
Representative and the West Coast Service Manager and click the Field Service Details tab. Edit 
the Schedule and Service Region fields with 12x5 Support and California Service Region, 
respectively.

NOTE: If service regions are modified or deleted, you must release assignment rules to update the 
rulecache.dat file.

After the Field Service application is configured, create the assignment rule that uses the assignment 
availability feature.

To create a field service assignment rule

1 Create the assignment rule.

Navigate to Assignment Rules List view of the Administration - Assignment screen, and create 
the assignment rule. For this example, name the rule West Coast Service. Define the assignment 
object as Service Request and the assignee filter as One, Best Fit. The Check Employee Calendar 
box is the field that activates the assignment availability feature. Check this box once to make 
this feature operational.

2 Determine assignment criteria.

Navigate to the Criteria view tab and create Product criteria for the assignment rule. For this 
example, service representatives are evaluated with the Compare Object to Person based on an 
employee�s product knowledge.

3 Determine assignment criteria values.

Navigate to the Values view and create a new record with Pentium III desktop.

4 Define employees for the assignment rule.

Navigate to the Assignment Employee view and add the West Coast Service Representative and 
the West Coast Service Manager to the assignment rule.

5 Release the assignment rule.
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Now, when a service request is created with attributes that match both West Coast service 
representatives, Siebel Assignment Manager, through the Field Service Appointment Booking System 
(ABS), assigns the employee who has available time in his or her calendar and work schedule. 
Optionally, the ABS can create an activity in the assigned employee�s calendar. For more information, 
see �Configuring Assignment Objects for Availability-Based Assignment� on page 100. For more 
information about ABS, see Siebel Field Service Guide. 

Figure 10 shows the assignment rule described in the preceding procedure. 

Scenario for Assigning Candidates 
Dynamically
This scenario gives one example of how you can dynamically assign candidates. You may use this 
feature differently, depending on your business model.

For this scenario, candidates are assigned to an activity based on the information provided in Table 9. 
The numbers at the top of the table correspond to the numbered text following the table.

Figure 10. A Field Service Assignment Rule with the Check Employee Calendar Field Activated

Table 9. Sample Data for Dynamic Candidates Assigned to an Activity

1 2 3 4

Asset Team 
Member Type

Account Team 
Member Type

Service 
Region Skills

Employee 1 Primary Employee 3 Primary Employee 1 ENU

Employee 2 Secondary Employee 6 Secondary Employee 2 FRA

Employee 3 Tertiary Employee 2 Tertiary Employee 3

Employee 4 Tech Support Employee 4 Tech Support Employee 7

Employee 5 Never Send Employee 7 Never Send Employee 8
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1 The activity has an asset team and each employee in that team has a type. All the employees in 
this team are eligible candidates for the activity. The employees are scored based on their type 
and the following assignment rules:

■ If Organization = Americas, primary score = 100.

■ If Organization = Europe, primary score = 50.

Based on the rules and their type, assume the asset team scores are:

Employee 1 =100
Employee 2 = 75
Employee 3 = 50
Employee 4 = 25
Employee 5 = 0

2 The activity has an account team and each employee in that team has a type. All the employees 
in this team are eligible candidates for this activity. The employees are scored based on their 
type.

The account team scores are:

Employee 3 = 80
Employee 6 = 60
Employee 2 = 30
Employee 4 = 10
Employee 7 = 0

3 The activity has a service region, and the service region has employees. All employees are 
eligible candidates for skill matching. You match activity skills and employee skills, but you can 
specify other matching criteria as well.

Employee 1= 100
Employee 2= 150
Employee 3= 75
Employee 7= 200
Employee 8 = 25

4 This step determines the final list of candidates for this activity. This list is the union of the 
employees from all three lists above, and employee scores are added if they exist in more than 
one list.

The final list of candidates for this activity with their corresponding scores is:

Employee 1=200 (100 + 100)
Employee 2=255 (75 + 30 + 150)
Employee 3=205 (50 + 80 + 75)
Employee 4=35 (25 + 10)
Employee 5=0
Employee 6=60
Employee 7=200 (0 + 200)
Employee 8=25
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Examples for Using Delegated 
Assignment
This topic provides an example of how delegated assignment might be used. You may use delegated 
assignment differently, depending on your business model. Your company may follow a different 
process according to its business requirements. 

It covers the following topics:

■ �Scenario for Working with Delegated Administrators� on page 75

■ �Delegated Assignment Example 1: Assignment Administrator Tasks� on page 77

■ �Delegated Assignment Example 2: 2nd-Tier Delegated Administrator Tasks� on page 79

■ �Delegated Assignment Example 3: 3rd-Tier Delegated Administrator Tasks� on page 81

■ �Delegated Assignment Example 4: 3rd-Tier Delegated Administrator Tasks for Partners� on page 81

■ �Summary for Working with Delegated Administrators� on page 82

Scenario for Working with Delegated Administrators
This scenario is one of the topics for �Examples for Using Delegated Assignment� on page 75.

A sales organization for a high tech company wants to create assignment rules that are inheritable 
and configurable by several different levels in the organization. The requirements are:

■ Handle large sales leads internally; handle small sales leads externally using partners

■ Promptly assign sales leads to the most qualified representative 

■ Design complex assignment rules, making use of the delegated assignment inheritance and 
templated criteria features to allow for uncomplicated rule administration by persons at all levels
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In this scenario, the Sales EVP, vice presidents, regional sales managers, partners, and sales 
representatives participate in delegated assignment for one rule group hierarchy as shown in 
Figure 11.

Figure 11 shows the following relationships:

■ Amy, Executive Vice President of Sales, is the assignment administrator (AA)

■ Two vice presidents report to Amy:

■ Lance, VP Direct Sales

■ Henry, VP Channel Sales

Lance and Henry are 2nd-tier delegated administrators

■ Two managers report to Lance:

■ Sarah, Western Regional Manager

■ Rick, Eastern Regional Manager

Sarah and Rick are 3rd-tier delegated administrators (DAs)

■ Two partners report to Henry:

■ Robin, Partner 1

■ Sam, Partner 2

Robin and Sam are also 3rd-tier delegated administrators (DAs)

■ Three western regional sales representatives report to Sarah

■ Three partner sales representatives report to Robin

Figure 11. Sample Delegated Assignment Organization Chart
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Table 10 provides sample responsibilities for each of the above positions.

Delegated Assignment Example 1: Assignment 
Administrator Tasks
This example is one of the topics for �Examples for Using Delegated Assignment� on page 75.

The assignment administrator (AA) makes sure that large leads go to internal sales reps (by way of 
Lance, VP Direct Sales) and small leads go to channel partners (by way of Henry, VP Channel Sales).

Tasks for the assignment administrator

1 Create a root-level rule group.

In this example, Amy organizes her assignment rules into a logical grouping�rules that route 
leads are in one rule group.

For information about how to create a root-level rule group, see �Creating Assignment Rule 
Groups� on page 128.

2 Create a child rule group (or groups) with the root-level rule group as the parent.

In this example, Amy creates two rules groups as follows:

■ Rule Group 1 with Owner = Lance

■ Rule Group 2 with Owner = Henry

This allows Henry and Lance the ability to manage their own lead assignment rules for their 
subordinates. 

For information about how to create a child rule group, see �Creating Child Assignment Rule 
Groups� on page 157.

3 Create an assignment rule (or rules).

a Add a new assignment rule.

Table 10. Sample Positions and Responsibilities for Delegated Assignment Scenario

Position Responsible for...

Executive Vice President 
(EVP) of Sales 

Making sure large leads are handled by internal sales representatives 
and small leads are handled by partner sales representatives.

VP Direct Sales Making sure leads are routed to the right regional manager.

VP Channel Sales Making sure leads are routed to the right partner.

Regional Manager Making sure leads are routed to the best sales representative.

Partner Making sure leads are routed to best partner employee (because the 
high tech company cannot determine which partner employee is best 
suited for the lead).
Siebel Assignment Manager Administration Guide Version 7.7 ■ 77



Assignment Methodology, Strategies, and Scenarios ■  Examples for Using Delegated 
Assignment
b Assign candidates to the rule.

For information about adding candidates to assignment rules, see �Adding Employees, 
Positions, and Organizations to Assignment Rules� on page 147.

c Add criteria templates (templated criteria) to the rule.

NOTE: It is recommended that assignment administrators create criteria templates to assist 
DAs in rule creation. This reduces the need for DAs to fully understand the steps required 
and implications of creating new logic.

For information about adding criteria templates to assignment rules, see �Adding Criteria 
Templates to Assignment Rules� on page 158.

d Add owners of the child rule groups to the inheritance access list for the assignment rule.

After owners are added to the inheritance access list, inheritors of those rules can refine and 
specialize the rules by adding criteria and candidates for their unique circumstances.

For information about adding owners to the inheritance access list for an assignment rule, 
see �Adding Owners to the Inheritance Access List� on page 157.

In this example, create the following assignment rules to route leads to Lance and Henry. 

This makes sure that large leads are managed by internal sales and smaller leads are managed 
by partners.

Task Assignment Rule 1 Assignment Rule 2

Add criteria Leads > $100k Leads < $100k

Assign candidates Lance (VP Direct Sales) Henry (VP Channel Sales)

Add owners to inheritance access list Lance Henry
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4 (Optional) Create additional criteria templates (templated criteria).

a Create new criteria for the assignment rule.

b Click the Template flag for each new criteria created.

In this example, use the following criteria. 

This allows Lance and Henry the ability to refine rules with predefined criteria instead of creating 
new criteria.

Delegated Assignment Example 2: 2nd-Tier Delegated 
Administrator Tasks
This example is one of the topics for �Examples for Using Delegated Assignment� on page 75.

The 2nd-tier delegated administrators (DAs) make sure that the leads that are more than $100K are 
routed to the correct sales manager based on geography and territories:

■ Leads in the eastern states go to Rick

■ Leads in the western states go to Sarah

Tasks for 2nd-tier delegated administrators

1 In the Rule Group Explorer, select a rule group previously created by the assignment 
administrator.

In this example, Lance selects the rule group for which he is the owner (Rule Group 1).

2 Create a child rule group (or groups) with the current rule group as the parent.

In this example, Lance creates two rules groups as follows:

■ Rule Group 10 with Owner = Rick; Parent Rule Group = Rule Group 1

■ Rule Group 20 with Owner = Sarah; Parent Rule Group = Rule Group 1

This allows Rick and Sarah the ability to manage their own lead assignment rules for their 
subordinates. 

For information about how to create a child rule group, see �Creating Child Assignment Rule 
Groups� on page 157.

Add to Rule Assignment Rule 1 Assignment Rule 2

Templated Criteria 1 Product Line= Servers

Templated Criteria 2 Product Line = PCs

Templated Criteria 3 Product = Notebooks State = NY, CT, NJ

Templated Criteria 4 Product = Desktops State = WA, CA, OR, NV

Templated Criteria 5 Product = Peripherals
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3 Inherit assignment rule (or rules).

In this example, Lance inherits Amy�s rule twice so that he can refine each rule to make sure 
leads in the western states go to Sarah and leads in the eastern states go to Rick.

For information about inheriting an assignment rule, see �Inheriting Delegated Assignment Rules� 
on page 159.

4 Refine the inherited assignment rule (or rules).

a Apply templated criteria (criteria from templates).

See �Applying templated criteria to an assignment rule� on page 160.

b Add candidates.

See �Adding Employees, Positions, and Organizations to Assignment Rules� on page 147.

In this example, use the following information to refine the assignment rules. 

5 Add owners of the child rule groups to the inheritance access list for each assignment rule.

See �Adding Owners to the Inheritance Access List� on page 157.

After you add Sarah and Rick to the inheritance access list for the appropriate assignment rule, 
Sarah and Rick can inherit the rules and further refine them by adding criteria and specifying 
candidates.

Henry follows the same steps as Lance, except Henry uses different templated criteria to route leads 
based on product line as follows:

■ Leads for PCs go to Robin (employee of Partner 1)

■ Leads for servers go to Sam (employee of Partner 2)

Rule Data Assignment Rule 10 Assignment Rule 20

Criteria Leads > $100k1

1. Criteria inherited from the original rule and is read only.

Leads > $100k1

Criteria State = WA, CA, OR, NV2

2. Applied from templated criteria.

State = NY, CT, NJ2

Candidate Sarah Rick
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Delegated Assignment Example 3: 3rd-Tier Delegated 
Administrator Tasks
Sarah and Rick are 3rd-tier delegated administrators in the rule group hierarchy. 

Sarah and Rick follow the same steps as Lance in �Delegated Assignment Example 2: 2nd-Tier 
Delegated Administrator Tasks� on page 79, except Sarah and Rick:

■ Inherit Lance�s rules (Assignment Rule 10 and 20), and refine those rules so that the leads are 
routed directly to sales representatives.

■ Do not need to create child rule groups (because they assign leads directly to representatives).

Delegated Assignment Example 4: 3rd-Tier Delegated 
Administrator Tasks for Partners
This example is one of the topics for �Examples for Using Delegated Assignment� on page 75.

The 2nd-Tier partner delegated administrator makes sure that leads that have been assigned to 
Partner 1 are routed to the best sales representative and that no leads go unassigned.

1 In the Rule Group Explorer, select the rule group previously created by the 2nd-tier delegated 
administrator (Henry, in this example).

In this example, assuming Henry created Assignment Rule 30 for Robin and Assignment Rule 40 
for Sam, Robin selects Rule Group 30. 

2 Inherit the assignment rule (or rules).

In this example, Robin inherits Henry�s rule three times and refines each rule to make sure leads 
are routed to one of Partner 1�s three sales representatives.

For information about inheriting an assignment rule, see �Inheriting Delegated Assignment Rules� 
on page 159.

3 Refine the inherited rule (or rules).

a Apply templated criteria (criteria from templates).

See �Applying templated criteria to an assignment rule� on page 160.

b Add candidates.

See �Adding Employees, Positions, and Organizations to Assignment Rules� on page 147.
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4 Add owners to the inheritance access list for the assignment rule.

See �Adding Owners to the Inheritance Access List� on page 157.

In this example, use the following information: 

Summary for Working with Delegated Administrators
This summary is one of the topics for �Examples for Using Delegated Assignment� on page 75.

Figure 12 shows a high-level process flowchart of the delegated assignment scenario examples 
described in �Examples for Using Delegated Assignment� on page 75.

Figure 12 shows the following relationships:

Apply to 
Rule Assignment Rule 30A Assignment Rule 30B Assignment Rule 30C

Criteria Leads > $100k1

1. This criteria is already inherited and is Read Only.

Leads > $100k1 Leads > $100k1

Criteria Product Line = PCs2

2. Applied from templated criteria.

Product Line = PCs1 Product Line = PCs1

Criteria Product = Desktops Product = Notebooks2 Product = Peripherals2

Candidate Partner 1 Sales Rep 1 Partner 1 Sales Rep 2 Partner 1 Sales Rep 3

Figure 12. Sample Process Flowchart for Delegated Assignment
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■ Amy is the EVP of Sales and is the assignment administrator. Amy must first create root-level 
rule groups, child rule groups, and rules, and add criteria templates (templated criteria) and 
owners of the child rule groups to the assignment rules before delegated assignment can be 
implemented. 

■ Lance and Henry are sales VPs and are delegated administrators (2nd-tier). Lance and Henry 
must first inherit rules in the rule group Amy created for their respective areas, and can then 
further refine and delegate those rules further down the hierarchy.

■ Sarah and Rick are Sales Managers and are delegated administrators (3rd-tier). Sarah and Rick 
inherit the rules created by Lance for their respective areas, and then further refine those rules 
for their sales representatives.

■ Robin and Sam are Partners and are delegated administrators (3rd-tier, similar to Sarah and 
Rick). Robin and Sam inherit the rules created by Henry for their respective areas, and then 
further refine those rules for their sales representatives. 

NOTE: After a rule is inherited in child rule groups and changes are made to the original rule, such 
as adding criteria to, expiring, or even deleting the rule, those changes are propagated down the 
hierarchy to all rules that were inherited from it.

For detailed tasks pertaining to the sample delegated assignment process, see:

■ �Delegated Assignment Example 1: Assignment Administrator Tasks� on page 77

■ �Delegated Assignment Example 2: 2nd-Tier Delegated Administrator Tasks� on page 79

■ �Delegated Assignment Example 3: 3rd-Tier Delegated Administrator Tasks� on page 81

■ �Delegated Assignment Example 4: 3rd-Tier Delegated Administrator Tasks for Partners� on page 81

The following points further summarize delegated assignment activities as they pertain to the 
examples:

■ The examples describe a four-level assignment model. However, this is no limit to the number of 
levels that the delegated assignment manager feature supports, and there is no limit to the 
number of branches in a level. In these examples, the levels are:

Level 1 = Amy
Level 2 = Lance, Henry
Level 3 = Sarah, Rick, Robin, Sam
Level 4 = West Sales Reps 1,2,3, and Partner 1 Sales Reps 1,2,3

■ Rules group hierarchies are executed from the bottom up. For example, Assignment Manager 
attempts to use Robin�s rules to match a particular lead to a candidate before it tries to use 
Henry�s rules. However, if Robin�s rules fail, Assignment Manager then tries Henry�s rules, and 
assigns the lead to Robin, and so on up the hierarchy.

For more information about rule group hierarchies, see �About Hierarchical Rule Groups� on 
page 51. 
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■ Each rule group owner can assign a designee.

Designess have the same responsibilities as an owner. You may want to delegate your ownership 
to someone else, such as an administrative assistant, to perform the tasks.

For more information about owners and designees, see �Owners and Designees� on page 52 and 
�Adding Owners to the Inheritance Access List� on page 157.

■ Each partner should assign one person as the delegated administrator�in these examples, either 
Robin or Sam�and that person should manage the partner�s rule group. This same person should 
receive all leads that are not assigned to the partner�s sales representatives. 

■ AAs and DAs can create new criteria (you are not required to use templated criteria). However, 
it is recommended that the AA create criteria templates (templated criteria) for the most 
common criteria to ease the learning curve for the DAs.

For information on how to create new criteria, see �Configuring Assignment Criteria� on page 113.
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Configuration
This chapter explains assignment object configuration components, how to configure the 
components, and the additional system administration tasks needed to complete your configurations. 
It includes the following topics:

■ �Assignment Manager Configuration Overview� on page 86

■ �Assignment Object Configuration Concepts� on page 87

■ �Assignment Object Configuration Overview� on page 91

■ �Assignment Criteria Configuration� on page 107

■ �Creating New Skills� on page 118

■ �Example of Using Skill Tables� on page 120

■ �Creating Workflow Policy Components� on page 121

■ �Server Administration After Configuring Assignment Manager� on page 125

If you plan to use the predefined Assignment Manager components, skip this chapter and proceed 
to Chapter 5, �Assignment Rule Administration.�
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Assignment Manager Configuration 
Overview
Table 11 lists the assignment configuration tasks you perform using Siebel Tools.

Table 11. Assignment Manager Configuration Tasks

If You Need To... For More Information, See...

■ Create new assignment objects �Creating Assignment Objects� on page 92

■ Modify the predefined assignment 
objects

�Configuring Assignment Objects� on page 92

■ Configure assignment objects for 
dynamic assignment

■ �Configuring Assignment Objects for Dynamic 
Candidates� on page 93 

■ �Configuring Assignment Objects for Dynamic 
Candidate Attributes� on page 95

■ Configure assignment object user 
properties

�Configuring Assignment Object User Properties� on 
page 96

■ Configure Assignment Manager for 
interactive assignment

■ �Configuring Assignment Objects for Interactive 
Assignment� on page 97 

■ �Configuring Interactive Assignment for an 
Assignment Object Using Server Key Mappings� on 
page 100

■ Configure Assignment Manager for 
availability-based assignment

■ �Configuring Assignment Objects for Availability-
Based Assignment� on page 100 

■ �About Creation of Activities for Employees During 
Availability-Based Assignment� on page 104

■ Configure Assignment Manager for 
multitiered assignment

�Configuring Assignment Objects for Multitiered 
Assignment� on page 104

■ Configure assignment objects for 
team scoring

�Configuring Assignment Objects for Team Scoring� on 
page 105

■ Define additional assignment criteria 
types and attributes

■ �Assignment Criteria Configuration� on page 107

■ �Configuring Assignment Attributes� on page 108

■ �Configuring Assignment Attribute Columns� on 
page 111

■ �Configuring Assignment Criteria� on page 113

■ �Configuring Assignment Criteria Attributes� on 
page 115

■ Remove existing assignment criteria 
and attributes

�To remove seed assignment criteria� on page 108
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NOTE: If you add or change assignment objects, assignment attributes, or assignment criteria, you 
must migrate the repository to the server production database. For information on migrating the 
repository, see �Migrating Assignment Rules� on page 127 and Going Live with Siebel eBusiness 
Applications. 

CAUTION: The criteria values, skills, and workload conditions components are specialized. Do not 
configure these components.

Before you can successfully configure Assignment Manager, you need to possess a solid 
understanding of how to use Siebel Tools. For more information, see Using Siebel Tools. You should 
also familiarize yourself with the basics of the underlying Siebel application architecture. For more 
information, see Deployment Planning Guide. Assignment Manager object types are also related to 
Workflow Manager object types. For more information, see Siebel Business Process Designer 
Administration Guide. 

Assignment Object Configuration 
Concepts
Using Siebel Tools, you can create new assignment object definitions in the repository. After you 
compile the changes, these new assignment objects appear in the picklists in your Siebel application 
for assignment object selection.

Assignment Manager features that you can custom configure using Siebel Tools include:

■ List of assignment objects that can be assigned to assignment rules

■ List of attributes that can be incorporated in assignment criteria

■ Behavior of each available assignment object, including whether certain features are activated 
for the assignment object

■ Table and column mappings of assignment objects and attributes

■ Workflow policy component and workflow policy component column mappings of attributes used 
in assignment criteria

■ List of dynamic candidate objects for each assignment object (if want to use dynamic candidates)

■ Disable existing assignment attributes �Disabling an Assignment Attribute� on page 117

■ Create new skills �Creating New Skills� on page 118

■ Work with the skill tables �Example of Using Skill Tables� on page 120

■ Create new workflow policy 
components

■ �Creating Workflow Policy Components� on 
page 121

■ �Example of Creating a Workflow Policy Component� 
on page 121

Table 11. Assignment Manager Configuration Tasks

If You Need To... For More Information, See...
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■ List of dynamic candidate attribute objects for each dynamic candidate (if you want to create 
team-based criteria)

Assignment Manager Object Types
The following object types are specific to Assignment Manager and can be configured using Siebel 
Tools:

■ Assignment Object. Assignment objects are assigned to assignment rules in the Objects to be 
Assigned field of assignment rule records. An assignment object specifies a business entity to 
which a candidate can be assigned, what is updated to accomplish that assignment, and other 
assignment behavior parameters.

■ Assignment Attribute. An assignment attribute object definition defines an attribute that can 
be referenced in assignment criteria records. It specifies a logical attribute that can be chosen 
from a picklist for defining comparisons.

■ Assignment Attribute Column. An assignment attribute column object definition assigns an 
assignment attribute to an assignment object and a workflow policy component column. These 
mappings set up value matching within the assignment object and workflow policy object.

■ Assignment Criteria. An assignment criteria object definition encapsulates multiple assignment 
attributes. Assignment criteria appear in the picklist in the Criteria list column when you are 
editing an assignment rule record.

■ Assignment Criteria Attribute. An assignment criteria attribute lists the assignment attributes 
that are part of an assignment criterion. Assignment criteria attributes make it possible for an 
assignment criteria to consist of multiple attributes, and as such, are known as composite 
criteria.
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Assignment Manager Object Hierarchy and Relationship
Figure 13 illustrates the hierarchical (parent-child) relationships of Assignment Manager object types 
(and two related object types in Workflow Manager configuration). You use the Object Explorer in 
Siebel Tools to view these relationships.

Figure 13 shows the following relationships:

■ Assignment object is a child of workflow policy object.

■ Dynamic candidate is a child of assignment object.

■ Dynamic candidate attribute is a child of dynamic candidate. 

■ Assignment attribute column is a child of assignment attribute.

■ Assignment criteria attribute is a child of assignment criteria.

Figure 13. Parent-Child Relationships Between Assignment Manager Object Types
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In addition to the parent-child relationships between Assignment Manager object types, there are 
one-to-one and one-to-many relationships specified in property settings within the object definitions, 
as illustrated in Figure 14. 

Figure 14 on page 90 shows the following relationships:

■ Assignment rules (the box with a dashed border at the upper left) have assignment criteria 
children. Assignment rules are actually records of the Assignment Group business component, 
and their child assignment criteria are records of the Assignment Rule business component.

■ Each assignment rule points to one or more assignment object definitions, stored in the Assignment 
Objects multivalue group field (MVG) in the assignment rule (Assignment Group business 
component) record.

NOTE: Assignment Object is a required field for all assignment rules; however, Assignment 
Manager ignores rules that have no objects specified when upgrading.

■ Dynamic Candidate is a child of Assignment Object and each assignment rule points to one or 
more dynamic candidates.

■ Each assignment criteria record points to an assignment criteria object definition, by means of 
the value in the Criteria field.

■ Assignment attributes are attached to an assignment object through a property setting in each 
assignment attribute column object definition.

■ An assignment attribute column object definition is mapped to a workflow policy component 
column object definition by means of a pair of property settings.

Figure 14. Field Value and Property Relationships Among Assignment Manager Object Types
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■ If your rule has dynamic candidates, the Person Candidate Source and/or Org Candidate Source 
fields point to a Dynamic Candidate object definition. 

Assignment Object Configuration 
Overview
Siebel Assignment Manager uses definitions in the Siebel repository to assign objects to assignment 
rules and candidates.

An assignment object specifies a business entity to which a candidate can be assigned and the 
entities that are updated to accomplish that assignment. For example, an employee or position can 
be assigned ownership of an opportunity or account, or made a member of the opportunity�s or 
account�s sales team. Similarly, an employee can be assigned ownership of a service request or 
product defect. Each of the corresponding business components has one or more fields that specify 
the owner or team. An assignment rule includes one or more assignment objects. When the rule is 
satisfied, specific columns underlying these fields are updated with replaced or added employee IDs 
in accordance with the settings in the assignment object. 

An assignment object is a child object type of the Workflow Policy Object object. The parent workflow 
policy object provides a set of available column mappings through its child workflow policy 
component and grandchild workflow policy component column object types. These can be specified 
in assignment attribute column object definitions as columns to test for value matches and to 
monitor in dynamic assignment for value changes.

NOTE: Workflow policy objects have a one-to-one or a one-to-zero relationship with assignment 
objects (the Order and Quote workflow policy objects do not have predefined child assignment 
objects). You cannot add more assignment objects to workflow policy objects that already have a 
child assignment object.

Siebel applications provides predefined definitions in the Siebel repository for several objects. 

NOTE: The Sample database includes predefined assignment rules for several of the predefined 
objects.

The predefined Workflow Policy Object and Workflow Policy Component column definitions include 
mappings for the most commonly used attributes for each object. For example, the Opportunity 
object has the following predefined definitions: Account Name, Account City, Account State, Account 
Zip Code, Account Country, Lead Quality, Revenue, Industry SIC Code, and so on.

CAUTION: Only create or configure assignment objects for either position-based or employee-based 
assignment, not both. Siebel Tools allows the creation or configuration of an assignment object with 
both position- and employee-based assignment, but Assignment Manager does not correctly assign 
objects with this type of configuration. 
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Creating Assignment Objects
Using Siebel Tools, you can create new assignment objects by adding an assignment object to a 
workflow policy object. However, adding assignment objects can require the addition of skills or other 
tables and columns. Because of the complexity of this requirement, it is recommended that you 
contact Technical Support if you need to create new assignment objects.

CAUTION: It is recommended that you contact Siebel Technical Support for assignment object 
creation. If you create your own assignment objects, you run the risk of Assignment Manager 
assigning incorrect assignments.

To create an assignment object

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select Assignment Object.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it by selecting 
View > Options > Object Explorer in the Development Tools Options dialog box.

3 In the Workflow Policy Objects window, select the workflow policy object type for which you want 
to add the new assignment object.

4 Select the Assignment Objects window and choose Edit > New Record.

5 Configure the assignment object by setting values in the appropriate fields for each run-time 
parameter. 

For a list of assignment object parameters and their default values, see Object Types Reference.

6 If you are running dynamic assignment, activate an assignment policy for the assignment object.

For more information, see �Activating Assignment Policies� on page 180.

7 Update your deployment with the new configurations. 

For instructions, see �Server Administration After Configuring Assignment Manager� on page 125.

Configuring Assignment Objects
Each assignment object uses its own set of run-time parameters that control the behavior of 
Assignment Manager for that assignment object. These run-time parameters are stored in the Siebel 
repository in the assignment object definitions. You can use Siebel Tools to modify the default values 
for these run-time parameters.

NOTE: The default values provided in the Siebel repository for different objects are provided as a 
guide and may not be applicable to your business requirements. Therefore, it is recommended you 
review the configuration of the predefined objects before using them. 

TIP: If modifying the parameters default employee, default position, or default organization, then 
make sure that the values specified exist in the appropriate base table. For example, if you change 
the default organization to My Organization, there must be an entry in the group administration 
organizations screen called My Organization. 
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To configure assignment objects

1 Start Siebel Tools.

2 Lock the project to which the assignment object belongs.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object, and select Assignment Object.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

4 In the Workflow Policy Objects window, select the assignment object that you want to configure.

5 In the Assignment Objects window, configure the assignment object by setting values in the 
appropriate fields for each run-time parameter.

For a list of assignment object parameters and their default values, see Object Types Reference. 

6 Update your deployment with the new configurations. 

For instructions, see Step 2 on page 126 and Step 3 on page 126 in the �To update your 
deployment with new configurations� procedure.

NOTE: It is not necessary to recompile the siebel.srf file when configuring an assignment object. 
For more information on when to recompile, see Table 20 on page 125 and Using Siebel Tools. 

Configuring Assignment Objects for Dynamic 
Candidates
The Dynamic Candidate object records contain the definition of the various dynamic candidate teams 
for each assignment object. The properties define the table and column names used when performing 
a join from the assignment object primary table to the team table to retrieve the dynamic candidates. 
There are two types of dynamic candidates�single-owner or multiple-owner.

Table 12 provides descriptions of some of the Dynamic Candidate object properties.

Table 12. Dynamic Candidate Object Properties

Property Description

Attribute Id Column The name of the column in the assignment object primary table 
(single owner) or the attribute table (multiple owner) that 
contains the foreign key to the attribute.

Attribute Table In the case of a multiple-owner relationship, the name of the 
intersection table between the assignment object primary table 
and the attribute. If single owner, leave this blank.
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Use the following procedure to view or configure dynamic candidate properties.

To view or configure dynamic candidate properties

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to view or configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 In the Object Explorer, expand Assignment Object, and then select Dynamic Candidate. 

The dynamic candidate teams for this assignment object appear in the Dynamic Candidates list 
in alphabetical order.

For more information about dynamic candidates, see �Dynamic Candidates� on page 47. For more 
information about single owner versus multiple owner, see �About Single- Versus Multiple-Owner 
Dynamic Candidate Types� on page 48. For more information about Siebel Tools, see Using Siebel 
Tools and Configuring Siebel eBusiness Applications.

Display Name - String Reference The display name for this team appearing in the Person 
Candidate Source or the Organization Candidate Source list of 
value (LOV) fields on the assignment rule applet. 

You must first create a string reference in the Symbolic String 
object, and then set the Display Name - String Reference to the 
symbolic string you created.

Name The name of the team. For example, Activity Asset Team.

Object Id Column In the case of a multiple-owner relationship, the name of the 
column in the attribute table (multiple owner) which contains 
the foreign key to the assignment object primary table. If 
single owner, leave this blank.

Score Column (Optional) The column in the team table containing scores of 
the candidates. If specified, the score of each candidate is 
written to this column.

Team Table The name of the table where the candidates are stored.

Team Table Attribute Id Column The name of the column in the team table that contains the 
attribute Id, which joins to the Attribute Id column.

Team Table Candidate Id Column The name of the column in the team table that contains the 
candidate Id, the foreign key to the candidate base table.

Team Type Indicates whether or not the candidate team is employee-, 
organization-, or position-based.

Table 12. Dynamic Candidate Object Properties

Property Description
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Configuring Assignment Objects for Dynamic Candidate 
Attributes
To map columns in the team table to team-based assignment criteria, you configure records in the 
Dynamic Candidate Attribute object. You specify the column name in the team table and the 
assignment criterion that is based on this column. Table 13 provides descriptions of some of the 
Dynamic Candidate Attribute object properties.

Use the following procedure to view or configure dynamic candidate attribute object properties.

To view or configure dynamic candidate attribute object properties

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to view or configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 In the Object Explorer, expand Assignment Object, next expand Dynamic Candidate, and then 
select Dynamic Candidate Attribute.

The team-based criteria for the selected dynamic candidate team appears in the Dynamic 
Candidate Attributes list.

Table 13. Dynamic Candidate Attribute Object Properties

Property Description

Assignment Criterion A picklist for the various team-based criteria that you 
defined (assignment criteria that have the Team flag checked).

Team Attribute Column The name of the column in the team table on which the assignment 
criterion is based.
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Configuring Assignment Object User Properties
Assignment object user properties allow you to optionally specify additional run-time characteristics 
for each assignment object. Each assignment object uses its own set of run-time properties.

You need to configure the assignment object user properties for:

■ Copying additional columns to the team table

The PositionTeamDenormN user property (where N is any number) is used to copy additional 
columns from the S_ASGN_GRP_POSTN assignment rule position candidate table to the team 
table.

For more information about copying additional columns to the team table, see �Configuring 
Assignment Objects to Copy Additional Columns to the Team Table� on page 203.

■ Configuring availability-based assignment

Using Siebel Tools, you can configure the values of the Activity Type, Activity Priority, and 
Breakable Flag properties to come from either the object row itself or through constants. 

Table 14 lists the assignment object user properties for configuring availability-based 
assignment. 

Table 14. Assignment Object User Properties

User Property1 Description

Breakable Flag 
Column

The name of the column in the assignment object primary table that stores 
the value of the Breakable Flag property. When this property is defined and 
the Check Employee Calendar flag is checked on the assignment rule, 
Assignment Manager queries for the Breakable Flag Column column when 
it retrieves data from the object row and passes this value to the 
Appointment Booking System (ABS) when evaluating employee availability. 
For example, you can create a user property for the Activity assignment 
object with name=Breakable Flag Column and value=ALLOW_BREAK_FLG. 

Breakable Flag 
Value

The constant value that is passed to the ABS for the Breakable Flag field in 
availability-based assignment. For example, you can create a user property 
for the Service Request assignment object with name=Breakable Flag 
Value and value=TRUE.

Activity Priority 
Column

The name of the column in the assignment object primary table that stores 
the value of the Activity Priority. When this property is defined and the 
Check Employee Calendar flag is checked on the assignment rule, 
Assignment Manager queries for the Activity Priority Column column when 
it retrieves data from the object row and passes this value to ABS when 
evaluating employee availability. For example, you can create a user 
property for the Activity assignment object, with name=Activity Priority 
Column and value=ALLOW_BREAK_FLG.
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For more information using Siebel Tools and configuration, see Using Siebel Tools and Configuring 
Siebel eBusiness Applications.

Configuring Assignment Objects for Interactive 
Assignment
Interactive assignment allows users to invoke Assignment Manager immediately, view the list of 
assignees generated by Assignment Manager, and then override or confirm the assignees in the list. 
Users can invoke Interactive Assignment by clicking the appropriate object�s form Menu button and 
choosing Assign. For example, you would choose the Assign option from the Menu button in the All 
Service Requests view (Navigate > Site Map > Service > Service Requests > Service Requests List, 
then choose All Service Requests from the view drop-down list).

When the user clicks on the Assign applet menu item in the Service Request form to assign the 
current service request, the Siebel client contacts the assignment server and creates a list of 
qualified employees sorted by descending scores. The list of qualified employees appears to the user 
in the Employees window. The user then selects an employee from the list to be the service request 
owner.

Alternatively, you can allow SmartScript to have Assignment Manager select the most qualified 
candidate from the list. In this case, a list of qualified employees does not appear in the Employees 
window, and the most qualified candidate is assigned.

Activity Priority 
Value

The constant value that is passed to the ABS for the Activity Priority field 
in availability-based assignment. For example, you can create a user 
property for the Service Request assignment object with name=Activity 
Priority Value and value=TRUE.

Activity Type 
Column

The name of the column in the assignment object primary table that stores 
the value of the Activity Type. When this property is defined and the Check 
Employee Calendar flag is checked on the assignment rule, Assignment 
Manager queries for this column when it retrieves data from the object row 
and passes this value to the ABS when evaluating employee availability. For 
example, you can create an Activity assignment object with name=Activity 
Type Column and value=ALLOW_BREAK_FLG.

Activity Type 
Value

The constant value that is passed to the ABS for the Activity Type field in 
availability-based assignment. For example, you can create a Service 
Request assignment object with name=Activity Type Value and 
value=TRUE.

1. A column user property takes precedence over the corresponding value user property. For example, if you define a Breakable 
Flag Column user property and a Breakable Flag Value user property, the Breakable Flag Column user property takes 
precedence. As an alternate method, you can configure the Calendar Activity Additional Fields property on the assignment 
object to specify the values of certain fields. Assignment Manager assigns in this order: column user property, then value user 
property, and then Calendar Activity Additional Fields property.

Table 14. Assignment Object User Properties

User Property1 Description
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The Service Request assignment object is configured for Interactive Assignment by default. You can 
use Siebel Tools to configure Interactive Assignment for other assignment objects. For more 
information on Interactive Assignment, see �About Interactive Assignment� on page 44.

To configure interactive assignment for an assignment object

1 Verify that Assignment Manager is configured to perform assignment of values in the desired 
field, including the presence of the necessary assignment object and assignment rules and 
values.

2 Verify that the displayed business component is of the CSSBCBase class or one of its subclasses 
and add the Assignment Object business component user property to the business component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component.

c In the Class property for that business component, verify the value is CSSBCBase (such as in 
the Account business component).

NOTE: Business components based on other classes cannot be configured for interactive 
assignment. If the class is not CSSBCBase, note the class name and locate it in the Object 
Explorer for the Class object type. Note the value in the Super Class property for this class. 
If the Super Class is CSSBCBase, interactive assignment is permitted. If the Super Class is 
not CSSBCBase, check the Super Class property for that class.

d Set the Name property to Assignment Object.

e Set the Value property to the name of the assignment object that is to be used in the assignment 
process.

3 Verify that the appropriate applet is of the CSSFrameBase class or one of its subclasses.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet.

c In the Class property for that applet, verify the value is CSSFrameBase (such as Account Entry 
Applet).

NOTE: Applets based on other classes (including CSSFrameListBase) cannot be configured for 
Interactive Assignment. 

4 Add the Assignment Type business component user property to the business component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component, and then click Business 
Component User Prop.

c Set the Name property to Assignment Type.

d Set the Value property to:

❏ People if you are setting up an employee- or position-based assignment

❏ Organizations if you are setting up an organization-based assignment
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5 Optionally, if you want to enable SmartScript, add the Assignment Interactive business 
component user property to the business component.

a Set the Name property to Assignment Interactive.

b Set the Value property to TRUE.

6 Add the Assign selection to the applet menu button.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet to which you want to add the Assign functionality.

c In the Object Explorer, select Applet Method Menu Item.

d Select the Applet Method Menu Items window, choose Edit > New Record and set the following 
values:

❏ Command=Assign(SWE)

❏ Menu Text=Assign

❏ Position number = 1 (or to the number corresponding to the preferred placement in the 
menu)

7 Add the business component that holds assignment results records to the business object of the 
view in which the reconfigured applet is used.

NOTE: This business component already exists, and is either: 1) Assignment Results (Position) 
or Assignment Results (Employee) if Assignment Type is set to People (depending on whether 
you are setting up an employee- or position-based assignment), or 2) Assignment Results 
(Organizations) if Assignment Type is set to Organizations.

a In the Object Explorer, select Business Object.

b In the Business Objects window, select the Business Object for which you want to add a child 
business object component.

c In the Object Explorer, click Business Objects Components, and in the Business Objects 
Components window, choose Edit > New Record.

d In the new record, enter values in the appropriate fields with the BusComp name set to: 
Assignment Results (Position), Assignment Results (Employee), or Assignment Results 
(Organization).

8 Optionally, the business component user property called Assignment Results BusComp and the 
applet user property called Assignment Results Applet can be defined.

NOTE: These user properties are desirable when you need to show additional information about 
the results. For example, the service request assignment results can be joined with the CTI 
tables, and query only qualified service people who are not currently using their telephone. The 
name of the business component used to hold data for the additional fields would be specified in 
an Assignment Results BusComp user property in the business component being assigned. The 
name of the applet used to display the assignment results would be specified in an Assignment 
Results Applet user property in the applet from which assignment is invoked.

9 Add one of the following Business Components (depending on what is being assigned) to the 
relevant Business Object: Assignment Group Position, Assignment Group Employee, or 
Assignment Group Organization. 
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10 Update your deployment with the new configurations. 

For instructions, see Step 1 on page 125 in the �To update your deployment with new 
configurations� procedure.

NOTE: Other than recompiling the siebel.srf file, there are no additional administrative tasks 
required for this procedure. For more information on when to recompile, see Table 20 on page 125 
and Using Siebel Tools. 

Configuring Interactive Assignment for an Assignment 
Object Using Server Key Mappings
In the default configuration, interactive assignment submits requests to an assignment server that 
is running in default mode. However, you can customize interactive assignment to use the server key 
mappings feature.

If you use server key mappings, when you click the Assign button, a request is sent to the 
Assignment Manager server component (AsgnSrvr) to evaluate and return the qualified candidates. 
To submit requests to a server that has server key mappings, one of the rule group Ids must pass 
(because the AsgnKey parameter must pass). To accomplish this, the SetAsgnKey InvokeMethod is 
called on the CSSBCBase business component base class. Using a script, a workflow process, or a 
business service, this InvokeMethod is called and the row Id of one of the rule groups is passed as 
the parameter. 

After this is complete, interactive assignment uses this parameter as the AsgnKey and ReqKey 
parameters when submitting requests to the AsgnSrvr component. Note that for one session, you 
only need call this InvokeMethod once. Subsequent requests in the same session reuse the rule 
group row Id. However, when the session is logged out or the server is restarted, you must call this 
InvokeMethod again to set the AsgnKey parameter. Otherwise, the assignment server reverts to 
running in default mode. 

For more information about default mode, see �About Different Modes of Running Assignment 
Manager� on page 22. For more information about scripting, see Object Types Reference. For more 
information about workflow processes, see Siebel Business Process Designer Administration Guide.

Configuring Assignment Objects for Availability-Based 
Assignment
Configuring assignment objects for availability-based assignment allows Assignment Manager to 
review an employee�s calendar as a criterion for assignment. If the employee�s calendar has no 
activities booked at the time required by the object, and has a sufficient time period available for the 
object�s duration, the employee qualifies for assignment. For more information on availability-based 
assignment, see �About Availability-Based Assignment� on page 42 and �Assigning Employees to 
Assignment Rules Based on Availability� on page 149.

Before configuring the assignment object, make sure the following information is satisfied:
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■ The Field Service component group is enabled.

For more information, see Siebel System Administration Guide.

■ A mapping of the server to the Field Service components and region exists.

For more information, see Siebel Field Service Guide. 

■ Employees are associated with service regions.

For more information, see Siebel Field Service Guide.

■ The object that you are configuring for assignment availability has the necessary columns in its 
database table (information and procedure follow).

By default, the Activity assignment object has the required columns in its database table for Start 
Time and Duration; however, one column must be extended if the Early Start Time field is desired. 
All other assignment objects must have their base tables extended. To extend an object�s base table 
for availability-based assignment, use the following procedure. As an example, the Service Request 
Assignment object is considered.

CAUTION: You must review the sections on extension tables and columns in Configuring Siebel 
eBusiness Applications before completing this procedure.

To extend the Service Request�s base table for availability-based assignment

1 Start Siebel Tools.

2 In the Object Explorer, expand the Table object, and then select Column.

3 In the Tables window, query for the S_SRV_REQ table.

4 With the S_SRV_REQ table selected, choose Tools > Lock Project to lock the project.

The project associated with the S_SRV_REQ table is newtable.

5 In the Columns list, choose Edit > Add New Record to add the records in the following table (only 
Record 1 and 2 are required):

Record 1 Record 2 Record 3 (Optional)

Name X_DURN_MIN X_START_TIME X_EARLY_START_TIME

Physical Type Number UTC Date Time UTC Date Time

Length 22 7 7

Precision 22

Scale 7

LOV Type APPOINTMENT_DURATION

Cascade Mode Ignore Ignore Ignore

TxnLog Code TRUE TRUE TRUE
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6 In the Table column window and after you have created the new records you need, click Apply.

This sends the new columns to the appropriate tables in the database.

7 Complete the fields in the Apply Schema dialog box.

a In the Tables field, click the select button, and choose one of the following:

❏ All

❏ Current Query

❏ Current Row

b In the Table owner password field, enter the appropriate value.

c Click Apply.

The S_SRV_REQ table is now extended with the following three columns: X_DURN_MIN, 
X_EARLY_START_TIME, and X_START_TIME.

With the appropriate columns in place, use the following procedure to configure availability criteria 
for the assignment object. 

To configure Availability-based Assignment for an assignment object

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select the assignment object.
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4 In the Assignment Objects list, select the object you want to configure, and set the column 
values, as shown in the following table:

NOTE: The fields in the preceding table are specified as one value string for that property.

If a value is not specified for the field specified in the Calendar Start Time Column column for an 
assignment object, Assignment Manager does not check calendars when assigning that object, even 
if the assignment rule has the Check Employee Calendar flag checked. Instead, Assignment Manager 
assigns all candidates who meet the criteria for the rule. For example, if you don't specify the Start 
Date or Due Date for an activity, Assignment Manager does not check calendars when assigning this 
activity, even if the assignment rule has the Check Employee Calendar flag checked. Instead, 
Assignment Manager assigns all candidates who meet the criteria for the rule.

After these fields are configured for the assignment object, they must be made visible to the end 
user by adding them to the appropriate business component and applets. For these procedures, see 
Using Siebel Tools. 

You can now configure the following user property values to come from either the object row itself 
or through constants:

■ Activity Type

Column Required Value

Calendar Start 
Time Column

Yes The table column that references the start time of the object. 
For example, X_START_TIME.

Calendar 
Duration 
Column

Yes The table column that references the duration of the object. For 
example, X_DURATION.

Calendar Early 
Start Time 
Column

No The table column that references the early start time of the 
object. For example, X_EARLY_START_TIME.

Calendar Create 
Activity

No Check this column if you want an activity created for the 
assigned employee.

TRUE = Activity is created in employee�s calendar
FALSE =Activity is not created in employee�s calendar 

Note: You must check this field if you plan to use the 
Appointment Booking System to detect conflicts. For more 
information about the Appointment Booking System, see 
�About Availability-Based Assignment� on page 42 in this guide 
and Siebel Field Service Guide.

Calendar 
Activity 
Additional 
Fields

No When this field is specified, Assignment Manager sets the field 
value to the row ID of the assignment object when it creates 
the activity. Assignment Manager also sets the additional fields 
to the specified field values. For example, for the Service 
Request object, you can specify the following fields: Activity SR 
Id, Type, To Do.
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■ Activity Priority

■ Breakable Flag 

For more information about assignment user properties, see �Configuring Assignment Object User 
Properties� on page 96.

About Creation of Activities for Employees During 
Availability-Based Assignment
If an assignment rule has the Check Employee Calendar flag checked, availability for each employee 
is evaluated before assignment. If the Calendar Create Activity property is also set for the 
assignment object, make sure that an activity exists in the employee's calendar for that duration to 
block the schedule. 

Assignment Manager evaluates whether the Check Employee Calendar flag is checked (calendar 
rules) or not (noncalendar rules) and processes the rules differently based on this indication. If 
Assignment Manager is assigning activities, and if only one employee passes and that employee is 
from a calendar rule, the original activity is reused and the employee is added to the owners list for 
that activity and the employee schedule is blocked. If more than one employee passes, separate 
activities are created for each employee. In this case, the parent activity of all these additional 
activities is set to the original activity to make sure that all are related to each other.

If Assignment Manager is not assigning activities, separate activities are created for each employee 
who passes and blocks their schedules.

For more information about activity- and availability-based assignment, see �About Activity-Based 
Assignment� on page 42 and �About Availability-Based Assignment� on page 42.

Configuring Assignment Objects for Multitiered 
Assignment
Configuring assignment objects for multitiered assignment allows Assignment Manager to consider 
the relationship between people and organizations when determining the proper assignment. By 
default, Assignment Manager assigns people and organizations independently. Multitiered 
assignment runs in a variety of modes. For more information on multitiered assignment and the 
assignment modes, see �About Multitiered Assignment� on page 43 and �Scenarios for Using Multitiered 
Assignment with Sales Assignment Rules� on page 66.

To configure an assignment object for multitiered assignment

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.
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c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select the assignment object.

4 For the assignment object, change the Assignment Mode field to the multitiered assignment 
mode operation of interest.

Choices are: 

■ Independent

■ Org & Person-oriented

■ Organization-oriented

■ Person-oriented

Configuring Assignment Objects for Team Scoring
Configuring Team Scoring allows Assignment Manager to save candidates� scores to the team table 
for those candidates who are assigned to an assignment object. These scores can be then used by 
other Siebel applications or exposed through the user interface. See �About Assignment Scoring� on 
page 39 for more information.

Before configuring the assignment object, make sure the object has the necessary columns in its 
database table. To extend an object�s database table for team scoring use the following procedure. 
As an example, the Opportunity object is considered. 

CAUTION: You must review the sections on extension tables and columns in Configuring Siebel 
eBusiness Applications before completing this procedure.

To extend the Opportunity object�s base table for team scoring

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Table object and select Column. 

4 In the Tables list, query for the S_OPTY table.
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5 In the Columns window, add the records shown in the following table (the values and records 
shown are examples and can be modified, as appropriate, for your deployment):

6 Select each new record and click the Apply button.

7 Enter the appropriate value for tableowner password.

The S_OPTY table is now extended with the following columns: X_POS_SCORE and 
X_ORG_SCORE.

After the necessary base table columns are in place, use the following procedure to configure the 
assignment object for team scoring.

To configure assignment objects for team scoring

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select Assignment Object.

4 In the Workflow Policy Objects list, select the object you want to configure.

Record 1 Record 2

Name X_POS_SCORE X_ORG_SCORE

Physical Type Data(Public) Data(Public)

Length 22 22

Precision 22 22

Scale 7 7

Cascade Mode Ignore Ignore

TxnLog Code TRUE TRUE
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5 In the Assignment Objects list, select the object, and set one of the column values as shown in 
the following table:

For information on modifying the appropriate components that expose the scoring information to the 
user interface, see Configuring Siebel eBusiness Applications.

Assignment Criteria Configuration
You can add new assignment attributes and assignment criteria using Siebel Tools.

An assignment attribute allows you to associate a single attribute on an object or a person or an org 
to multiple fields in the application. For example, you can define an assignment rule that matches 
candidates based on State. However, State is stored in a different field in the application for different 
objects. Assignment attributes map the places that State is defined into a single state attribute. 

Assignment attributes can be either column-based or skill-based. Column-based attributes are 
stored as columns in the object (such as Opportunity). You can use existing columns in the object, 
or use Siebel Database Extensibility to add new extension columns to the object. Skills-based 
attributes are stored as rows in the object�s skill tables (if any).

If you are adding an assignment attribute to a new table, you need to modify the existing Workflow 
Manager definitions in the Siebel repository. For more information, see Siebel Business Process 
Designer Administration Guide. 

An assignment criteria can consist of one or more assignment attributes, such as the criteria Account 
City, Account State, and Account Country. These assignment attributes are grouped as assignment 
criteria. In this case, a single criterion, called a composite criterion, includes three assignment 
attributes. To add or change drop-down fields that define assignment criteria in an assignment rule, 
you should define or modify assignment criteria. Assignment criteria attributes enumerate 
assignment attributes for the assignment criteria.

When you create new assignment criteria, you typically perform the following procedures (in the 
order listed):

■ Create new assignment attributes

■ Create new assignment attribute columns to map new assignment attributes to existing 
assignment objects

■ Create new assignment criteria to group new assignment attributes

Column Value

Employee Team Score The table column that references a Number column in the assignment 
object�s employee team table.

Org Team Score The table column that references a Number column in the assignment 
object�s organization team table.

Position Team Score The table column that references a Number column in the assignment 
object�s position team table.
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■ Create assignment criteria attributes to enumerate assignment attributes for the assignment 
criteria

NOTE: Assignment criteria configured to include multiple assignment attributes cannot have these 
attributes based on columns in different tables. 

To eliminate default assignment criteria appearing in the Assignment Criteria view, use the following 
procedure.

To remove seed assignment criteria

1 Delete from any assignment rules the use of the criteria you want removed from the assignment 
criteria (Assignment Rules > Criteria).

2 In Siebel Tools, inactivate the assignment attribute column, the assignment attribute, the 
assignment criteria attribute, and the assignment criteria.

For more information, see �Disabling an Assignment Attribute� on page 117.

3 Recompile all projects (not just the locked projects) in the .srf file.

For instructions, see Step 1 on page 125 of the �To update your deployment with new 
configurations� procedure.

Configuring Assignment Attributes
An assignment attribute object definition defines an attribute that can be referenced in assignment 
criteria records. It specifies a logical attribute that can be chosen from a picklist for defining 
comparisons; it does not directly specify a particular database column or combination of columns. 
Column mapping is accomplished through the child assignment attribute column object definitions, 
one for each assignment object that uses the parent assignment attribute.

An assignment attribute also specifies the picklist that appears in the Values list in the Assignment 
Criteria view when you are entering an attribute in a value record, as shown in Figure 15. 

Figure 15. Picklist for Populating an Attribute in a Value Record

This list column is based on 
an assignment attribute... ...in whose definition 

this picklist is specified.
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An assignment criteria attribute object definition implements each list column in the Values applet, 
as described in �Configuring Assignment Criteria Attributes� on page 115. The assignment criteria 
attribute is based on an assignment attribute, as specified in its assignment attribute property. The 
referenced assignment attribute identifies a picklist. This is the picklist that appears when you click 
the drop-down arrow to the right of the list column cell.

The Assignment Attribute object type functions as an intermediary between the assignment criteria 
on the one hand and the assignment objects on the other, as shown in Figure 14 on page 90.

An assignment criteria attribute references an assignment attribute through its assignment attribute 
property. In turn, each of the assignment attribute�s child assignment attribute columns specifies an 
assignment object and a workflow policy component/column combination. 

An assignment attribute is a logical grouping of similar mappings to different assignment objects that 
can use the same picklist for value selection. For example, the Account State assignment attribute 
has ten child assignment attribute column object definitions. Each of these assignment attributes is 
used for selection of the state in which an account is located, but five of them are used for different 
assignment objects (Activity, Account, Campaign Contact, and Order), and the other five are used 
for different account state attributes in the Opportunity assignment object (such as Primary Account 
State and Indirect Account Primary State).

NOTE: To generate a trigger based on an assignment attribute, a corresponding assignment 
attribute column must be configured. See Configuring Assignment Attribute Columns on page 111.

To create a new assignment attribute

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object, and then choose Edit > New 
Record.

TIP: If the Assignment Attribute object is not visible in the Object Explorer, you can enable it in 
the Development Tools Options dialog box (View > Options > Object Explorer).

4 In the Assignment Attributes window, configure the assignment attribute object by setting values 
in the appropriate fields.

a In the Name field, type the name of the new assignment attribute.

b In the Project field, select a project.

c Optionally, if the attribute supports a range of values (such as revenue), check the Use Range 
field.

d In the Data Type field, select a data type for the attribute.

e Optionally, if you want a picklist for the attribute to allow users to select values for the 
assignment attribute, enter a value in the Picklist field.
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f Optionally, you can use a pick field for the attribute to allow users to select values for the 
assignment attribute, enter a value in the Pick Field field.

For a description of these properties, see Table 15 on page 110.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Server 
Administration After Configuring Assignment Manager� on page 125.

Table 15 shows some of the properties of the Assignment Attribute object type.

Configuring MLOV for Assignment Attributes
Multilingual List of Values (MLOV) capability allows assignment attributes to be stored in a form that 
can be retrieved and displayed in a variety of supported client languages. For detailed information 
on MLOV, see Configuring Siebel eBusiness Applications. To enable assignment attributes for MLOV, 
use the following procedure.

Table 15. Properties of Assignment Attributes

Property Required Description

Bounded Optional When checked, the picklist is bounded (you can select a value 
from the picklist). When unchecked, you can enter a value that 
does not appear in the list.

Data Type Required Data type for the assignment attribute. Number, UtcDateTime, 
and Varchar are supported.

Name Required Name of the assignment attribute. Must be unique within the 
repository.

Order By LOV 
Type

Optional Not used.

Pick Field Optional Name of the field to select from the picklist.

Pick List Optional Name of the picklist that supplies the selection values for 
populating any list column in the Values list (in the Assignment 
Criteria view) that is based on this assignment attribute.

Use Range Optional Specifies whether a single list column or a pair of list columns, 
indicating a range, appears for assignment criteria attributes 
based on this assignment attribute. For example, the Revenue 
assignment attribute, which has a TRUE value for Use Range, 
appears as two list columns, Revenue Low and Revenue High. You 
can enter 50000 in the former and 100000 in the latter in a value 
record to indicate the range $50,000�100,000.

Translate Optional When checked, enables MLOV capability for the attribute. For 
more information on enabling this feature, see �Configuring MLOV 
for Assignment Attributes� on page 110.
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To enable assignment attributes for MLOV

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object.

4 Select the Assignment Attribute in the list of attributes that requires translation.

5 Locate the Translate column for this attribute, and select the check box to assign this property 
with a TRUE value.

6 Locate the Translate Pick Field for the assignment attribute, and select from the Translate Pick 
Field dialog box the field in the Pick List Business Component that stores the Language 
Independent Code (in most cases this is the Name field).

You can also configure the application to enable MLOV for workload criteria, criteria values, and skills. 
For more information, see Configuring Siebel eBusiness Applications.

Configuring Assignment Attribute Columns
An assignment attribute column object definition maps an assignment attribute to an assignment 
object and a workflow policy component column, as shown in Figure 14 on page 90. These mappings 
set up value matching within the assignment object and workflow policy object for criteria that use 
the parent assignment attribute.

The parent assignment attribute is an abstract logical attribute to test for a value match, which you 
can specify in an assignment criteria. The child assignment attribute columns specify the actual 
mappings to assignment objects and workflow policy component columns. Each assignment attribute 
column can specify a different assignment object to search, or a different attribute within the same 
assignment object.

To map assignment attributes to an existing assignment object 

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Attribute object, and select the Assignment 
Attribute Column object.

4 In the Assignment Attributes window, select the assignment attribute for which you want to map 
the logical location in the database schema.
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5 In the Assignment Attribute Columns window, choose Edit > New Record.

6 Configure the assignment attribute object by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment attribute column.

b In the Assignment Object field, select an assignment object to which the assignment attribute is 
applied.

c In the Workflow Policy Component field, select a workflow policy component to which the 
workflow policy object is applied.

d In the Workflow Policy Component field, select a workflow policy component column to which the 
workflow policy component is applied.

e In the Sequence field, type in a sequence value.

For descriptions of these properties, see Table 16 on page 112.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Server 
Administration After Configuring Assignment Manager� on page 125.

Table 16 shows some of the properties of the Assignment Attribute Column object type.

Table 16. Properties of Assignment Attribute Columns

Property Required Description

Assignment Object Required Assignment object that is checked for a value match with the 
parent assignment attribute.

Name Required Name of the assignment attribute column. The typical format 
for the name is:

assignment_object: workflow_component_column

For example: 

Service Request: Account Area Code 

Sequence Required A unique sequence number for the assignment attribute 
column within the assignment attribute. If an assignment 
attribute has multiple assignment attribute columns, 
Assignment Manager searches for attribute values in the 
order of the values in this property.

Workflow Policy 
Component

Required Name of the workflow policy component, within the specified 
workflow policy object, with which this assignment attribute 
column is associated.
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Configuring Assignment Criteria
An assignment criteria object definition defines an object, called an assignment criteria, that can be 
used in assignment criteria records. Assignment criteria appear in the picklist in the Criteria list 
column when editing an assignment criteria record in Siebel applications.

The Criteria list column in an assignment criteria record specifies the assignment criteria that is 
tested for a match against one or more attributes of the assignment object or candidate. For 
example, in an assignment criteria that determines whether the state is California, the assignment 
item would be State, Home State, or Account State, and the value California (CA) would be specified 
in a child value record.

When you click the drop-down arrow button in the Criteria list column, a picklist appears for selection 
of an assignment criteria. The picklist lists the available assignment criteria (assignment criteria 
object definitions in the repository). When you select an assignment criteria, its name is stored in 
the Criteria Name field in the current Assignment Rule business component record.

NOTE: The business component that holds assignment criteria is called Assignment Rule. The 
business component that holds assignment rules is called Assignment Group.

An assignment criteria includes one or more assignment criteria attributes, stored as child 
assignment criteria attribute object definitions. For information on assignment criteria attributes, see 
�Configuring Assignment Criteria Attributes� on page 115.

After you create and recompile an assignment criteria object definition, it becomes available for 
selection from the Criteria list column picklist in assignment criteria records.

To create assignment criteria

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Criteria object, then choose Edit > New Record.

4 Configure the assignment criteria by setting values in the appropriate fields.

Workflow Policy 
Component Column

Required Name of the workflow policy component column, within the 
specified workflow policy component, with which this 
assignment attribute column is associated.

Workflow Policy 
Object

Required Name of the workflow policy object with which the assignment 
attribute column is associated. When an assignment object is 
selected, the workflow policy object defaults to this selection.

Table 16. Properties of Assignment Attribute Columns

Property Required Description
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a In the Name field, type the name of the new assignment criteria.

b In the Project field, select the Assignment project.

c In the Display Name field, type the name that appears for the assignment criteria.

d Optionally, if you want the assignment criteria stored in the skill table, check the Employee Skill 
field.

For information about skill tables, see �Creating Criteria Values as Skills with Expertise Codes 
and Weighting Factors� on page 139.

e Optionally, if you want expertise codes stored for the skill, check the Use Expertise field.

If you check this field, Assignment Manager uses expertise codes to match objects to 
candidates.

f Optionally, if you do not want the assignment criteria to appear in the Criteria picklist, uncheck 
the Display Flag field.

g If this is a team-based criterion, check the Team flag. In this case, you define only one criteria 
attribute record and you do not define any attribute columns for the assignment attribute. 

For more information about team-based criteria, see �About Assignment Rules� on page 19.

For descriptions of these properties, see Table 17 on page 114. 

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Server 
Administration After Configuring Assignment Manager� on page 125.

The assignment criteria object definition has two properties to specify the name (internally and as 
displayed) and two properties that are used to configure skill tables (Employee Skill and Use 
Expertise). Most of the behavior of an assignment criteria is configured in the assignment criteria 
attribute children. Table 17 shows some of the properties of the assignment criteria object type.

Table 17. Properties of Assignment Criteria

Property Required Description

Display Flag Optional When checked, the assignment criteria appears in the Criteria picklist.

Display 
Name

Optional Name that appears for this assignment criteria in the picklist and the 
Criteria list column in the Criteria list in the Criteria view (Assignment 
Rule> Criteria). If not specified, the value in the Name property is used 
instead.

Employee 
Skill

Optional A TRUE/FALSE property that specifies whether the attribute is actually 
stored in the skill and skill item tables for the candidate or object. For 
more information about skill tables, see �Example of Using Skill Tables� 
on page 120.
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Configuring Assignment Criteria Attributes
An assignment criteria includes one or more assignment criteria attributes. Assignment criteria 
attributes are implemented as object definitions of the assignment criteria attribute object type. This 
is a child object type of assignment criteria. Assignment criteria attributes make it possible for an 
assignment criteria to consist of multiple attributes, known as composite criteria.

For example, the Account Wildcard assignment criteria includes an Account and Site, both of which 
correspond to a specific column. This setup is accomplished by creating two assignment criteria 
attribute children, Account and Site, of the Account Wildcard assignment criteria.

NOTE: Many assignment criteria have only a single assignment criteria attribute.

The set of assignment criteria attributes in an assignment criteria determines the set of list columns 
to appear in the Values list. 

One list column appears in the Values list for each assignment criteria attribute in the assignment 
criteria. The Account Wildcard assignment criteria (the Account Name assignment criteria with a 
display name of Account Wildcard) has an Account and a Site list column in the display of its child 
Value records. Both the Account and Site list columns correspond to the Account Name assignment 
criteria attribute (with a display name of Account and Site, respectively). Figure 16 shows how this 
is accomplished in Siebel Tools.

Name Required Name of the assignment criteria.

Use 
Expertise

Optional A TRUE/FALSE property that applies to assignment criteria that are 
skills. It specifies whether expertise codes are stored for the skill. If so, 
Assignment Manager uses the expertise code to match the assignment 
object to people. 

Figure 16. Assignment Criteria and Child Assignment Criteria Attribute

Table 17. Properties of Assignment Criteria

Property Required Description

Account Name 
assignment criteria

Account Name assignment 
criteria attribute
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If there were more assignment criteria attributes for this assignment criteria, each would have a list 
column in the Values list. The Score list column is automatically provided, and the Expertise Code 
list column appears in this instance because the assignment criteria has a Use Expertise property 
setting of TRUE.

For information on configuring assignment attributes, see �Configuring Assignment Attributes� on 
page 108.

To create an assignment criteria attribute

1 Start Siebel Tools.

2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Criteria object, and select the Assignment Criteria 
Attribute object.

4 In the Assignment Criteria window, select the assignment criteria for which you want to 
enumerate assignment attributes.

5 Select the Assignment Criteria Attributes window, then choose Edit > New Record.

6 Configure the assignment criteria attribute by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment criteria attribute.

b In the Assignment Attribute field, select the assignment attribute for this assignment criteria.

c In the Display Name field, type the name for the assignment criteria attribute.

d In the Store Column field, specify the column in the assignment factor items table where the 
value for the assignment criteria attribute is stored.

e In the Display Sequence field, specify the sequence in which the assignment criteria attribute 
appears.

f Optionally, in the Pick Applet field, choose a pick applet for the assignment criteria attribute to 
allow users to view or select values for the assignment criteria attribute.

NOTE: For composite criteria, repeat Step 5 and Step 6 as many times as is necessary.

For more information on these properties, see Table 18 on page 117.

7 Update the siebel.srf file.

For instructions on updating the siebel.srf file, see Step 1 on page 125 of the �To update your 
deployment with new configurations� procedure.

8 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the �To update your deployment with new configurations� 
procedure.
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Table 18 shows some of the properties of the assignment criteria attribute object type.

Disabling an Assignment Attribute
In some cases, you may need to disable an existing assignment attribute. To do so, you must also 
disable the assignment attribute column, assignment criteria, and assignment criteria attribute 
definitions.

To disable an existing assignment attribute

1 Start Siebel Tools.

Table 18. Properties of Assignment Criteria Attributes

Property Required Description

Assignment 
Attribute

Required Name of the assignment attribute that this assignment criteria 
attribute is based on. Selected from a drop-down list.

Display Name Required List column label that appears for this assignment criteria 
attribute in the Values list. If omitted, the Name is used in the 
list column label.

Display Sequence Required Order in which the list column for this assignment criteria 
attribute appears in the list applet, relative to those of other 
assignment criteria attributes in the assignment item. A lower 
number places the list column further to the left.

Name Required Name of the assignment criteria attribute, for identification. 
This name must be unique within the parent assignment 
criteria.

Pick Applet Optional If a picklist is defined for the associated assignment attribute, 
you specify the name of a pick applet to display the picklist for 
selection of a value in the attribute�s list column.

Store Column Required Specifies the column in the assignment factor items table 
(S_ASGN_RULE_ITEM) in which to store the value for the 
assignment criteria attribute. There are four columns of each 
data type (Number, UtcDateTime, and Varchar) provided for 
storage of assignment criteria attribute values in each 
assignment criteria. You must specify a unique value, between 
1 and 4 inclusive, for each assignment criteria attribute of the 
same data type. The data type can be determined from the 
Data Type property in the referenced assignment attribute 
object definition.

NOTE: You can have up to four assignment criteria attributes 
for each assignment criterion (a composite criterion can have a 
maximum of four attributes).
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2 Lock the assignment object�s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 Disable the assignment attribute definition.

a In the Object Explorer, select the Assignment Attribute object.

b In the Assignment Attributes window, select the assignment attribute you want to disable.

c Check the Inactive field.

4 Disable the assignment attribute column definition.

a In the Object Explorer, expand the Assignment Attribute object, and then select the Assignment 
Attribute Column object.

b In the Assignment Attribute Columns window, select the assignment attribute column you want 
to disable.

c Check the Inactive field.

5 Disable the assignment criteria definition.

a In the Object Explorer, select the Assignment Criteria object.

b In the Assignment Criteria window, select the assignment criteria you want to disable.

c Check the Inactive field.

6 Disable the assignment criteria attribute definition.

a In the Object Explorer, expand the Assignment Criteria object, and then select the Assignment 
Criteria Attribute object.

b In the Assignment Criteria Attributes window, select the assignment criteria attribute you want 
to disable.

c Check the Inactive field.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Server 
Administration After Configuring Assignment Manager� on page 125.

Creating New Skills
Skills are assignment criteria values attributed to specific assignment rules, objects, employees, 
positions, and organizations. Assignment Manager uses skills to match assignment rules, objects, 
employees, positions, and organizations.

The Siebel application provides several predefined skills, however, you can create new skills using 
Siebel Tools. This section explains how to view the predefined skills and create new skills.
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To view predefined skills

1 Start Siebel Tools.

2 In the Object Explorer, click to select the Assignment Criteria object.

3 In the Assignment Criteria applet, query for criteria with Employee Skill equal to TRUE.

The predefined skills appear as well as any new skills you create.

The predefined skills are:

■ Activity Category

■ Email Language Code 

■ Email Recipient Profile

■ Industry

■ Language

■ Product

■ Product Line

■ Product Line Wildcard

■ Product Wildcard

■ Revenue

For most deployments, the predefined skills are sufficient. However, you can create new skills using 
Siebel Tools. The following procedure explains how to create a new skill that can be used in any Siebel 
application. 

To create a new skill

1 Create an assignment attribute.

For more information, see �To create a new assignment attribute� on page 109. 

2 Create an assignment criterion. 

For more information, see �To create assignment criteria� on page 113. When prompted in Step 4 
of this procedure, you must check the Employee Skill field because you are configuring the 
criterion as a skill.

3 Add the assignment attribute created in Step 1 above as a child object to the Assignment 
Criterion created in Step 2 above.

For more information, see �To create an assignment criteria attribute� on page 116. When prompted 
in Step 6 of the �To create an assignment criteria attribute� procedure, select the assignment attribute 
created in Step 1 above.

NOTE: To use Assignment Manager to use a skill for the purpose of assignment, additional 
configuration is required. For more information, see �Assignment Criteria Configuration� on page 107.
Siebel Assignment Manager Administration Guide Version 7.7 ■ 119



Assignment Object Configuration ■  Example of Using Skill Tables
Example of Using Skill Tables
A skill is a generic row-level attribute that qualifies a person, organization, or assignment object row. 
For example, if an employee speaks English and Spanish, language is the skill he or she possesses, 
and English and Spanish are the skill items. Employee, position, and organization skills are used to 
store skills possessed; the skill tables for objects are used to store skills required. Assignment 
Manager uses skill tables to do skill matching by comparing the skills on the object with the skills of 
an employee, position, or organization to determine who passes the rule.

The skill and skill item tables are child and grandchild tables, respectively, of the object used to store 
skills, and skill items for assignment objects that are not stored as columns in the parent table itself. 
The employee skill table is used to store skills possessed by employees, such as languages spoken, 
product expertise, and so on. For example, for an employee who speaks English and Spanish, there 
is one record in the employee skill table that specifies the skill name as Language. And there are two 
records in the child employee skill item table that correspond to this skill record: one record for 
English, and another record for Spanish. For more information on how to assign skills to candidate 
objects, see �Assignment Strategy for Sales Organizations� on page 61.

For example, the following procedure explains how to configure Assignment Manager so that only 
employees who speak Spanish are assigned a service request.

To configure Assignment Manager to assign a service request only to employees 
who speak Spanish

1 Create a service request with Language as the skill and Spanish as the skill item. 

a In the Service Request skill table for the service request, create one record and specify Language 
as the skill. 

b In the child Service Request skill item table, create one record and specify Spanish as the skill 
item.

For more information about how to perform this step, see �Creating Criteria Values as Skills with 
Expertise Codes and Weighting Factors� on page 139.

2 Create an assignment rule that filters employees based on their language skills.

a Create an assignment rule and apply the Service Request assignment object.

b Create a criterion called Language and use the Compare to Person assignment rule comparison 
method.

This criterion, and therefore the rule, passes only employees who have the Spanish language 
skill.

NOTE: The above example used the Compare to Person comparison method, however, skill matching 
can be used with other comparison methods. For more information about comparison methods, see 
�About Assignment Criteria and Criteria Methods� on page 27.

Assignment Manager can also do skill matching with expertise codes and can use weighting factors 
to assign weighted scores to different expertise codes. For more information, see �Assignment 
Operation Modes� on page 44, �Expertise Codes� on page 37, and �Weighting Factors� on page 38.
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Creating Workflow Policy Components
In some cases, you can create an assignment rule that assigns candidates to two objects while using 
only one of the object�s criteria. For example, you may want the ability to assign both accounts and 
opportunities based on the criteria Opportunity Lead Quality. To configure Assignment Manager to 
assign accounts based on this criteria, you must configure and expose the Opportunity Lead Quality 
column to the Account assignment object. 

NOTE: The triggers for dynamic assignment are based on the workflow policy components and 
workflow policy component columns. For more information about triggers, see �Generating Triggers 
for Dynamic Assignment� on page 176.

The following procedure explains how to create assignment rules that assign two objects using only 
one object criteria. 

NOTE: Assignment based on calculated fields is not possible. A calculated field does not have a 
corresponding database table field, which is a key requirement for the definition of an assignment 
criterion. Configuration of the Assignment Attribute Column requires Workflow Policy Component and 
Workflow Policy Component Column information, and a Workflow Policy Component Column 
references a database table column.

To create an assignment rule that assigns two objects using only one object criteria

1 Create a workflow policy component for both objects.

For procedures using a specific example, see �Phase 1: Creating a Workflow Policy Component for 
Both Objects� on page 122.

2 Map the workflow policy component to the assignment criteria.

For procedures using a specific example, see �Phase 2: Mapping a Column to the Workflow Policy 
Component� on page 123.

3 Map the workflow policy component to the assignment attribute.

For procedures using a specific example, see �Phase 3: Mapping the Workflow Policy Component 
to the Assignment Attribute� on page 123.

4 Define an assignment rule for two objects using one assignment (object) criteria.

For procedures, see �Creating Assignment Rules to Assign Two Objects� on page 194.

For more information about workflows in general, see Siebel Business Process Designer 
Administration Guide.

Example of Creating a Workflow Policy Component
This section explains how to create a workflow policy component based on a specific scenario of 
creating an assignment rule that assigns candidates to two objects (Account and Opportunity) using 
only one of the object�s criteria (Opportunity Lead Quality). The example for accomplishing this is 
divided into four phases; perform each phase and the steps within each phase in the order provided.

■ �Phase 1: Creating a Workflow Policy Component for Both Objects� on page 122
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■ �Phase 2: Mapping a Column to the Workflow Policy Component� on page 123

■ �Phase 3: Mapping the Workflow Policy Component to the Assignment Attribute� on page 123

■ �Phase 4: Administration Tasks After Configuration� on page 124

Phase 1: Creating a Workflow Policy Component for Both Objects
In this first phase, you create a workflow policy component for both objects.

To create a workflow policy component

1 Start Siebel Tools.

2 Lock the project.

a In the Object Explorer, select the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

For this example, select Assignment (SSE).

c Check the Locked field.

3 Select the workflow policy object for which you want to create a workflow policy component.

a In the Object Explorer, select Workflow Policy Object.

b In the Workflow Policy Objects window, select the object.

For this example, select Account.

4 Add a new workflow policy component record.

a In the Object Explorer, expand Workflow Policy Component.

b In the Workflow Policy Component window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the workflow policy component.

For this example, type Account/Opportunity.

b In the Source Table Name field, select the source table for the workflow policy component.

For this example, select S_OPTY.

c In the Source Column Name field, select the source column for the workflow policy component.

For this example, select PR_DEPT_OU_ID.

d In the Target Component Name field, select the target component for the workflow policy 
component.

For this example, select Account.

e In the Target Column Name field, select the target column for the workflow policy component.

For this example, select ROW_ID. 
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Phase 2: Mapping a Column to the Workflow Policy Component
After you create the workflow policy components for both objects, you need to map the workflow 
policy component to the assignment criteria. You do this by mapping a column to one of the workflow 
policy components. In this example, you map the Opportunity workflow policy component to the 
Opportunity Lead Contact assignment criteria.

To map a column to the workflow policy component

1 With the Account/Opportunity record still selected, expand the Workflow Policy Component 
object in the Object Explorer, and then select the Workflow Policy Component Col object.

2 In the Workflow Policy Component Columns window, choose Edit > New Record.

3 In the Workflow Column Name field, select the workflow column for the workflow policy 
component.

For this example, select Opportunity Lead Quality.

Phase 3: Mapping the Workflow Policy Component to the Assignment 
Attribute
After you map a column to the workflow policy component, you map the workflow policy component 
to the assignment attribute. In this example, you map the Account/Opportunity policy component to 
the Lead Quality Code assignment attribute.

To map the workflow policy component to the assignment attribute

1 In the Object Explorer, select the Assignment Attribute object.

2 In the Assignment Attributes window, select Lead Quality Code.

3 In the Object Explorer, expand the Assignment Attribute object and select the Assignment 
Attribute Column object.

4 In the Assignment Attribute Columns window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the assignment attribute column.

For this example, type Account: Lead Quality.

b In the Assignment Object field, select the assignment object to which candidates are assigned 
for the assignment rule.

For this example, select Account.

c In the Workflow Policy Component field, select the workflow policy component to map to this 
assignment attribute.

For this example, select Account/Opportunity.

d In the Workflow Policy Component Column field, select the workflow policy component column 
to map to this assignment attribute.

For this example, select Opportunity Lead Quality.
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e In the Sequence field, specify the sequence of this assignment attribute.

For this example, type 2.

6 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Server 
Administration After Configuring Assignment Manager� on page 125.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, and assignment attributes. Make sure all projects 
are recompiled�not only the locked projects�if you inactivate or delete a top-level object type 
or assignment criteria. For more information on when to recompile the siebel.srf file, see Table 20 
on page 125.

Phase 4: Administration Tasks After Configuration
After the workflow policy component is mapped to the assignment attribute, the siebel.srf file must 
be updated and various server administration tasks run. To make sure your configurations are 
recognized, complete steps in �To update your deployment with new configurations� on page 125.

Workflow Policy Components Inactivated by Default
The Workflow Policy Components, shown in Table 19 for the Opportunity Workflow Policy Object, are 
inactivate by default for Assignment Manager.

If these Workflow Policy Components are required for your deployment, activate the components by 
following the procedures that describe defining a Workflow Policy Component in Siebel Business 
Process Designer Administration Guide.

Table 19. Inactive Assignment Manager Workflow Policy Components

Workflow Policy 
Object Workflow Policy Component

Opportunity Indirect Account

Opportunity Indirect Account Address

Opportunity Indirect Account Industry

Opportunity Indirect Account Primary Address

Opportunity Indirect Account Synonym

Opportunity Indirect Account/Industry

Opportunity Opportunity/Indirect Account

Opportunity Primary Account Address
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Server Administration After Configuring 
Assignment Manager
After configuring Assignment Manager objects and attributes, it is often necessary to recompile the 
.srf file and restart various server components and tasks. Table 20 summarizes the required 
administration tasks based on the type of configuration process. 

CAUTION: You must recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, and assignment attributes. Make sure all projects are 
recompiled�not only the locked projects�if you inactivate or delete a top-level object type or 
assignment criteria. 

NOTE: For information about checking out and checking in objects, see Using Siebel Tools. 

Use the following procedure to update your deployment with new configurations.

NOTE: Some steps may not be required for your particular deployment. See Table 20 on page 125 
and the particular procedure for the necessary steps.

To update your deployment with new configurations

1 Compile changes to the siebel.srf file, if necessary, and deploy it to the server.

a Choose Tools > Compile Projects.

b In the Object Compiler dialog box, select the project (or projects) you want to compile.

Table 20. Summarization of Server Administration After Configuring Assignment Manager

Configuration Process
Compile 
.srf File

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart Workflow 
Monitor Agent (for 
dynamic assignment)

Add, inactivate, or delete 
assignment objects

Yes Yes Yes Yes

Configure assignment 
objects

No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment attributes

Yes Yes Yes Yes

Configure assignment 
attribute columns

No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria

Yes Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria 
attributes

Yes Yes Yes Yes
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c Select the Siebel client repository file (default is siebel.srf) located in the Objects subdirectory 
within the Siebel client root directory.

d Click Compile.

For more information on when to recompile the siebel.srf file, see Table 20 on page 125 and Using 
Siebel Tools. For information on distributing the siebel.srf file, see Siebel Anywhere 
Administration Guide.

NOTE: It is not necessary to recompile the siebel.srf file whenever you configure an assignment 
object or an assignment attribute column, but you must recompile the siebel.srf file whenever 
you add, inactivate, or delete any assignment object types, assignment criteria, or assignment 
attributes.

Make sure all projects are recompiled�not only the locked projects�if you inactivate or delete 
a top-level object type or assignment criteria. 

2 If you are running dynamic assignment, perform the following steps:

a Stop the Workflow Monitor Agent server component.

b Regenerate triggers by running the Generate Triggers server component.

c Release assignment rules (if rules have changed) by clicking Release in the Assignment Rules 
view.

For more information on releasing assignment rules, see �Releasing Assignment Rules� on 
page 154.

d Restart the Workflow Monitor Agent server component. 

For more information on stopping and restarting server components, see Siebel System 
Administration Guide.

3 If your are running dynamic assignment, stop and restart the Assignment Manager server 
component for the changes to take effect.

a Stop the Workflow Monitor Agent server component.

b Stop the Assignment Manager server component.

c Start the Assignment Manager server component.

d Start the Workflow Monitor Agent server component.

For more information on stopping and restarting server components, see Siebel System 
Administration Guide.

NOTE: You must stop and restart the Assignment Manager server component whenever you add, 
inactivate, or delete any assignment object types, assignment criteria, or assignment attributes.
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5 Assignment Rule Administration
This chapter explains how to migrate, define, and release assignment rules in the Siebel client using 
the various assignment manager components and features. It covers the following topics:

■ �Migrating Assignment Rules� on page 127

■ �Process of Defining Assignment Rules� on page 127

■ �Releasing Assignment Rules� on page 154

The tasks explained in this chapter are for assignment administrators (AAs), and as such, the 
procedures are documented using the Administration - Assignment screen and views.

NOTE: Even if you intend to use predefined assignment objects, you must define assignment rules 
by completing the tasks in this chapter. 

Migrating Assignment Rules
You can use Siebel Enterprise Integration Manager (EIM) or Application Deployment Manager (ADM) 
to migrate assignment rules from one system to another, such as from a test environment to a 
production environment. If you add or change assignment objects, assignment attributes, or 
assignment criteria, you must also migrate the repository to the server production database.

For more information about migration, see Siebel Enterprise Integration Manager Administration 
Guide and Going Live with Siebel eBusiness Applications.

Process of Defining Assignment Rules
To define assignment rules, you need to perform the following tasks in the Siebel client:

1 �Creating Assignment Rule Groups� on page 128

2 �Creating Assignment Rules� on page 130

3 �Defining Server Key Maps� on page 133

4 �Defining Assignment Rule Sequences� on page 133

5 �Creating Assignment Criteria� on page 134

6 �Creating Assignment Criteria Values� on page 137 (optional when using the Compare Object to 
Person comparison method)

7 �Creating Criteria Values as Skills with Expertise Codes and Weighting Factors� on page 139 
(optional; use only when configuring an object to use skills)

8 �Defining Assignment Workload� on page 142

9 �Adding Employees, Positions, and Organizations to Assignment Rules� on page 147
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10 �Assigning Skills to Employees, Positions, and Organizations� on page 153 (optional; only when 
configuring an object to use skills) 

After you define your assignment rules, you must release them to instruct Assignment Manager to 
use these rules. For more information about releasing rules, see �Releasing Assignment Rules� on 
page 154.

These topics are organized to present information in a sequence roughly corresponding to the order 
in which you are likely to be concerned with the subjects described when defining new assignment 
rules. For additional tasks required for delegated assignment administration, see �Assignment Rule 
Administration for Delegated Assignment� on page 155.

NOTE: The procedures in this chapter are written for the Administration - Assignment screen and 
views unless noted otherwise.

Several other server processes, not fully documented in this guide, play an integral role in 
Assignment Manager functionality. The Siebel system administration documentation, especially 
Siebel Business Process Designer Administration Guide, and Siebel System Administration Guide 
should be used as additional references when using Assignment Manager with these processes. For 
application development, see Using Siebel Tools and Configuring Siebel eBusiness Applications.

Creating Assignment Rule Groups
Before defining assignment rules based on your particular business needs, you need to decide 
whether you want to use rule groups. Create rule groups if you want a separate set of assignment 
rules that you can apply to different business scenarios. 

Another factor you should consider when deciding to create rule groups is whether or not you need 
rule group hierarchies. Use rule group hierarchies if you plan to use delegated assignment.

Alternatively, you do not need to create rule groups if you want all rules processed every time you 
run Assignment Manager. In this case, you use the Default Rule Group that is provided as part of the 
Assignment Manager seed data. 

This topic explains how to create new assignment rule groups using the assignment administration 
views. 

This task is a step in �Process of Defining Assignment Rules� on page 127.

To create an assignment rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Rule Groups List.

2 In the Rule Groups List list, click New.

3 In the new record, click in the available fields to enter relevant information for the new rule 
group.

The new rule group appears in the Rule Group List and the Rule Group Explorer.
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Table 21 shows the predefined fields.

TIP: All fields may not be visible in the initial view; use the Columns Displayed feature to make 
fields visible (right-click, select Columns Displayed, use the arrows to move a field from Available 
Columns to Selected Columns, and then click Save).

Table 21. Assignment Rule Group Fields

Field Description

Activation Start date of the assignment rule group. 

By default, rules within a group inherit the activation date from the group date. 
However, if you specify an activation date for a particular rule, it overrides that 
date.

NOTE: If your application is enabled for the Universal Time Coordinated (UTC) 
standard, see Global Deployment Guide for proper database settings. 

Expiration End date of the assignment rule group. 

By default, rules within a group inherit the expiration date from the group date. 
However, if you specify an activation date for a particular rule, it overrides that 
date.

NOTE: If your application is enabled for the Universal Time Coordinated (UTC) 
standard, see Global Deployment Guide for proper database settings. 

Key Based Indicates the rule group is intended for key-based routing and usually has a 
corresponding server key mapping.

By checking this flag, even if there is no server key mapping defined for the rule 
group, this makes sure that the rules that belong to this rule group are not 
processed when running the assignment server in default mode.

Note: The Key Based field may be a hidden column on the Assignment Rule 
Groups list. You can enable the Key Based field by selecting it through the 
Columns Displayed feature.

For more information about key-based routing and server key maps, see �About 
Server Key Maps� on page 23.

Name Name of the assignment rule group.

Organization The organization in which this rule group belongs.

Owner Login The login of the owner position. The owner position has visibility from the 
delegated administration views for rule groups and each of the child rule groups.
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For more information about rule groups and the Default Rule Group, see �About Assignment Rule 
Groups� on page 22. If you plan to use delegated assignment, see also �Creating Child Assignment 
Rule Groups� on page 157.

Creating Assignment Rules
This topic explains how to create assignment rules. For more information on assignment rules, see 
�About Assignment Rules� on page 19.

This task is a step in �Process of Defining Assignment Rules� on page 127.

To create an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Rules List.

2 In the Assignment Rules list, click New. 

3 In the new record, click in the available fields to enter relevant information for the new rule.

Owner Position The owner of the rule group. Each rule group has an owner (and potentially 
designees who also have owner rights). 

For more information about owners and designees, see �Owners and Designees� 
on page 52.

Parent Rule 
Group

A rule group that appears directly above another rule group in the hierarchy.

Table 21. Assignment Rule Group Fields

Field Description
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Table 22 shows the predefined fields.

TIP: All fields may not be visible in the initial view; use the Columns Displayed feature to make 
fields visible (right-click, select Columns Displayed, use the arrows to move a field from Available 
Columns to Selected Columns, and then click Save).

Table 22. Assignment Rule Fields

Field Description

Activation Start date of the assignment rule.

NOTE: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database 
settings. 

Assignee Filter Filters used by Assignment Manager to determine which potential 
assignees are assigned. Choices for assignee filters are:

■ All, Above Minimum

■ All, Must Assign

■ One, Best Fit

■ One, Random

Defaults to All, Above Minimum when creating new assignment rules.

For more information about how filters are used by Assignment Manager 
to determine which potential assignees are assigned to an object from 
each assignment rule, see �Assignee Filter Field� on page 20.

Candidate Passing 
Score

Minimum score required for candidates to qualify for this assignment 
rule. Defaults to 0 (zero) when creating new assignment rules.

Check Employee 
Calendar

If selected, activates Assignment Manager to check employees� 
calendars when determining assignment eligibility. Used only for 
employee-based objects.

For more information about this feature, see �Check Employee Calendar 
Field� on page 21.

Exclusive If selected, candidates for this assignment rule supersede candidates 
that qualify for any other nonexclusive assignment rules. 

For more information on the exclusive feature, see �Exclusive Field� on 
page 21.

Expiration End date of the assignment rule.

Note: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database 
settings. 

Name Name of the assignment rule.
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Objects to be Assigned One or more assignment objects applied to this rule.

Person Candidates 
Source

Determines whether the person candidates for this rule are specified on 
the rule (statically) or come dynamically from the object row. The 
choices are From Rule, All People, and the list of other dynamic person 
candidate team records you defined in the Dynamic Candidate object 
using Siebel Tools.

For more information about this field, see �Candidates Source Field� on 
page 20. For more information about dynamic candidates, see �About 
Assignment Rules� on page 19.

Organization 
Candidates Source

Determines whether the organization candidates for this rule are 
specified on the rule (statically) or come dynamically from the object 
row. The choices are From Rule, All Organizations, and the list of other 
dynamic candidate team records you defined in the Dynamic Candidate 
object using Siebel Tools.

For more information about this field, see �Candidates Source Field� on 
page 20. For more information about dynamic candidates, see �About 
Assignment Rules� on page 19.

Primary Employee Primary employee for this assignment rule. Typically used for service-
related assignments. Applicable only if this employee is included for the 
assignment rule. If the assignee filter type is One, Best Fit, then do not 
select a primary employee, because the highest-scoring employee is still 
selected and the primary employee is ignored.

Primary Organization Primary organization for this assignment rule. Applicable only if this 
organization is included for the assignment rule. If the assignee filter 
type is One, Best Fit, then do not select a primary organization, because 
the highest-scoring organization is still selected and the primary 
organization is ignored.

Primary Position Primary position for this assignment rule. Typically used for sales-related 
assignments. Applicable only if this position is included for the 
assignment rule. If the Assignee Filter type is One, Best Fit, then do not 
select a primary position, because the highest-scoring position is still 
selected and the primary position is ignored.

Rule Group Assignment rule groups applied to this rule. Each rule must be associated 
to an assignment rule group.

For more information, see �About Assignment Rule Groups� on page 22.

Score Score given to candidates who qualify for this assignment rule

Sequence Sequence number for this rule. By default, assignment rules do not have 
a sequence number�one must be assigned by the administrator. For 
more information, see �About Assignment Rule Sequencing� on page 26.

Table 22. Assignment Rule Fields

Field Description
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For more information about the assignment rules, see �About Assignment Rules� on page 19.

Defining Server Key Maps
This topic explains how to define server key maps.

This task is a step in �Process of Defining Assignment Rules� on page 127.

To define a server key map

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Server Key Mappings.

2 In the Assignment Server Key Mappings list, click New.

3 In the new record, click in the available fields to enter relevant information.

Table 23 shows the predefined fields.

For more information about server key mapping, see �About Server Key Maps� on page 23. For more 
information about running Assignment Manager using server key maps, see �Running Assignment 
Manager in Interactive Mode� on page 171.

Defining Assignment Rule Sequences
This topic explains how to define sequences for assignment rules.

This task is a step in �Process of Defining Assignment Rules� on page 127.

To define a sequence for an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Rules List.

Table 23. Server Key Map Fields

Field Description

Assignment 
Rule Group

The assignment rule group that you wish to associate with a particular Siebel 
Server running Assignment Manager. For more information, see �About Assignment 
Rule Groups� on page 22.

Siebel Server 
Name

The name of the Siebel Server that is running that instance of Assignment 
Manager. Note that you should enter the logical Siebel Server name, not the 
machine name.

For more information about Siebel Servers, see Siebel System Administration 
Guide.
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2 In the Assignment Rules List list, select the assignment rule for which you want to define rule 
sequencing.

3 In the Sequence field, enter a sequence number.

For more information about assignment rule sequences, see �About Assignment Rule Sequencing� on 
page 26.

Creating Assignment Criteria
This topic explains how to create assignment criteria for assignment rules.

This task is a step in �Process of Defining Assignment Rules� on page 127.

NOTE: Assignment rules can be created with no criteria. A rule of this nature functions to make sure 
data items of a particular type are assigned, that is, objects of the defined type pass. Use these rules 
carefully as a rule defined with no criteria can make assignments that are not required. 

To create an assignment criterion

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Rules List.

2 In the Assignment Rules List list, drill down on the assignment rule for which you want to create 
an assignment criterion, and then click the Criteria view tab (if not already active).

3 In the Criteria list, click New.

4 In the new criterion record, click in the available fields to enter the relevant information.

NOTE: If you want to query for an assignment criterion, you must use the name of the 
assignment criterion, not the display name for the assignment criterion object you configured 
using Siebel Tools. For example, if the name of the Account assignment criteria is ACCOUNT_ID, 
then you must use this name for your query, although the display name is Account. The queries 
for seed assignment criteria must also be made with their English names, that is, these queries 
do not accept non-English characters. 
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Table 24 shows the predefined fields.

Table 24. Assignment Criteria Predefined Fields

Field Description Example 

Comparison
Method

Methods used by Assignment Manager to determine how 
objects and candidates are matched. For explanations of each 
method, see Table 6 on page 28.

Compare to 
Object

DA Read Only If selected, makes a criterion read-only for delegated 
administrators. By checking this field, the assignment 
administrator (AA) makes sure the criterion is read-only to all 
users who view the rule from the delegated assignment 
views, including the owner of that child rule group.

For example, if an AA creates Rule A in a rule group and that 
rule gets inherited as Rule B in a child rule group, the AA can 
add a criterion to Rule B and make it read-only. The owner of 
the child rule group cannot change this setting. Without this 
flag, the owner of the child rule group could delete that 
criterion because it was not inherited from the parent rule.

NOTE: This field appears only in the Administration - 
Assignment screen (does not appear in the delegated 
assignment views). Criteria with this flag set to TRUE remain 
editable in the assignment administration views.

Inclusion Methods used by Assignment Manager to determine how 
criteria values and candidates are matched. Choices are: 
Include, Include All Matching, Include All, and Exclude.

For more information on inclusion methods, see Table 7 on 
page 30.

Include

Inherited If selected, indicates the criterion was inherited from a parent 
rule. This is a read-only field.

NOTE: This field appears only in the Administration - 
Assignment screen (does not appear in the delegated 
assignment views).

Minimum Score Minimum score required to qualify for this criterion. 

If the total score from all matching criterion values 
(calculated based on the inclusion method for the rule) is 
greater than or equal to the minimum score specified for the 
criterion, then the criterion passes.

For more information about inclusion methods, see 
�Assignment Criteria Inclusion Methods� on page 29.
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Figure 17 shows an example of creating assignment criteria using the values from Table 24. This 
example creates a required Product Defect Priority assignment criteria for an assignment rule that 
is compared to service objects.

Read Only Indicates the criterion is read-only. 

TIP: If either the DA Read Only flag or the Inherited flag for 
a criterion is true in the assignment administration view, the 
Read Only flag is true in the delegated assignment views.

NOTE: This field appears only in the Administration - 
Delegated Assignment views. (It does not appear in the 
Administration - Assignment views).

Required Determines whether the criteria is required. Choices are: 
Always, Never, and When Available.

For more information, see �About the Required Attribute for 
Assignment Criteria� on page 32.

Always

Rule Criterion The assignment criterion you create. Product Defect 
Priority

Score Score for this criteria. Candidates that satisfy this criteria 
have this score added to their total score.

Template If selected, Assignment Manager ignores the criterion when 
processing rules. 

NOTE: Assignment Manager does not process templated 
criteria until an inheritor chooses to apply a template to an 
assignment rule. For more information about applying 
templated criteria, see �Applying Templated Criteria to 
Inherited Assignment Rules� on page 160.

TIP: When a rule with a templated criterion is inherited, the 
criterion is not automatically inherited with the other criteria. 
You must explicitly apply the criterion to the inherited rule. 
After the criterion is applied to the inherited rule, you can 
modify the criterion as you would any other criteria.

Figure 17. Example of Creating Assignment Criteria

Table 24. Assignment Criteria Predefined Fields

Field Description Example 
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For more information on assignment criteria, see �About Assignment Criteria and Criteria Methods� on 
page 27.

Creating Assignment Criteria Values
This topic explains how to create criteria values. Each assignment criterion has one or more criteria 
attributes that are shown as columns in the Values list applet.

This task is a step in �Process of Defining Assignment Rules� on page 127.

NOTE: Only assignment criteria that use the Compare to Object, Compare to Person, or Compare to 
Organization comparison methods use criteria values. 

To create criteria values

1 With the appropriate assignment criterion selected in the Criteria list (Navigate > Site Map > 
Administration - Assignment > Assignment Rules List > Criteria), scroll down to the Values 
subview.

2 In the Values list, click New. 

3 In the new record, click in the available fields to enter the relevant information. 

NOTE: The assignment attributes for criteria values that are available differ depending on the 
assignment criterion you select in Step 1.
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Table 25 shows examples of assignment attributes for the assignment criteria created in �Creating 
Assignment Criteria� on page 134.

NOTE: You define different types of criteria values depending on the assignment attribute. Some 
criteria values appear as list of value (LOV) fields from which you choose a value (such as Account 
State), some criteria values show a pick dialog box from which you choose a value (such as Account), 
and some criteria values are numbers which you choose using the calculator button, while other 
values are dates which you choose using the calendar select button.

NOTE: It is possible to create duplicate criteria values for an assignment criteria. If both criteria 
values use scores in this case, then both scores are added to the assignment criteria if the criteria 
value passes. This can happen when you create criteria values that use ranges (such as criteria 
values for the Revenue assignment criteria). 

CAUTION: It is recommended that you not create duplicate criteria values for the same assignment 
criterion, even though Assignment Manager allows this. If both criteria values use scores and you 
use the Include inclusion method, the score added to the passing candidate may be inconsistent. 
And, if you use the Include All or Include All Matching inclusion method, both the scores are added 
to the passing candidate.

Wildcard characters can also be used when defining specific criteria values. This option allows for a 
greater range of assignment object matches. For example, if you create an assignment rule for 
Account objects with the Account City as assignment criteria, the corresponding criteria value City 
can be defined as A*. This setting matches Accounts in cities beginning with the letter A. 

If a criteria value includes the special characters �?�, �*�, and �\� that are used as literals, the escape 
identifier character (\) must be added before each special character in the value field. For example, 
the criteria value Tri*Laptop is entered into the Values field as Tri\*Laptop.

Criteria values that include alphanumeric entries are stored as string values. These values are sorted 
lexicographically, that is, in dictionary order, when determining specific ranges for assignment rules. 
For example, the value AB10 is sorted between AB1 and AB9 even though you may require AB10 
placed greater than AB9. 

Table 25. Available Assignment Attributes

Criteria Value Example

Score 10
5

Product Defect Priority 1�Very High
2�High
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Figure 18 shows an example of creating Product Defect Priority criteria values using the procedure 
�To create criteria values� on page 137 and the values in Table 25 on page 138. 

For more information on criteria values, see �About Assignment Criteria Values� on page 34.

Creating Criteria Values as Skills with Expertise Codes 
and Weighting Factors
Creating criteria values as skills with expertise codes is a preconfigured feature of assignment criteria 
values and works with assignment rules for service objects (or any object configured to use skills). 
Creating skills is similar to creating criteria values. This section explains how to create skills with 
expertise codes and how to use weighting factors for the skills that you create by describing the 
following tasks:

■ �Creating Expertise Codes� on page 140

■ �Defining Weighting Factors� on page 141

These tasks are one step in �Process of Defining Assignment Rules� on page 127.

For more information on creating assignment criteria values, see �Creating Assignment Criteria 
Values� on page 137.

Figure 18. Example of Creating Criteria Values
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Figure 19 shows an example of creating a required Product Line Wildcard assignment criterion that 
is compared to candidates. This criterion requires a minimum score of 10 and the modem product 
skill with an expertise level of intermediate or better. 

In this example, only candidates with an intermediate or expert expertise qualify for this skill and 
receive 20 points.

Creating Expertise Codes
When defining a criteria value as a skill, select the desired expertise code from the Expertise Code 
field. For more information on skills, see �Assignment Operation Modes� on page 44. 

To create expertise codes, use the procedure in this section. For more information on expertise 
codes, see �Expertise Codes� on page 37.

CAUTION: You should perform the procedures in this section only if the default expertise codes 
(novice, intermediate, and expert) do not meet the requirements of your organization.

To create expertise codes

1 From the application-level menu, choose Navigate > Site Map > Administration - Data> List of 
Values.

2 In the List of Values list, click New.

3 In the new record, click in the fields to enter the relevant information for the expertise code.

a In the Type field, click the select button, query for EXPERTISE_CD in the Pick Value Type dialog 
box, and then click OK.

b In the Display Value field, type the name of the expertise code as you want it to appear.

c In the Language-Independent Code field, type in the exact value that you entered in Step b.

Figure 19. Example of Creating a Skill with an Expertise Code
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d In the Language Name field, click the select button to select the appropriate language in the Pick 
Language Name dialog box, and then click OK.

e In the Translate field, click to place a check mark (if not already checked).

f In the Order field, type a numerical value for the rank of the expertise code.

The numerical value you type in this field determines the rank of the expertise code. Use a 
higher value to apply a greater rank to the expertise code, and a lower value to apply a lesser 
rank.

The new expertise value appears in the List of Values list and also becomes a valid expertise code 
selection in the criteria value drop-down menu when defining skills.

For information on multilingual list of values (MLOV), see Configuring Siebel eBusiness Applications. 

Figure 20 shows an example of creating a Manager expertise code that is ranked higher than the 
default expertise codes. 

Defining Weighting Factors
If you use weighting factors to weigh the expertise codes, candidates with different expertise receive 
different scores. For example, if you use the weighting factors described in Table 8 on page 39 and 
the expertise code defined in Figure 19 on page 140: 

■ Candidates who possess an intermediate expertise in the modem product skill receive 20 points 
and qualify for this criterion.

■ Candidates who possess an expert expertise receive 10 points and qualify for this criterion.

■ Candidates who possess a novice expertise fail this criteria (because an expertise level of 
intermediate or better is required), and fail the assignment rule (because the criterion is 
required).

■ Candidates who possess an intermediate expertise are therefore favored, because they receive 
a higher score.

This topic explains how to define weighting factors to weigh skill scores.

To define weighting factors 

1 From the application-level menu, choose Navigate > Site Map > Administration - Data > List of 
Values.

2 Display the list of values of type EXPERTISE_CD.

a In the List of Values list, click Query.

Figure 20. Example of Creating Expertise Codes
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b In the Type field, click the select button.

c In the Pick Value Type dialog box, query for EXPERTISE_CD, click Go, and then click OK.

d In the List of Values list, click Go to complete the query.

3 For each of the resulting display values (default values are Novice, Intermediate, and Expert), 
click in the Weighting Factor field and type in a numerical value.

The numerical value you type in this field, relative to the maximum weighting value defined, 
represents the percentage applied to the skill score. 

NOTE: If the Weighting Factor field is not visible when the List of Values appear, use the Columns 
Displayed feature to make it visible (right-click, select Columns Displayed, use the arrows to 
move Weighting Factor from Available Columns to Selected Columns, and then click Save).

Figure 21 shows an example of defining the weighting factors for the default expertise codes using 
the values listed in Table 8 on page 39.

For more information on weighting factors, see �Weighting Factors� on page 38. For information on 
assigning skills to employees, positions, and organizations, see �Assigning Skills to Employees, 
Positions, and Organizations� on page 153.

Defining Assignment Workload
This topic explains how to create workload rules and define workload criteria. For more information 
on workload criteria, see �About Assignment Workload Criteria� on page 40. Optionally, you can also 
create workload rules that can be used in workload criteria. After you have created your workload 
rules (or you can use the predefined workload rules instead), you can define workload criteria in 
assignment rules for employees, positions, or organizations.

The tasks in this topic are one step in �Process of Defining Assignment Rules� on page 127. You must 
first create the workload rules and then define workload criteria for employees, positions, and 
organizations.

To create workload rules

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Workload Distribution Rules.

NOTE: If you plan to use the predefined workload rules, skip to Step 4.

2 In the Workload Rules list, click New.

Figure 21. Example of Defining Weighting Factors
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3 In the new record, click in the available fields to enter the relevant information for the workload 
rule.

a In the Name field, type a name for the workload rule.

b In the Assignment Object field, select the assignment object of the workload rule. 

The following table shows the predefined workload rules:

NOTE: The workload rule�s assignment object must match the assignment rule�s assignment 
object; otherwise, the assignment workload criteria is ignored or a runtime error occurs 
(dependent on the assignment rule assignment object�s Ignore Extra Attributes runtime 
parameter setting).

4 With the appropriate workload rule selected, in the Workload Conditions view, click New.

5 In the new record, click in the available fields to enter the relevant information for the workload 
conditions.

a In the Field field, select a value to define the workload condition. 

The fields that are available depend on the assignment object selected in Step 3 on page 143.

b In the Comparison field, select a comparison method.

NOTE: When specifying values for the comparison operands (LIKE, NOT LIKE, IN, NOT IN, 
and BETWEEN), the Value field must be in a form that the underlying database expects. For 
more information about operands, see Siebel Developer�s Reference.

c In the Value field, select a value with which you want to compare the workload condition.

The values that are available depend on the workload condition selected in Step 3 on 
page 143.

NOTE: If the drop-down arrow does not appear when you select the Value field, you need to 
enter an appropriate value. For example, if you are creating a workload rule for an 
Opportunity object and using Position Id as the workload condition, you need to enter the 
physical ROW_ID of the positions.

NOTE: If the assignment object selected for the workload criteria is team-based, workload criteria 
using this workload rule should be associated with an assignment rule only if the workload rule object 
has the team table (or owner field) referenced by one of its workflow components.

Workload Rule Name Assignment Object

Excellent Leads Opportunity

Critical Service Requests Service Request

Open Opportunities Opportunity

Total Open Service Requests Service Request
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Figure 22 shows an example of creating a workload rule called Example for the Account assignment 
object. The workload condition requires that the account state equal CA.

To define workload criteria for employees and positions

1 Drill down on the assignment rule for which you want to define workload criteria (Navigate > Site 
Map > Assignment Rules List), and then click the Workload Distribution view tab.

2 In the Workload Distribution list, click New.

3 In the new record, click in the available fields and enter the relevant information.

Figure 22. Creating Workload Rules
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Table 26 shows the available predefined fields.

Figure 23 shows an example of defining a workload criteria for employees and positions using values 
specified in Table 26. 

To define workload criteria for organizations

1 Drill down on the assignment rule for which you want to define workload criteria (Navigate > Site 
Map > Assignment Rules List), and then click the Organization Workload Distribution view tab.

2 In the Organization Workload Distribution list, click New.

Table 26. Workload Criteria Fields for Employees and Positions

Field Description Example

Assignment Object Type of assignment object related to this workload rule. Service Request

Maximum Load The maximum workload allowed for this workload rule. 
For more information on how this value affects the 
workload score, see �About Assignment Workload Criteria� 
on page 40.

2

Required Determines whether the workload rule is required for the 
assignment rule. Choices are: Always and Never. For 
more information, see �About Assignment Criteria and 
Criteria Methods� on page 27.

Score Score to apply for this workload rule. For more 
information on workload scores, see �About Assignment 
Workload Criteria� on page 40.

50

Workload 
Distribution Rule

Name of the workload rule to apply to the assignment 
rule. The Workload Rule should already be defined as 
shown in �To create workload rules� on page 142.

Total Open Service 
Requests

Figure 23. Example of Defining Workload Criteria for Employees and Positions
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3 In the new record, click in the available fields and enter the relevant information.

Table 27 shows the available predefined fields.

Figure 24 shows an example of adding a workload criteria for organizations using values specified in 
Table 27 on page 146.

Table 27. Workload Criteria Fields for Organizations

Field Description Example

Assignment 
Object

Type of assignment object related to this workload rule. Opportunity

Maximum Load The maximum workload allowed for this workload rule. For 
more information on how this value affects the workload score, 
see �About Assignment Workload Criteria� on page 40.

3

Required Determines whether the workload rule is required for the 
assignment rule. Choices are: Always and Never. For more 
information, see �About Assignment Criteria and Criteria 
Methods� on page 27.

Score Score to apply for this workload rule. For more information on 
workload scores, see �About Assignment Workload Criteria� on 
page 40.

10

Workload 
Distribution Rule

Name of the workload rule to apply to the assignment rule. The 
workload rule should already be defined as shown in �To create 
workload rules� on page 142.

Excellent 
Leads

Figure 24. Example of Defining Workload Criteria for Organizations
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Adding Employees, Positions, and Organizations to 
Assignment Rules
This topic provides procedures for adding employees, positions, and organizations to assignment 
rules as follows:

■ �Adding Employees to Assignment Rules�

■ �Assigning Employees to Assignment Rules Based on Availability� on page 149

■ �Adding Positions to Assignment Rules� on page 150

■ �Adding Organizations to Assignment Rules� on page 151

This task is a step in �Process of Defining Assignment Rules� on page 127.

For more information about employees, positions, and organizations, see �About Assignment 
Candidates� on page 16. For information about assigning skills to employees, positions, and 
organizations, see �Assignment Strategy for Sales Organizations� on page 61.

Adding Employees to Assignment Rules
This topic explains how to add employees to an assignment rule. Service organizations typically add 
employees to objects. For more information on employees, see �Employee Candidates� on page 16.

NOTE: Assignment Manager does not prevent you from adding employees to an assignment rule that 
requires position assignment. Before adding employees, make sure that the objects for the 
assignment rule allow employee assignment.

To add employees to an assignment rule

1 Drill down on the assignment rule for which you want to add employees (Navigate > Site Map > 
Assignment Rules List), and then click the Employee Candidates view tab.

2 In the Employee Candidates list, click New.

3 In the Add Employees dialog box, select the employees to include for this assignment rule, and 
then click OK.

TIP: To select multiple employees, hold down the CTRL key while selecting employees.

4 In the new employee record, click in the available fields to enter or edit the relevant information.
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Table 28 shows select predefined fields available.

If new candidates are added, make sure you release the assignment rules for the changes to take 
affect. For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 154

NOTE: Assignment Manager caches employee skills when the Siebel Server is started. Every time 
rules are released, employee skills are updated and cached. If you want to automatically refresh 
employee skills at a periodic interval, set the value of Refresh people skills interval (an AsgnSrvr 
component parameter) to the desired interval of update. For more information about employee skills, 
see �Assignment Strategy for Sales Organizations� on page 61. For information about the AsgnSrvr 
component parameter, see �Running Interactive Assignment Using the Command-Line SRVRMGR 
Utility� on page 174.

Assignment Manager can also assign employees based on their association with their parent 
organization. For example, only employees associated with a specific organization can be assigned 
to an assignment object even if other employees not associated with the organization qualify. This 
functionality is called multitiered assignment and must be configured for the appropriate assignment 
object. For more information multitiered assignment, see �About Multitiered Assignment� on page 43 
and �Scenarios for Using Multitiered Assignment with Sales Assignment Rules� on page 66.

Alternatively, you can set a default employee for assignment objects. For example, if you want 
records for a given assignment object assigned to a certain employee, you can change the Default 
Employee property on the assignment object using Siebel Tools. For more information about the 
Default Employee property, see Object Types Reference. For more information about setting this 
property, see �Configuring Assignment Objects� on page 92.

Table 28. Employee Candidates List Fields

Field Description

Activation Start date of the assignment rule employee.

NOTE: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database settings.

Expiration End date of the assignment rule employee.

NOTE: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database settings.

Score An initial score for each employee is permitted in this field to differentiate 
between other employees for potential assignment.
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Assigning Employees to Assignment Rules Based on Availability
Assignment rules can be created for employee-based objects using availability-based assignment, 
which allows Assignment Manager to check an employee�s calendar and to consider the employee�s 
availability when determining assignment eligibility. Assignment objects must be preconfigured 
before using the assignment availability criteria feature. For more information on configuring 
assignment availability, see �Configuring Assignment Objects for Availability-Based Assignment� on 
page 100.

When an assignment object is configured for availability, a user specifies three times for the 
assignment object: an Early Start Time, a Must Start Time, and a Duration. 

■ (Optional) Early Start Time (which is specified in the Calendar Early Start Time Column property 
of the assignment object) is the earliest time the assignment object can be scheduled.

If this time is specified, Assignment Manager looks for an available slot for the specified duration 
in the employees' schedules with the starting time anywhere between the Early Start Time and 
the Start Time. If this time is not specified, it defaults to the Must Start Time which means that 
Assignment Manager looks for an available slot for the specified duration starting exactly at the 
start time.

■ Latest Start Time (which is specified in the Calendar Start Time Column property of the 
assignment object) is the latest time that the assignment object can be started.

■ Duration (which is specified in the Calendar Duration Column property of the assignment object) 
is the time in minutes required to finish the assignment object�s task.

Each of these times is accessed by Assignment Manager when determining the availability of an 
employee. Assignment Manager then uses the availability information like other criteria when 
evaluating employees for the assignment object. Assignment Manager can also be configured to add 
an activity to the calendar of the employee who is assigned the assignment object. For example, if 
a service request is created with times indicating a service duration of four hours, Assignment 
Manager evaluates the object�s times and employees� schedules, and selects only employees who are 
available for the four hours indicated by the service object. Assignment Manager then selects the 
highest scoring employee available and creates an activity for the employee (if the object is 
configured to assign activities). Employees can manually insert activities into their calendar to block 
assignments during specific periods. Similarly, an employee can delete activities created by the 
original assignment so further assignments can be made.

Assignment Manager functions for both single employees and teams. If an object is assigned to a 
team, every employee within the team is assigned an activity for the duration of the assignment (if 
the object is configured to assign activities). Assignment Manager can assign activities for the same 
object at different times based on the calendars of individual team members. A calendar activity, 
however, cannot be split up across multiple dates and times. For more information about activities 
for availability assignment, see �About Creation of Activities for Employees During Availability-Based 
Assignment� on page 104.

When administrators define a new rule, selecting the Check Employee Calendar box activates the 
assignment availability criteria.
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Adding Positions to Assignment Rules
This section explains how to add positions to an assignment rule. Sales organizations typically assign 
positions to objects. For more information on positions, see �Position Candidates� on page 16.

NOTE: Assignment Manager does not prevent you from adding positions to an assignment rule that 
requires employee assignment. Before adding positions, make sure that the objects for the 
assignment rule allow employee assignment.

To add positions to an assignment rule

1 Drill down on the assignment rule for which you want to add positions (Navigate > Site Map > 
Assignment Rules List), and then click the Position Candidates view tab.

2 In the Position Candidates list, click New.

3 In the Add Positions dialog box, select the positions to include for this assignment rule, and then 
click OK.

TIP: To select multiple positions, hold down the CTRL key while selecting positions. 

4 In the new record in the Positions list, click in the available fields to enter or edit the relevant 
information.

Table 29 shows select predefined fields available for editing.

NOTE: You can configure Assignment Manager to define additional fields for Positions associated 
with an assignment rule. For more information, see �Configuring Assignment Objects to Copy 
Additional Columns to the Team Table� on page 203.

After you add positions for an assignment rule, only the active employees for each position are 
available. If Assignment Manager assigns the position, employees for the position have visibility to 
the assigned object.

To delete system-assigned positions from individual assignment objects, or to manually assign other 
positions, see the procedure in �Maintaining the Manually Assigned Primary Position� on page 200. 

Table 29. Positions List Fields

Field Description

Activation Start date of the assignment rule position.

NOTE: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database 
settings.

Expiration End date of the assignment rule position.

NOTE: If your application is enabled for the Universal Time Coordinated 
(UTC) standard, see Global Deployment Guide for proper database 
settings.

Score An initial score for each position is permitted in this field to differentiate 
between other positions for potential assignment.
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If new candidates are added, make sure you release the assignment rules for the changes to take 
affect. For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 154

NOTE: Assignment Manager caches position skills when the Siebel Server is started. Every time rules 
are released, position skills are updated and cached. If you want to automatically refresh position 
skills at a periodic interval, set the value of Refresh people skills interval (an AsgnSrvr component 
parameter) to the desired interval of update. For more information about position skills, see 
�Assignment Strategy for Sales Organizations� on page 61. For information about the AsgnSrvr 
component parameter, see �Running Interactive Assignment Using the Command-Line SRVRMGR 
Utility� on page 174.

Assignment Manager can also assign positions based on their association with their parent 
organization. For example, only positions associated with a specific organization can be assigned to 
an assignment object even if other positions not associated with the organization qualify. This 
functionality is called multitiered assignment and must be configured for the appropriate assignment 
object. For more information on this feature, see �About Multitiered Assignment� on page 43 and 
�Scenarios for Using Multitiered Assignment with Sales Assignment Rules� on page 66.

Alternatively, you can set a default employee for assignment objects. For example, if you want 
records for a given assignment object assigned to a certain employee, you can change the Default 
Employee property on the assignment object using Siebel Tools. For more information about the 
Default Employee property, see Object Types Reference. For more information about setting this 
property, see �Configuring Assignment Objects� on page 92.

Adding Organizations to Assignment Rules
This topic explains how to add organizations to an assignment rule. For more information on 
organizations, see �Organization Candidates� on page 17.

To add organizations to an assignment rule

1 Drill down on the assignment rule for which you want to add organizations (Navigate > Site Map 
> Assignment Rules List), and then click the Organization Candidates view tab.

2 In the Organization Candidates list, click New.

3 In the Add Organization dialog box, select the organizations to include for this assignment rule, 
and then click OK.

TIP: To select multiple organizations, hold down the CTRL key while selecting organizations, and 
click OK.

4 In the new record in the Organizations list, click in the available fields to enter or edit the relevant 
information.
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Table 30 shows select predefined fields available for editing.

If new candidates are added, make sure you release the assignment rules for the changes to take 
affect. For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 154

NOTE: Assignment Manager caches organization skills when the Siebel Server is started. Every time 
rules are released, organization skills are updated and cached. If you want to automatically refresh 
organization skills at a periodic interval, set the value of Refresh people skills interval (an AsgnSrvr 
component parameter) to the desired interval of update. For more information about organization 
skills, see �Assignment Strategy for Sales Organizations� on page 61. For information about the 
AsgnSrvr component parameter, see �Running Interactive Assignment Using the Command-Line 
SRVRMGR Utility� on page 174.

Assignment Manager can also assign organizations based on the positions associated within the 
organization. For example, positions assigned to an assignment object can also have their associated 
organizations assigned. This functionality is called multitiered assignment and must be configured 
for the appropriate assignment object. For more information on this feature, see �About Multitiered 
Assignment� on page 43 and �Scenarios for Using Multitiered Assignment with Sales Assignment Rules� 
on page 66.

Alternatively, you can set a default organization for assignment objects. For example, if you want 
records for a given assignment object assigned to a certain organization, you can change the Default 
Org property on the assignment object using Siebel Tools. For more information about the Default 
Org property, see Object Types Reference. For more information about setting this property, see 
�Configuring Assignment Objects� on page 92.

Table 30. Organizations List Fields

Field Description

Activation Start date of the assignment rule organization.

NOTE: If your application is enabled for the Universal Time Coordinated (UTC) 
standard, see Global Deployment Guide for proper database settings.

Expiration End date of the assignment rule organization.

NOTE: If your application is enabled for the Universal Time Coordinated (UTC) 
standard, see Global Deployment Guide for proper database settings.

Score An initial score for each organization is permitted in this field to differentiate between 
other organizations for potential assignment.
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Assigning Skills to Employees, Positions, and 
Organizations
You use skills to find the best matching candidates to assign to assignment objects. Skills can be 
associated with individual employees, positions, or organizations. During the assignment process, 
Assignment Manager tries to find candidates that have the relevant skills for assignment to a 
particular item. For example, a service request requiring an agent who has expertise for a particular 
product is routed to someone who has that product expertise as a part of their skillset. For more 
information about how skills are applied, see �Assignment Operation Modes� on page 44, and �Creating 
Criteria Values as Skills with Expertise Codes and Weighting Factors� on page 139. For more information 
about creating skills, see �Creating New Skills� on page 118.

This task is a step in �Process of Defining Assignment Rules� on page 127.

You can enable and configure skills at the criteria level by using Siebel Tools. For more information, 
see �Assignment Criteria Configuration� on page 107. 

To associate skills with an employee

1 From the application-level menu, choose Navigate > Site Map > Administration - User > 
Employees > Assignment Skills. 

2 In the Employees list, select the employee for whom you want to define skills.

3 In the Assignment skills list, click New to add a new record.

4 In the Skill field, select a skill from the drop-down list.

5 In the Assignment Skill Items list, click New to add a new record, and then complete the 
necessary fields.

The columns that display in the Employee Skill Items list depend on the skill chosen from the 
drop-down list in the Assignment Skills list.

NOTE: Employees can also track and update their own skill profiles in the User Preferences Profile 
view (Navigate > User Preferences > User Profile > Assignment Skills).

To associate skills with a position

1 From the application-level menu, choose Navigate > Site Map > Administration - Group > 
Positions > Assignment Skills.

2 In the Positions list, select the position for which you want to associate skills. 

3 In the Assignment Skills list, click New.

4 In the Item field, select a skill from the drop-down list.

5 Scroll down to the Position Skill Items list, click New to add a new record, and then complete the 
necessary fields.

NOTE: The columns that display in the Position Skill Items list depend on the skill chosen from 
the drop-down list in the Assignment Skills list.
Siebel Assignment Manager Administration Guide Version 7.7 ■ 153



Assignment Rule Administration ■  Releasing Assignment Rules
To associate skills with an organization

1 From the application-level menu, choose Navigate > Site Map > Administration - Group > 
Organizations > Assignment Skills. 

2 In the Organizations list, select the organization for which you want to associate skills.

3 In the Assignment Skills list, click New.

4 In the Item field, select a skill from the drop-down list.

5 Scroll down to the Organization Skill Items list, click New to add a new record, and then complete 
the necessary fields.

NOTE: The columns that display in the Organization Skill Items list depend on the skill chosen 
from the drop-down list in the Assignment Skills list.

Releasing Assignment Rules
After you create (define) assignment rules or make any changes to the rules, criteria, values, or 
candidates (employee, position, or organization) for the assignment rules, you must release them to 
instruct Assignment Manager to use these rules. Releasing assignment rules also updates the 
rulecache.dat file. For more information about the rulecache.dat file, see �About Assignment Manager 
Rule Cache Files� on page 25.

CAUTION: The following procedure releases all assignment rules simultaneously. Do not release 
assignment rules while associated server tasks are running.

To release assignment rules 

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Rules List.

2 In the Assignment Rules list, click the Release button.

A confirmation message appears indicating the rules have been released and the rulecache.dat 
file is updated. For v77 

NOTE: You can also refresh (update) the rule cache by deleting the rule cache files (the 
*rulecache*.dat files in the siebel_server\bin folder) and restarting the Siebel Server.

TIP: If you want to verify the new or modified rules have been applied, check the timestamp of the 
rulecache.dat file or the AsgnSrvr log file. 

When a new Siebel Server is installed�for instance, as part of an upgrade� pending assignment 
rules are released (the rule cache is recreated) on the first startup. It is recommended that you 
release assignment rules after installation so that servers in the deployment recreate the same rule 
cache. 
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6 Assignment Rule Administration 
for Delegated Assignment
This chapter covers assignment rule administration tasks for delegated assignment. It includes the 
following topics:

■ �Delegated Assignment Rule Administration Overview� on page 155

■ �Process of Making an Assignment Rule Inheritable� on page 156

■ �Creating Child Assignment Rule Groups� on page 157

■ �Adding Owners to the Inheritance Access List� on page 157

■ �Adding Criteria Templates to Assignment Rules� on page 158

■ �Process of Inheriting and Refining Delegated Assignment Rules� on page 159

■ �Inheriting Delegated Assignment Rules� on page 159

■ �Applying Templated Criteria to Inherited Assignment Rules� on page 160

■ �Process of Delegating Assignment Rules to Others� on page 160

■ (Optional) �Adding Designees to Assignment Rule Groups� on page 161

These topics are organized to present information in a sequence roughly corresponding to the order 
in which you are likely to be concerned with the subjects described when using delegated 
assignment.

NOTE: The procedures in this chapter are written for the Administration - Delegated Assignment 
screen and views unless noted otherwise. However, you can also perform these same operations 
using the Rule Group Explorer views in the Administration - Assignment screen.

Before performing the tasks in this chapter, you should be familiar with the assignment 
administration tasks explained in Chapter 5, �Assignment Rule Administration.�

Delegated Assignment Rule 
Administration Overview
If you plan to use delegated assignment, the assignment administrator (AA) or designee must first 
prepare the assignment rules for inheritance in addition to the tasks presented in �Process of Defining 
Assignment Rules� on page 127.
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The assignment administrator (or designee) typically creates rules and rule criteria templates 
(templated criteria) from which all other delegated rules and rule criteria are created using the 
Administration - Assignment views. Delegated administrators (DAs) can inherit these predefined 
rules and further refine those rules by adding new criteria or from templated criteria using the 
Administration - Delegated Assignment views. These refined rules can again be inherited and 
modified by other delegated administrators at a lower level in the hierarchy, and so on. At each level 
in the hierarchy, administrators can assign designees to act on their behalf. Designees can view and 
edit rule groups (and the rules within those rules groups) on behalf of an AA or DA. Figure 11 on 
page 76 shows an example of this n-tier hierarchical relationship.

After a rule is inherited in child rule groups and changes are made to the original rule�such as, 
adding criteria to, expiring, or even deleting the rule�those changes are propagated down the 
hierarchy to all rules that were inherited from it.

For more information about delegated assignment, see �Delegated Assignment� on page 50. For more 
information about rule inheritance and templated criteria, see �About Assignment Rule Inheritance and 
Templated Criteria� on page 54. For examples for implementing delegated assignment, see �Examples 
for Using Delegated Assignment� on page 75.

Process of Making an Assignment Rule 
Inheritable
By associating positions to the inheritance access list for an assignment rule, you make that rule 
inheritable for use by child rule groups (accessible by the rule group�s owners and designees). 
Assignment administrators (AAs and DAs) can make an assignment rule inheritable as long as they 
have access to the rule.

To make assignment rules inheritable, you perform the following tasks:

■ �Creating Child Assignment Rule Groups� on page 157

You must first create a child rule group from a parent rule group, setting the Parent Rule Group 
field to the current rule group.

■ �Adding Owners to the Inheritance Access List� on page 157 

After creating the child rule group, you add the owner of the child rule group to the inheritance 
access list for the rule.

NOTE: Unless the owner of a rule group is on the inheritance access list, that owner (and his or 
her designees) cannot inherit a rule.

■ �Adding Criteria Templates to Assignment Rules� on page 158

Optionally, you can add templated criteria to an assignment rule. DAs then have the option to 
apply the templated criteria to their inherited rules in lieu of creating new criteria.

For more information about inheriting a rule, see �Inheriting Delegated Assignment Rules� on 
page 159.
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For more information about rule groups, see �About Hierarchical Rule Groups� on page 51 and �About 
the Rule Group Explorer� on page 53. For more information about owners and inheritance, see 
�Owners and Designees� on page 52 and �About Assignment Rule Inheritance and Templated Criteria� 
on page 54.

Creating Child Assignment Rule Groups
This topic explains how to create a child assignment rule group using the delegated assignment 
administration views.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 156 and �Process of 
Delegating Assignment Rules to Others� on page 160. 

To create a child rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group folder for which you want to define a child rule 
group, and then click Rule Groups.

3 In the My Rule Group Explorer list, click New.

4 In the new rule group record, click in the available fields to enter relevant information for the 
new group rule.

a In the Name field, type a name for the child rule group.

b In the Owner Position field, click the select button to query for an owner, and then click OK.

NOTE: You must specify an appropriate position for the owner. A position cannot be owner 
(or designee) for a rule group below one for which that position is already an owner or 
designee.

For field descriptions, see �Creating Assignment Rule Groups� on page 128.

TIP: Activation and expiration dates are modifiable only at the root-level rule group level in the 
hierarchy. All other rule groups under the root-level rule group share the same dates and are 
read only.

For more information about rule groups, see �About Hierarchical Rule Groups� on page 51. For more 
information about the Rule Group Explorer, see �About the Rule Group Explorer� on page 53.

Adding Owners to the Inheritance Access List
This topic explains how to add owners to the inheritance access list for an assignment rule using the 
delegated assignment administration views. After owners are added to the inheritance access list of 
an assignment rule, inheritors of that rule can further refine and specialize that rule.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 156 and �Process of 
Delegating Assignment Rules to Others� on page 160.
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To add an owner to the inheritance access list

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group in which the assignment rule resides, and then 
click Rules.

3 In the My Rule Group Explorer list, drill down on the assignment rule you want to make 
inheritable, and then click the Inheritance Access view tab.

4 In the Inheritance Access List, click Synchronize.

NOTE: This action first deletes anyone from the list who is not an owner of a child rule group 
and then adds back only the owners of the child rule group. To prevent deletion, check the Lock 
During Synchronization checkbox next to a position before clicking Synchronize.

5 Delete any positions from the list that you do not want to inherit rules.

6 Alternatively, you can add a single position:

a In the Inheritance Access List, click New. 

b In the Pick Positions dialog box, query for the position you want to give access, and then click OK.

For more information about owners, see �Owners and Designees� on page 52.

Adding Criteria Templates to Assignment Rules
This topic explains how assignment administrators (AAs) can add criteria templates (create 
templated criteria) to an assignment rule using the delegated administration views. After you create 
criteria templates, the templated criteria is available for use with inherited rules.

NOTE: It is recommended that assignment administrators create criteria templates to assist DAs in 
rule creation. This reduces the need for DAs to fully under the steps required and implications of 
creating new logic.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 156.

Adding criteria templates to an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, select the assignment rule for which you want to add templated 
criteria.

NOTE: Depending on the rule, you may need to navigate down the hierarchy.

3 In the My Rule Group Explorer list, drill down on the assignment rule, and then click the Criteria 
view tab (if not already active).

4 Add a new criterion.

For information about creating new criteria, see �Creating Assignment Criteria� on page 134.
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5 Check the Template checkbox for the new criterion.

The templated criterion is now available for use with inherited rules.

NOTE: Assignment Manager does not process templated criteria until an inheritor chooses to 
apply a template to an assignment rule. When someone inherits from that rule, that person has 
the option to apply a template into an actual criterion (by checking the Create From Templates 
button in the Criteria view tab) instead of creating a new criterion.

To learn more about templated criteria, see �About Assignment Rule Inheritance and Templated 
Criteria� on page 54. For information about applying templated criteria to an inherited assignment 
rule, see �Applying Templated Criteria to Inherited Assignment Rules� on page 160.

Process of Inheriting and Refining 
Delegated Assignment Rules
To inherit and refine delegated assignment rules, you perform the following tasks:

1 Inherit an assignment rule.

For a procedure, see �Inheriting Delegated Assignment Rules� on page 159.

2 Add criteria to the inherited assignment rule by either creating new criteria or applying templated 
criteria. 

For information about:

■ Creating new criteria, see �Creating Assignment Criteria� on page 134

■ Applying templated criteria, see �Applying Templated Criteria to Inherited Assignment Rules� 
on page 160

3 Add candidates to the assignment rule.

For information about adding candidates, see �Adding Employees, Positions, and Organizations to 
Assignment Rules� on page 147.

For more information about delegated assignment, see �Delegated Assignment� on page 50 and 
�Delegated Assignment Rule Administration Overview� on page 155.

Inheriting Delegated Assignment Rules
This topic explains how to inherit an assignment rule using the delegated assignment administration 
views.

This task is a step in �Process of Inheriting and Refining Delegated Assignment Rules� on page 159.

To inherit a delegated assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.
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2 In the Rule Group Explorer, expand the rule group for which you want to inherit rules, and then click 
Inheritable Rules.

3 Select one or more rules you want to inherit, and then click Inherit Rules.

The rule (or rules) now appear as rules in the Rule Group Explorer view under Rules. 

For more information about inheriting rules, see �About Assignment Rule Inheritance and Templated 
Criteria� on page 54.

Applying Templated Criteria to Inherited Assignment 
Rules
This topic explains how to apply predefined templated criteria to inherited assignment rules using 
the delegated assignment administration views. 

This task is a step in �Process of Inheriting and Refining Delegated Assignment Rules� on page 159 and 
an optional task in �Process of Delegating Assignment Rules to Others� on page 160.

Applying templated criteria to an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group in which the assignment rule resides and you 
want to apply templated criteria, and then click Rules.

NOTE: Depending on the rule, you may need to navigate down the hierarchy.

3 In the My Rule Group Explorer list, drill down on the assignment rule for which you want to apply 
templated criteria, and then click Create From Templates.

4 In the Pick Criteria Templates dialog box, select the rule criterion you want, and click OK.

A new criterion is added to the rule.

For information about templated criteria, see �About Assignment Rule Inheritance and Templated 
Criteria� on page 54. For information about how to add templated criteria to assignment rules, see 
�Adding Criteria Templates to Assignment Rules� on page 158.

Process of Delegating Assignment Rules 
to Others
To delegate assignment rules to others, you perform the following tasks:

1 Create a child rule group.

For a procedure, see �Creating Child Assignment Rule Groups� on page 157.
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2 Add the owner of the child rule group you created in Step 1 to the inheritance access list of an 
assignment rule.

For a procedure, see �Adding Owners to the Inheritance Access List� on page 157.

3 (Optional) Apply templated criteria to the assignment rule.

For a procedure, see �Applying Templated Criteria to Inherited Assignment Rules� on page 160.

For more information about delegated assignment and administering delegated assignment rules, 
see �Delegated Assignment� on page 50 and �Delegated Assignment Rule Administration Overview� on 
page 155.

Adding Designees to Assignment Rule 
Groups
This topic explains how to add designees to an assignment rule group using the delegated 
assignment administration views. Use the following procedure if you want to delegate assignment 
responsibility to someone else (a designee).

To add a designee to an assignment rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group for which you want to assign designees, and then 
click Designees.

3 In the My Rule Group Explorer list, click New.

4 In the Pick Positions dialog box, query for the position you want to add to the rule group, and 
then click OK.

For more information about designees, see �Owners and Designees� on page 52.
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7 Running Assignment Manager
This chapter provides preparatory considerations and tasks before running Assignment Manager and 
explains how to run Assignment Manager in several operating modes. It covers the following topics:

■ �Considerations Before Running Assignment Manager� on page 163

■ �Preparing to Run Assignment Manager� on page 165

■ �Running Assignment Manager in Interactive Mode� on page 171

■ �Running Assignment Manager in Dynamic Mode� on page 175

■ �Running Assignment Manager in Mobile Mode� on page 183

■ �Running Assignment Manager in Batch Mode� on page 184

Considerations Before Running 
Assignment Manager
Before running Assignment Manager, you must already have created your assignment rules. For 
information on creating assignment rules, see Chapter 5, �Assignment Rule Administration.� You also 
need to perform several preparation tasks. For more information, see �Preparing to Run Assignment 
Manager� on page 165.

Assignment Manager obtains information required for operation from the following sources:

■ The assignment rules and criteria as well as employees, positions, and organizations that are 
read from the rule cache file.

NOTE: If you want to automatically refresh skills without restarting the Assignment Manager 
component, set the value of the Refresh people skills interval component parameter to the 
desired update interval (the value must be greater than zero seconds). Then, when rules are 
released, Assignment Manager refreshes skills and recreates the rulecache.dat file at the periodic 
interval set. For more information about the Refresh people skills interval, see the MaxSkillsAge 
AsgnSrvr component parameter in Table 35 in �Running Interactive Assignment Using the 
Command-Line SRVRMGR Utility� on page 174. 

■ The run-time parameters of assignment objects and their properties, the list of values for the 
picklists, and assignment criteria, attributes, workflow policy components, workflow policy 
component columns, and other repository information from the database.

CAUTION: If there is a change in at least one of the primaries, or if there is a change in at least one 
of the team tables, Assignment Manager updates all columns (primaries, ASGN_DT, and system 
columns) on the object row. However, if there is no net change, only the ASGN_DT column is 
updated. 
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Make sure the rule cache file is updated (see �Releasing Assignment Rules� on page 154 for a 
procedure) and the .srf file is compiled with the latest configurations (see �Server Administration After 
Configuring Assignment Manager� on page 125 or Using Siebel Tools for information on this 
procedure) before running Assignment Manager. 

TIP: If you are using DB2, for performance reasons, you should periodically execute the REORG and 
update statistics utilities against all applicable tables for the assignment objects that you use. For 
example, to enhance Assignment Manager performance before running batch or dynamic assignment 
for Contact territory realignment (assuming you are using the preconfigured Contact assignment 
object), you should execute REORG and update statistics against the related tables, such as the 
S_CON_TERR and S_POSTN_CON tables. For the Account assignment object, consider evaluating the 
S_ORG_TERR and S_ACCNT_POST tables; and for the Opportunity assignment object, consider 
evaluating the S_OPTY_TERR and S_OPTY_POSTN tables; and so on. For applicable tables for other 
assignment objects (planned or in use), view the assignment object properties for those objects 
using Siebel Tools. 

To view assignment object properties, see �Creating Assignment Objects� on page 92. For more 
information about the REORG and update statistics utilities, see Implementing Siebel eBusiness 
Applications on DB2 UDB for z/OS and OS/390 and the Siebel Server Installation Guide for your 
operating system.

CAUTION: Assignment Manager uses many Siebel Server resources. It is recommended you monitor 
the Siebel Servers whenever Assignment Manager is invoked, especially if you run multiple instances 
at the same time. For more information about running multiple instances of Assignment Manager, 
see �Running Multiple Instances of Assignment Manager in Batch Mode� on page 190.

About Excluding Candidates from Assignment
You can choose to ignore a specific candidate or candidates, even though you added the candidate 
or candidates to an assignment rule. You do so at runtime by specifying the ExcludePersonList or the 
ExcludeOrgList request-level server parameter as comma-separated lists of candidate Ids. 
Assignment Manager does not evaluate these candidates, and because of this, the candidates do not 
appear in log files even when Match or Assign logging is active.

For example, if an employee has not worked on a service request for several days, and if a request 
is submitted to assign the same service request, Assignment Manager assigns the service request to 
the same person again. That is because, given a set of assignment rules and criteria, Assignment 
Manager assigns the candidate with the highest score to the object row. By specifying the 
ExcludePersonList parameter when releasing rules, you can exclude this particular candidate from 
assignment consideration.
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About Excluding Expired (Terminated) Person 
Candidates from Assignment
You can choose to ignore certain employees for rule evaluation. For example, you might want to 
exclude inactive employees or employees who are on a leave of absence from assignment 
consideration. You exclude employees using the Active Employee Where Clause component-level 
server parameter (or use ActiveEmpLOVCode from the Server Manager command line) with a SQL 
WHERE clause that is based on any column (or columns) on the S_EMP_PER employee table. For 
example, you could use the EMP_STAT_CD column with the following value to indicate that you only 
want active employees considered for evaluation and assignment:

AND emp.EMP_STAT_CD='Active'

The employees are ignored even if they are explicitly added to an assignment rule as candidates.

Similarly, you can exclude (ignore) inactive positions using the Active Position Where Clause 
component-level server parameter (or use ActivePosWhereClause from the Server Manager 
command line). 

NOTE: If you make changes to either of these parameters, you must release rules for the them to 
take effect.

CAUTION: When specifying the parameters, you must use the emp SQL alias for the S_EMP_PER 
employee table and the pos alias for the S_POSTN position table. This is to differentiate from other 
columns by the same name in other tables that Assignment Manager might use in the same SQL. 
Otherwise, a SQL error (ambiguous reference to a column) may occur.

Preparing to Run Assignment Manager
Before running Assignment Manager, you must first perform preparation tasks. These tasks include:

■ �Checking the State of the Assignment Manager and Server Request Broker Components� on 
page 165

■ �Configuring the Assignment Manager Component� on page 166

■ �Configuring Assignment Manager Event Logs� on page 168

In addition to the preparatory tasks, there are server administration requirements that should be 
addressed before running Assignment Manager. These include:

■ �Server Administration Requirements for Assignment Modes� on page 170

■ �Server Administration Requirements After Configuration� on page 170

Checking the State of the Assignment Manager and 
Server Request Broker Components
Before running Assignment Manager, you must first make sure that the Siebel Server can start one 
or more multithreaded assignment servers by checking the Assignment Manager and Server Request 
Broker components.
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To check the state of the Assignment Manager and Server Request Broker 
components

1 From the application-level menu, choose Navigate > Site Map > Administration - Server 
Management > Servers.

2 In the Servers list, query for the Assignment Manager and Server Request Broker components, 
and check the Server field to verify these components are running on the appropriate Siebel 
Server. 

TIP: If the Server field is not visible, use the Columns Displayed feature to make it visible (right-
click, select Columns Displayed, use the arrows to move Server from Available Columns to 
Selected Columns, and then click Save).

3 In the State field in the Component Groups list, verify the state of each of the following 
components:

■ Assignment Manager component is Online.

■ Server Request Broker component is Running.

NOTE: If these components are not in their required state, check the log file for errors, and then 
make the necessary corrections.

Configuring the Assignment Manager Component
Before running Assignment Manager, you should configure the Assignment Manager component to 
enhance its performance for your implementation by adjusting the appropriate parameters. Table 31 
on page 167 shows the parameters you can change.

To configure the Assignment Manager component

1 From the application-level menu, choose Navigate > Site Map > Administration - Server 
Configuration > Servers.

2 In the Siebel Servers list, select your server (if more than one server appears) and make sure 
the Assignment Manager component is enabled on that server (the Enable State field in the 
Components list should have a check mark for the Assignment Manager component).

3 Click the Parameters subview (if not already active).

4 In the Parameters list, select the component parameters of interest, and adjust the values as 
required by your implementation to achieve optimal performance.

5 After you have determined the optimal settings, make sure that the MinMTServers parameter is 
set to a current value greater than 0, and then restart the Siebel Server.

This starts the specified number of Assignment Manager components. For more information 
about starting and restarting the Siebel Server, see Siebel System Administration Guide.
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Table 31 shows the parameters used by Assignment Manager that you can change. 

The following bulleted points explain why you might want to configure some of the various 
Assignment Manager component parameters:

■ Check version iterations. Changing this parameter to a small value, such as 1, reduces the 
potential for invalid assignment. For example, running interactive assignment before Assignment 
Manager detects that the Release button was recently pressed causes assignment based on the 
previous version of assignment rules. By having a small iteration value, Assignment Manager 
checks for a newer version of assignment rules more frequently. Test your deployment with this 
lower parameter value to make sure it does not interfere with any other database activity. 

■ Log txn only on change. Setting this parameter to FALSE causes Assignment Manager to log a 
transaction in the S_DOCK_TXN_TABLE on reassignment even when there is no change in rules 
or assignees. By detault, this parameter is set to TRUE. For information about how this parameter 
works with regard to merge conflicts, see Siebel Remote and Replication Manager Administration 
Guide.

Table 31. Assignment Manager Component Parameters

Parameter Name
Parameter 
Alias

Data 
Type Description

Default 
Value

Check version 
iterations

CheckVerIter Integer Defines the frequency of time 
Assignment Manager checks 
whether rule version has changed. 
This also represents the time lag 
the new rules take effect after 
clicking the Release button.

One integer value equals ten 
seconds (minimum value is 1).

6

Default Tasks DfltTasks Integer Default number of service tasks to 
start (server mode only).

0

Log txn only on 
change

LogTxnChgOnly Boolean Log transaction only when there is 
a net change in assignment (for 
example, sales team updated).

TRUE

Maximum MT Servers MaxMTServers Integer Maximum number of active 
servers for a multithreaded 
service.

1

Maximum Tasks MaxTasks Integer Maximum number of running tasks 
for a service.

2

Minimum MT Servers MinMTServers1

1. Applies only to the assignment server and other multithreaded request-based servers.

Integer Minimum number of active servers 
for a multithreaded service.

1
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■ Maximum MT Servers. This parameter controls the maximum number of Assignment Manager 
server processes that are running at any time (when MaxMTServers > MinMTServers). Generally, 
the default value is sufficient for most deployments as server processes and Assignment Manager 
have large resource requirements.

■ Maximum Tasks. This parameter controls the maximum number of server threads that can run 
at any time. For Assignment Manager, this controls the maximum number of assignments that 
can be processed concurrently. The value of this parameter should be set to the maximum 
anticipated concurrent requests (dependent on your server�s capabilities).

■ Minimum MT Servers. This parameter controls the number of Assignment Manager server 
processes that are started when the Siebel servers starts up. If this value is set to zero, 
Assignment Manager is disabled. It is recommend to use the default value of one, as server 
processes and Assignment Manager have large resource requirements.

Configuring Assignment Manager Event Logs
Before running Assignment Manager, you can configure event logs to view results. The Assignment 
Manager, Batch Assignment, and Workflow Monitor Agent server components are configured to use 
events. For information on event logging and log files, see System Monitoring and Diagnostics Guide 
for Siebel eBusiness Applications.

NOTE: The Trace Flags and Error Flags parameters are no longer used with Assignment Manager. 

In addition to the events used for other server components, the Assignment Manager, Batch 
Assignment, and Workflow Monitor Agent server components use specific events to log information 
related to assignments:

■ Rules Evaluation (Match). Logging of events during the evaluation phase

■ Object Assignment (Assign). Logging of events during the assignment phase.

■ Loading (Loading). Logging of events that happen during loading.

■ Assignment Manager Generic (Generic). Generic events specific to Assignment Manager.

There are five levels in each of the events:

■ Level 0: Used for fatal errors

■ Level 1: Used for nonfatal errors and warnings

■ Level 2-4: Used for different levels of logging detail

■ Level 5: Used for detailed debug information

Assignment Manager uses two events for logging information when assigning object rows. For the 
evaluation phase, Assignment Manager uses the Rules Evaluation (Match) event. The following levels 
of information are logged for each level:

■ Level 2 - Object row-level logging

■ Level 3 - Rule-level logging

■ Level 4 - Criterion-level logging
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■ Level 5 - Criterion value-level logging

NOTE: As of version 7.7, level 5 is necessary for you to see detailed criteria value-level logging.

For the assignment phase, Assignment Manger uses the Object Assignment (Assign) event. The 
following levels of information are logged for each level:

■ Level 2 - Object row-level logging

■ Level 3 - Passing rules-level logging

■ Level 4 - Passing candidates-level logging

NOTE: You can set the log level of both event types to print a list with combined results. However, 
when assigning too many objects, these settings may create extremely large log files. 

To set the log level of Assignment Manager events

1 From the application-level menu, choose Navigate > Site Map > Administration - Server 
Configuration > Servers > Events.

2 In the Components list, select the Assignment Manager, Batch Assignment, or Workflow Monitor 
Agent component, depending on which component you want to set a log level; make sure the 
selected component is running on the correct server.

3 In the Log Level field in the Events list, adjust the values as required by your implementation as 
follows:

a Select Rules Evaluation; type in 3 if you want to print a list of assignment rules that were 
evaluated

b Select Object Assignment; type in 3 if you want to print a list of evaluated assignment rules that 
passed

For more information on configuring event logs, see System Monitoring and Diagnostics Guide for 
Siebel eBusiness Applications.
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Server Administration Requirements for Assignment 
Modes
Assignment Manager requires various functioning server components and tasks based on the 
selected assignment mode. Table 32 summarizes the required server components and tasks that 
must be online or started when selecting a particular mode of assignment. When Mobile Assignment 
is selected, use the information provided for either interactive or batch assignment based on your 
deployment requirements. Detailed information on starting these components and tasks is covered 
in the remainder of this chapter.

Server Administration Requirements After 
Configuration
After configuring Assignment Manager objects and attributes or altering assignment policies, it is 
often necessary to stop and restart various server tasks and components. Table 33 summarizes the 
required server tasks and components that must be restarted based on the type of configuration 
process. For further information on Assignment Manager configuration, see Chapter 4, �Assignment 
Object Configuration.� Detailed information on how and when to run these server tasks and 
components is provided in the remainder of this chapter. 

Table 32. Summarization of Server Requirements for Assignment Modes

Assignment Mode
Set Assignment 
Manager Online

Start Workflow 
Monitor Agent

Start Server 
Request Broker1 

1. For dynamic and batch assignment, you do not need to start the Server Request Broker when running your tasks using the 
SRVRMGR command-line interface (or an alternate method, such as setting Default Tasks for the server component).

Interactive Mode Yes No Yes

Dynamic Assignment Mode No2 Yes No2 

2. This information is based on the default �Assignment Request (In Process)� seeded action.

Batch Assignment Mode No No No

Table 33. Summary of Server Administration After Configuration

Configuration Process

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart 
Workflow 
Monitor Agent

Adding or configuring an assignment object, 
assignment attribute, or assignment criteria

Yes Yes Yes

Changing assignment policies No Yes Yes

Activating or deactivating assignment policies No Yes Yes
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Running Assignment Manager in 
Interactive Mode
This topic explains how to run Assignment Manager in interactive mode. Use interactive assignment 
to assign people in real time. The Activity and Service Request objects are predefined to use 
interactive assignment. This feature allows you to assign employees to activities and service requests 
in real time by clicking the Menu button and choosing Assign. You can also configure other 
assignment objects to use interactive assignment. For more information on interactive assignment, 
see �About Interactive Assignment� on page 44. For more information on configuring assignment 
objects, see �Configuring Assignment Objects� on page 92.

You can run interactive assignment using the Siebel Dedicated Web Client, the Siebel Web Client 
(also known as zero footprint client), or the command-line SRVRMGR utility. The following 
subsections explain how to run interactive assignment for these environments:

■ �Running Interactive Assignment for a Service Request�An Example� on page 171

■ �Running Interactive Assignment Using the Command-Line SRVRMGR Utility� on page 174

NOTE: Before running interactive assignment using the Siebel Dedicated Web Client, it is 
recommended that you verify that the correct parameter settings exist in your Siebel client 
configuration (.cfg) file. The parameters identified in this configuration file specify the location of the 
Siebel Server where Assignment Manager is running and are automatically created during installation 
of the Siebel client. For information about the Siebel client installation process and configuration file, 
see the Siebel Server Installation Guide for the operating system you are using. 

Interactive assignment requires that the:

■ Assignment Manager server component is Online

■ Server Request Broker server component is Running

You are now ready to run interactive assignment. For an example, see �Running Interactive 
Assignment for a Service Request�An Example.�

Running Interactive Assignment for a Service Request�
An Example
The Activity and Service Request assignment objects are predefined to use interactive assignment. 
The following procedure is an example of running interactive assignment for service requests and is 
applicable for use with the Siebel Dedicated Web Client as well as the Siebel Web Client.

To run interactive assignment for a service request

1 From the application-level menu, choose Navigate > Site Map > Service Requests > All Service 
Requests.

2 In the Service Requests list, select an open Service Request for assignment.

3 In the More Info form, click the Menu button and select Assign to start interactive assignment.
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4 Choose an assignee from the list of best candidates provided by Assignment Manager.

The Siebel client:

■ Communicates with the Siebel Assignment Manager on the Siebel Server and creates a list of 
qualified employees for the service request.

■ Displays the list of qualified employees to the Siebel user, sorted by the descending order of 
scores.

■ Sets the service request owner to the employee that you choose.

Assignment Manager Integration
You can make assignments by invoking Assignment Manager from within a Siebel workflow process, 
business service, or Siebel script interface. 

Assignment Manager provides the ability of sharing inputs and outputs (supports rerouting of 
objects) with an external component. Assignment Manager can return qualified or assigned 
candidates along with their scores in the form of a hierarchical property set. A property set is a set 
of name-value pairs that are used by various Siebel components to pass information back and forth 
between them.This feature is particularly useful in a workflow process. For example, a business 
service step in a workflow process might call on Assignment Manager (with the assignment mode set 
to Match) to evaluate potential candidates and return the set of qualified candidates in a property 
set along with their scores. Then, the workflow process can, based on other business logic, decide 
the set of candidates that are assigned. 

TIP: Prior to the version 7.7 release, Assignment Manager could only write qualified or assigned 
candidates to the database.

Assignment Manager integration behavior is controlled by the ReturnPropSet request-level server 
parameter (ReturnPropSet). Table 34 lists the conditions for which Assignment Manager returns a 
property set or writes the results to the database.

Table 34. ReturnPropSet Server Parameter Behavior

AsgnMode Writes to Database Returns Property Set

Synchronous:

Match

If ReturnPropSet is FALSE, writes to database No property set returned

If ReturnPropSet is TRUE, does not write to 
database

Qualified candidates 
returned

Assign Writes to database No property set returned

MatchAssign Writes to database If ReturnPropSet is TRUE

Asynchronous Writes to database No property set returned
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Figure 25 illustrates the structure of the output property set that Assignment Manager returns from 
a synchronous request, given the input parameter AsgnMode = Match or MatchAssign.

Figure 25. Example of Output Property Set Structure Returned from a Synchronous Request
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Running Interactive Assignment Using the Command-
Line SRVRMGR Utility
 Interactive assignment uses the Assignment Manager (AsgnSrvr) server component to make 
assignments. Assignments can also be made to object rows using the Assignment Manager 
(AsgnSrvr) component from the command-line interface using the AsgnSrvr command and the 
parameters in Table 35. The command-line interface of the Server Manager is the srvrmgr program. 
For more information on using the command-line interface, see Siebel System Administration Guide. 

Table 35. Interactive Assignment Command-Line Interface Parameters

Parameter 
Name Display Name Description

Default 
Value

AllowDupPostn Allow Duplicate 
Position

Allows assignment of duplicate positions to 
the team

For more information, see �AllowDupPostn� 
on page 188.

FALSE

AsgnKey Assignment Key Rule set used for key-based routing

For more information, see �AsgnKey� on 
page 188.

All AM Rule 
Set

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign before 
committing results (transaction) to the 
database.

100

EventDate Event Date Date of the event that caused this 
assignment request

IgnoreCache Ignore assignment 
rule cache

Ignore assignment rule cache and read 
from the database

FALSE

LogTxnChgOnly Log txn only on 
change

Log transaction only when the assignment 
has changed

TRUE

MaxSkillsAge Refresh people 
skills interval

Interval in which people skills are refreshed 
in seconds (must be greater than zero 
seconds).

NOTE: This parameter is only applicable to 
interactive assignment.

0
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Running Assignment Manager in 
Dynamic Mode
Use dynamic assignment if you want to reassign people when changes are made to the assignment 
object rows or new records are created. As other users and server programs make changes to the 
assignment object records, dynamic assignment automatically assigns the objects to the appropriate 
people and organizations.

This topic explains how to run Assignment Manager in dynamic mode. The subtopics are:

■ �Generating Triggers for Dynamic Assignment� on page 176

■ �Generating Triggers Using the Command-Line SRVRMGR Utility� on page 178

■ �Running Workflow Monitor Agents� on page 178

■ �Activating Assignment Policies� on page 180

■ �Assignment Manager Performance in Dynamic Mode� on page 183

To run dynamic assignment, make sure: 

■ Generating Triggers is enabled

■ Workflow Monitor Agent is running

■ Assignment policies are set and activated

NOTE: For performance reasons, do not run dynamic assignment when running batch assignment.

You must run Generate Triggers to create triggers that monitor changes in the database.

The triggers created by the Generate Triggers server component detect changes in the Siebel 
database and trigger the Workflow Monitor Agent to alert the Assignment Server. However, triggers 
generated for Assignment Manager can reference other database columns not associated with 
assignment rules. It is important to make sure that triggers are generated only for an assignment 
policy�s criteria. Large data loads can experience performance issues otherwise.

ObjWhereClause Object Where 
Clause

SQL WHERE clause that identifies the 
object rows from the assignment object 
primary table to be assigned.

For more information, see 
�ObjWhereClause� on page 188.

UseForUpdate Use FOR UPDATE If TRUE, Assignment Manager uses the FOR 
UPDATE SQL clause to lock primary table 
rows so that, during evaluation and 
assignment, no other process or user can 
make changes to this row. 

TRUE

Table 35. Interactive Assignment Command-Line Interface Parameters

Parameter 
Name Display Name Description

Default 
Value
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To check and edit triggers

1 Use Siebel Tools, or view the trigger.sql file (/Siebel Root/Siebsrvr/trigger.sql), to examine the 
appropriate table columns.

For more information about using Siebel Tools, see Using Siebel Tools.

2 Disable the inappropriate columns by inactivating the assignment attribute column.

For detailed information, see �Disabling an Assignment Attribute� on page 117.

NOTE: If you inactivate only the assignment attribute column and leave the assignment attribute 
and assignment criteria active, then the assignment criteria appears in the user interface in the 
assignment administration views, which means you can create assignment rules based on that 
criteria. The following is the result of this action based on whether or not the Employee Skill field 
is checked:

� If the Employee Skill field is checked, then the assignment criteria is skill-based and, as such, 
should continue to work for assignment rules. For example, the criteria works if you run batch 
assignment because that mode does not rely on triggers.

� If the Employee Skill field is not checked, then the assignment criteria is object-based, and as 
such, relies on a valid assignment attribute column configuration. If you attempt to create 
assignment rules, you get an error message when the task is run.

3 Drop and regenerate new triggers (see the following section, �Generating Triggers for Dynamic 
Assignment�).

4 Recheck the trigger.sql file, to confirm that the trigger is no longer active. 

NOTE: When dynamic assignment is running, some users may receive the following error when 
attempting to modify a record: �The selected record has been modified by another user since 
it was received. Please continue.� This may occur because Assignment Manager updated the 
record by assigning it while the user was trying to edit it. In this situation, the user�s changes may 
be lost. The solution is to refresh the query and reenter the user�s changes. 

Generating Triggers for Dynamic Assignment
To run dynamic assignment, you need to run the Generate Triggers server component after:

■ Creating or changing an Assignment Object, Assignment Attribute, or Assignment Criteria object 
type in Siebel Tools

■ Changing assignment policies

■ Installing or upgrading the Siebel Server

NOTE: When amending an assignment rule, criteria, or value, or when making changes to 
assignment positions in dynamic mode, you do not have to drop and then regenerate database 
triggers. 
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Use the Generate Triggers server component to generate the database triggers used by Workflow 
Manager to detect changes in the database. For more information about starting and using Generate 
Triggers, see Siebel Business Process Designer Administration Guide. 

NOTE: You cannot create custom triggers on the Siebel database. The only supported triggers 
allowed on the Siebel database are those generated during installation or from running the Generate 
Triggers server component. 

To run Generate Triggers

1 From the application-level menu, choose Navigate > Site Map > Administration - Server 
Management > Jobs.

2 In the Jobs list, click New.

A new record appears with a system-defined ID automatically generated with a status of 
Creating.

3 In the Job Detail subview, enter the relevant information for the new component request record.

a In the Requested Server field, type the name of the Siebel Server for which you want to run 
Generate Triggers.

b In the Request Key field, type in the name of the request key.

c Complete the rest of the fields, if needed.

4 In the Job Parameters list, click New to create a new record for the Privileged User, and enter the 
relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for PrivUser, and then click OK.

c In the Value field, type in the privileged user name.

NOTE: If you are using a Microsoft SQL Server database, you need to set the Privileged User 
Password value to the user password with tableowner privileges. Also make sure that the Table 
Owner value is set to dbo.

5 In the Job Parameters list, click New to create a new record for the Privileged User Password, 
and enter the relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for PrivUserPass, and then click OK.

c In the Value field, type in the privileged user password.

6 For the Microsoft SQL Server database, run the generated trigger.sql file against the database 
independently. 

a Select EXEC.

b Click in the Value field.
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c Type FALSE.

NOTE: If the EXEC parameter is set to TRUE, the Generate Trigger component automatically 
creates the SQL script and applies it to the server database.

Also, if you are creating a large number of triggers because there are too many workflow policies, 
the triggers should be applied by the user and not by the Generate Triggers server process. The 
EXEC parameter should be set to FALSE in this case.

For more information on the EXEC parameter, see Siebel Business Process Designer 
Administration Guide.

7 In the My Component Requests form, click the Menu button, and then click Submit request.

Generating Triggers Using the Command-Line SRVRMGR 
Utility
Triggers can be generated using the SRVRMGR command-line interface GenTrig command and the 
parameters in Table 36. The command-line interface of the Server Manager is the srvrmgr program. 
For more information on using the command-line interface, see Siebel System Administration Guide.

Running Workflow Monitor Agents
To run dynamic assignment, the Workflow Monitor Agent needs to be running. This server component 
monitors the S_ESCL_REQ table. Database triggers, when fired because of object changes, create 
records in the S_ESCL_REQ table. The Workflow Monitor Agent reads these new records and 
processes requests for Assignment Manager policies. Affected objects are then dynamically assigned. 
For more information about Workflow Monitor Agent, see Siebel Business Process Designer 
Administration Guide. 

NOTE: Dynamic assignment does not log information into S_ESCL_LOG. For more information about 
log files, see System Monitoring and Diagnostics Guide for Siebel eBusiness Applications.

Table 36. GenTrig Command-Line Interface Parameters

Parameter 
Name Display Name Description

Default 
Value

EXEC EXEC Install Triggers to DB directly FALSE

Mode Mode Assignment Server and/or Workflow mode 
(ASGN, WORK, or ALL)

ALL

Remove Remove Remove All Triggers Mode FALSE

TAMode TAMode All Territory or Contact Only mode ALL

TrigFile Trigger File Name Output trigger script file name trigger.sql
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To start Workflow Monitor Agent from the command-line interface

1 Determine the workflow group that you want Workflow Monitor Agent to monitor. 

a From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies. 

b In the Policy Group field in the Assignment Policies list, choose the workflow group (the default 
group is Assignment Group).

2 Start the srvmgr program. 

For detailed information on this process, see Siebel System Administration Guide. After the 
program starts, the prompt changes to:

srvmgr: server_name>

3 At the prompt, enter the following information to start the Workflow Monitor Agent server 
component task; use the Group information gathered from Step 1 (Assignment Group used in 
this example):

start task for component workmon with GroupName=�Assignment Group�

4 Configure other component parameters, if needed.

For more information about other configurable parameters, see Table 37 on page 179.

NOTE: Separate the parameters and their values in the command-line statement with commas.

5 Alternatively, you can configure a Workflow Monitor Agent to start automatically to process 
assignment requests whenever the Siebel Server starts. 

For detailed information, see Siebel Business Process Designer Administration Guide. 

This command starts a new task running in the background and returns to the Server Manager 
immediately. For detailed information on starting, stopping, and monitoring server tasks, see Siebel 
System Administration Guide. For further information about the Workflow Monitor Agent, see Siebel 
Business Process Designer Administration Guide. 

NOTE: It is possible to set up multiple Workflow Monitor Agents for dynamic assignment. For more 
information, see the �Monitoring and Tuning Performance� section of Siebel Business Process 
Designer Administration Guide.

Table 37 shows the Workflow Monitor Agent command-line interface parameters.

Table 37. WorkMon Command-Line Interface Parameters

Parameter Name Display Name Description
Default 
Value

ActionAgent Use Action Agent Use Action Agent FALSE

ActionInterval Action Interval Do not re-execute actions within 
specified interval in minutes

3600

BatchMode Processes the batch 
policies

Process the batch Policies FALSE
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Activating Assignment Policies
Siebel applications include predefined assignment policies for each of the predefined assignment 
objects. You should use these predefined assignment policies. However, you can create new 
assignment policies for dynamic assignments.

Each Workflow Monitor Agent can monitor one or more assignment policies. You can use a single 
Workflow Monitor Agent to monitor all assignment policies by placing all assignment policies in the 
same workflow group (the predefined assignment policies are defined this way). You can also place 
the assignment policies in separate workflow groups and dedicate Workflow Monitor Agents for each 
workflow group.

The Assignment Manager workflow policy actions you can use for an assignment policy are:

■ Assignment Request (In Process). This action assigns rows in its own process and does not use 
the AsgnSrvr server component.

CheckLogCacheSz Cache size of Policy 
violations

Number of policy violations to store in 
cache

100

DeleteSize Request delete size Request delete size 500

GenReqRetry Number of seconds to 
retry

Number of seconds to retry sending a 
Generic Request message

120

GroupName Group Name Group Name

IgnoreError Ignore errors Ignore errors while processing requests FALSE

KeepLogDays Number of days to 
keep violation 
information

Number of days worth of violation 
information that should be retained

30

LastUsrCacheSz Cache size of last user 
information

Number of last user information items to 
cache

100

MailServer Mail Server Name of email server to send notification 
of abnormal termination

MailTo Mailing Address Mail address to review notification of 
abnormal termination

ReloadPolicy Reload Policy Reload Policy Interval in seconds 86400

Requests Requests per iteration Requests per iteration 5000

SleepTime Sleep Time Time to sleep between iterations (in 
seconds). This is the frequency of time 
the Workmon Agent polls the escalation 
request table and assigns rows.

60

Table 37. WorkMon Command-Line Interface Parameters

Parameter Name Display Name Description
Default 
Value
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■ Assignment Request. This action routes the requests to an AsgnSrvr process running in default 
mode. 

CAUTION: It is recommended that you use the Assignment Request (In Process) workflow policy 
action because the Assignment Request action might cause performance problems. If you do choose 
to use the Assignment Request action, make sure the AsgnSrvr process is available and online. 

If you want to use the rule group feature in dynamic assignment, create a workflow process that 
submits requests to AsgnSrvr using a business service.

CAUTION: Assign a workflow policy group to only one Workflow Monitor Agent. Multiple Workflow 
Monitor Agents running the same workflow policy group cause unpredictable completion times and 
possible multiple actions created for one trigger. For more information, see Siebel Business Process 
Designer Administration Guide. 

Also, you should not associate customized workflow actions with assignment policies. For more 
information about workflow actions, see Siebel Business Process Designer Administration Guide. 

To enable dynamic assignment for an assignment object, activate the assignment policy for that 
object. To disable dynamic assignment for an assignment object, deactivate the assignment policy 
for that object.

The rest of this section explains how to activate, deactivate, set the workflow group for, and create 
actions for assignment policies. The procedures are: 

■ �To set the workflow group for assignment policies� on page 181

■ �To activate an assignment policy� on page 181

■ �To deactivate an assignment policy� on page 182

■ �To create an action for an assignment policy� on page 182

NOTE: After activating, deactivating, or creating an action for an assignment policy, you must 
generate triggers again for the changes to take effect.

To set the workflow group for assignment policies

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want to set the 
workflow group.

3 In the Group field, click the select button.

4 In the Workflow Groups dialog box, select a workflow group (the default is Assignment Group), 
and then click OK. 

To activate an assignment policy

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to activate.
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3 In the Expiration field, click to either null the existing value or set the value to a later date.

Workflow components process only active assignment policies that have not expired. 

To deactivate an assignment policy

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to deactivate.

3 In the Expiration field, set the value to a date that has already passed.

Workflow components process only active assignment policies that have not expired; therefore, you 
can deactivate an assignment policy by expiring it.

CAUTION: By default, every assignment policy has an action. Use the following procedure only if 
you accidentally remove an action or create a new assignment policy. 

To create an action for an assignment policy

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want to create an 
action.

3 In the Actions list, click New.

4 In the new record, enter values for the relevant information.

a In the Assignment Action field, click the drop-down arrow and select Assignment Request (In 
Process).

b In the Assignment Mode field, click the down-arrow button and select MatchAssign.

Activating Contact Denormalization
Perform the following procedure to activate contact denormalization. The policy is inactivated by 
default.

NOTE: When Assignment Manager runs in Contact Denormalization mode, it does not evaluate 
assignment rules. Therefore, you do not need to select the Contact Denormalization object for the 
assignment rule to run Assignment Manager in Contact Denormalization mode.

To activate contact denormalization

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Assignment Policies.

2 In the Assignment Policies list, select Contact Denormalization, and then perform the following:

a In the Group field, click the select button.
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b In the Workflow Groups dialog box, select a workflow group (the default is Assignment Group), 
and then click OK.

c In the Expiration field, either clear the existing value or set the value to a later date.

3 In the Actions list, click New to create a new record and enter the relevant information.

a In the Assignment Action field, click the drop-down arrow and select Assignment Request (In 
Process).

b In the Assignment Mode field, click the down-arrow button and select Denorm.

NOTE: Dynamic assignment can refresh employee, position, and organization skills from the 
database if changes were made to these items. The program argument, MaxSkillsAge, forces 
Assignment Manager to reload this information if activated. By default, this argument is not set. In 
Siebel Tools, select the Assignment Request (In Process) workflow policy program to change the 
MaxSkillsAge argument. For information about how to set this parameter using command-line 
interface, see �Running Interactive Assignment Using the Command-Line SRVRMGR Utility� on 
page 174. 

Assignment Manager Performance in Dynamic Mode
If users experience slow response time while running Assignment Manager in dynamic mode, you 
can implement one or more of the following to improve dynamic assignment performance:

■ Increase the Requests (Requests per iteration) workflow monitor parameter (the default is set to 
5,000).

■ Decrease the DeleteSize workflow monitor parameter (the default is set to 500).

■ Decrease the SleepTime workflow monitor parameter (the default is 60 seconds).

■ Increase the ReloadPolicy workflow monitor parameter to a much larger number, for example, 
86,400 seconds (the default is 600 seconds).

■ Distribute each assignment policy into its individual group and then invoke several Workflow 
Monitor Agents concurrently (one on each Siebel Server, if available).

Running Assignment Manager in Mobile 
Mode
This section includes procedures to run Assignment Manager in mobile mode. Use Mobile Assignment 
to reassign people based on changes uploaded by mobile clients. Assignment Manager assigns 
objects after a mobile client synchronizes with the Siebel Server and uploads assignment requests 
or any changes to objects and assignment rules. Depending on the configuration of Generate 
Triggers, the Workflow Monitor detects these changes and activates Assignment Manager to 
dynamically reassign affected objects. For more information, see �About Mobile Assignment� on 
page 45.

NOTE: If a disconnected client sends an assignment request to the Siebel Server while running 
Mobile Assignment, the request is sent as an asynchronous request. Because of this, the request 
does not override the Keep Manual Assign flag.
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To run Mobile Assignment

1 Be sure that you have run the Generate Triggers server component. 

For instructions, see �Generating Triggers for Dynamic Assignment� on page 176.

2 Start the Workflow Monitor Agent. 

For instructions, see �Running Workflow Monitor Agents� on page 178.

3 Start the Server Request Broker server component (if running interactive assignment). 

For instructions, see Siebel System Administration Guide.

Running Assignment Manager in Batch 
Mode
This topic explains how to run Assignment Manager in batch mode. Typically, you want to run batch 
jobs periodically when you anticipate the least amount of database activity (such as daily or weekly 
after-hours).

Use batch assignment to assign an assignment object in a single batch. You must run Assignment 
Manager in batch mode if you change non-object data that can affect assignments. This happens 
whenever you:

■ Modify assignment rules and want these changes to affect existing objects. You modify 
assignment rules when you:

■ Add or remove employees, positions, or organizations

■ Add, remove, or update assignment criteria or criteria values

■ Associate a rule with a different rule group or change the rule sequence number

■ Change scores

■ Change activation and expiration dates

■ Change exclusive mode

■ Modify the list of employees, positions, or organizations and you want these changes to affect 
existing objects. You modify the list of employees, positions, or organizations when you:

■ Add new employees, positions, or organizations (if you use assignment rules with the All 
People setting)

■ Change skills of employees, positions, or organizations (these values are cached in memory)

■ Change the Assignment Manager configuration in Siebel Tools and you want your changes to 
affect existing objects. You change the Assignment Manager configuration when you:

■ Change Assignment Attribute definitions

■ Change Assignment Criteria definitions

■ Change Assignment Object definitions

■ Change Workflow Policy Object definitions
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■ Use EIM (Enterprise Integration Manager) to perform initial loads (if you do not run Generate 
Triggers to create the appropriate triggers).

NOTE: When using EIM to load assignment rules, make sure the column ASGN_TYPE_CD 
includes a value. If it is left NULL, which is permissible in EIM, the rules are loaded but 
Assignment Manager fails. 

■ Feel that existing assignments may not be accurate. Assignment Manager does not change 
assignments if the existing assignments are correct.

NOTE: When batch mode is run on correct assignments, although there are no changes to the 
team or primary, an update of the record occurs. This situation can disturb other workflow 
policies relying on various record fields. For example, a workflow policy relying on PR_POSTN_ID 
field to trigger an action does not work properly if this field is updated from a new batch 
assignment. If your deployment uses SQL Server, this note does not apply. 

If you run both batch assignment and batch assignment in your environment, the batch assignment 
can activate batch assignment due to triggers created in the database required to run batch 
assignment. Before running batch assignment, you should deactivate all assignment policies and 
drop related triggers to prevent batch assignment from processing modified rules, objects, and 
candidates. For more information, see �To deactivate an assignment policy� on page 182 and �To run 
Generate Triggers� on page 177. After completing batch assignment, you can activate the assignment 
policies and re-enable batch assignment. For more information on batch assignment, see �About 
Batch Assignment� on page 45. For more information, see �To activate an assignment policy� on 
page 181.

NOTE: For performance reasons, do not run dynamic assignment while running batch assignment.

You can have a batch assignment task load only a particular group of rules into memory by specifying 
the ROW ID of the rule group in the Assignment Key parameter when you start the task. If no rule 
group is specified for this parameter, the batch task loads all rules in the Default Group into memory. 
If no rule groups have been defined in the application, then all active rules in the database load. For 
more information, see �About Assignment Rule Groups� on page 22.

To run batch assignment 

1 From the application-level menu, choose Navigate > Site Map > Administration - Server 
Management > Jobs.

2 In the Jobs list, click New.

A new record appears with a system-defined ID automatically populated with a status of 
Creating.

3 In the new record, enter the relevant information for the new job.

a In the Component/Job field, select Batch Assignment.

b In the Server field, type the name of the server on which you want to run this batch request.

c Optionally, if you want to run a specific rule group for this batch, type the row Id of the 
assignment rule group for which you want rules processed for the AsgnKey parameter. 

d Complete the rest of the fields for the new record, if needed.
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4 In the Job Parameters list, click New to create a new record, and enter relevant information for 
the assignment object that you want to assign as part of this batch request.

a In Name field, click the select button.

b In the Job Parameters dialog box, select Assignment Object Name, and then click OK.

c In the Value field, enter the name of the assignment object for the parameter.

Use the exact name found in Siebel Tools, such as Service Request or Order (Sales Credit 
Assignment). 

NOTE: Because batch assignment cannot run more than one assignment object per batch, you 
should run batch assignment on only one assignment object for each batch.

5 While still in the Job Parameters list, click New to create a new record so that Assignment 
Manager uses the Object WHERE clause to limit the number of rows processed at one time.

a In Name field, click the select button.

b In the Job Parameters dialog box, query for ObjWhereClause, click Go, and then click OK.

c In the Value field, enter a WHERE clause to select the object instance that you want to process; 
the WHERE clause can include up to 100 characters.

For example, to select object instances beginning with ibm, type:

WHERE name like �ibm%� 

NOTE: If you leave the value field blank, all object instances are selected. However, it is 
strongly recommended that you limit the number of rows that Assignment Manager 
processes to make sure that sufficient rollback space is available.

For more information about using the Object WHERE clause, see Table 38 on page 187 and further 
description following the table.

6 Optionally, if you want to enable Contact Denormalization for batch assignment, add two more 
component request parameter records with 
values from the following table:

7 Optionally, if you want to save changes to the database during batch processing, add another 
component request parameter as follows:

a In Name field, click the select button.

b In the Job Parameters dialog box, query for Batch Size, and then click Go.

c In the Value field, enter the number of objects to assign before committing each batch.

8 In the My Component Requests form, click the menu button and choose Submit request.

Parameter Name Value

Assignment Object Name Contact Denormalization

Assignment Mode Denorm
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Running Batch Assignment Using the Command-Line 
SRVRMGR Utility
Batch assignment can be run from the command-line interface using the AsgnBatch command and 
the parameters in Table 38. The command-line interface of the Server Manager is the srvrmgr 
program. For more information on using the command-line interface, see Siebel System 
Administration Guide.

Additional Parameter Characteristics
The following bulleted points provide additional information about some of the parameters shown in 
Table 38 on page 187.

Table 38. Batch Assignment Command-Line Interface Parameters

Parameter 
Name Display Name Description

Default 
Value

AllowDupPostn Allow Duplicate 
Position

Allows duplicate positions.

For more information, see 
�AllowDupPostn� on page 188.

FALSE

AsgnKey Assignment Key Used to specify a particular rule group 
for a batch assignment task.

For more information, see �AsgnKey� 
on page 188.

All AM Rule 
Set

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign before 
committing for batch assignment

100

EventDate Event Date Date of the event that caused this 
assignment request

IgnoreCache Ignore Assignment 
Rule Cache

Ignore assignment rule cache and read 
from the database

FALSE

LogTxnChgOnly Log txn only on change Log transaction only when the 
assignment has changed

TRUE

ObjWhereClause Object Where Clause WHERE clause of the object for batch 
assignment

For more information, see 
�ObjWhereClause� on page 188.

UseForUpdate Use FOR UPDATE Use FOR UPDATE to lock primary table 
row

TRUE
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■ AllowDupPostn

When this parameter is set to TRUE (set to FALSE by default), Assignment Manager attempts to 
insert duplicate positions (positions with the same id) in the team table, given these positions do 
not violate the user key constraints of the table. The third field of the PositionTeamDenorm (Y, N 
value) user property specifies which destination columns are part of the user key. Assignment 
Manager checks whether or not positions with the same Id that pass violate the uniqueness of 
these key columns. If Assignment Manager detects a violation, the position with the lower score 
is ignored. Otherwise, Assignment Manager inserts both positions in the team table. 

If Assignment Manager detects a violation, only the first position encountered is inserted and the 
other is ignored.

■ AsgnKey

The AsgnKey parameter is the row Id of the assignment rule group that is associated with the 
rules you want to evaluate. The default value of the parameter is All AM Rule Set, in which case 
all active rules are evaluated.

■ ObjWhereClause

Standard SQL WHERE statements are used for the Object WHERE Clause and can include up to 
2048 characters when a batch assignment server task is started using the command-line 
interface. However, when you start a batch assignment server task from the Component 
Requests screen, you can only specify up to 100 characters. Also, when using wildcards in the 
object WHERE clause, make sure you use the correct wildcard specific to your database.

The Object WHERE Clause can be used to restrict which records are retrieved and processed in 
batch assignment. The following conditions apply:

■ Joins are allowed in the Object WHERE Clause. 

An example of a join is as follows:

Assignment Object = Account

Object Where Clause = where pr_postn_id in (select row_id from s_postn where name 
= 'Sales Rep') 

The Object WHERE Clause assumes the base table is coming from the assignment object 
specified. 

For example, if you start batch assignment specifying the assignment object as Account and 
the Object Where Clause is where row_id = '1-232', then batch assignment attempts to 
assign only the row_id = '1-232' from the S_ORG_EXT table.

The following is an example of a batch assignment using the command-line interface:

start task for component AsgnBatch with AsgnObjName= �Account�, 
AsgnMode=�MatchAssign�, ObjWhereClause=�where name like 'B%'�

This command batch assigns accounts starting with B. 

Optionally, you can use the command-line interface and the Object WHERE Clause to run only 
a select number of assignment rule groups. The following is an example of this:
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start task for comp asgnbatch with asgnobjname="Account", objwhereclause="where 
name like 'B%'", asgnkey="12-4DR56"

In this example, 12-4DR56 is the row Id of an assignment rule group, and only those rules 
belonging to this group are evaluated when this parameter is passed in the request.

NOTE: When using the command-line interface, use double quotation marks for the 
ObjWhereClause parameter; otherwise, it is treated as a SRVRMGR command option that 
changes the case.

Assignment Manager Performance in Batch Mode
If users experience slow response time while running Assignment Manager in batch mode, review 
the settings on virus software installed on the applicable server. Implement one or more of the 
following settings to improve batch assignment performance.

■ Virus scan only program files.

■ Exclude all outbound files from virus scanning.

■ Exclude the RDBMS directory where all msb files are located from virus scanning.

Make sure to run a full virus scan on all files during the weekend or off-peak time if the preceding 
settings were used.

You can also implement one or more of the following to boost batch performance in batch mode:

■ Increase the BatchSize parameter, for example, set the batch size to 500 (the default is set to 
100).

This increases the number of records that are processed within a transaction before a commit 
occurs, resulting in less resources used and faster assignment.

NOTE: Only set large batch sizes when there are no or very few users on the system.

■ Create multiple instances of batch assignment (using WHERE clause statements). See �Running 
Multiple Instances of Assignment Manager in Batch Mode� on page 190.

■ Select a good filter.

This reduces the time it takes to retrieve Object records.

NOTE: Use indexed field or fields for comparison in the object WHERE clause, such as Name for 
Account and Opportunity, or Last Name for Contacts.
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■ Use better logic.

For example, if you want to run Account Assignment based on account name, you can create 
multiple batches so that the first batch starts with names beginning with the letter C through K, 
the second batch starts with the letter L through R, and so on. 

Consider the following logic:

Object Where Clause: WHERE NAME > �B� AND NAME < �L�

Although this causes the database to retrieve account records with names starting with the letter 
C through K, the WHERE clause is specified in such a manner that if accounts starting with the 
letter M through Z are encountered, they are passed on the first round because the values are 
> B. They are then eliminated in the second round (< �L�) by the database. These records are not 
needed in the batch because there is a cap of account names less than L.

It is better logic to use:

Object Where Clause: WHERE NAME < �L� AND NAME >�B�

By switching the order of the conditions, the extra parsing required by the database in the second 
round is eliminated because most of the names start with a letter greater than B.

Running Multiple Instances of Assignment Manager in 
Batch Mode
When there are many objects that need to be assigned, you can run multiple instances of Assignment 
Manager in batch mode to improve performance. First, develop a strategy for specifying multiple 
batches using the Object Where Clause parameter in the Batch Assignment component. Then, start 
multiple instances of batch assignment specifying the appropriate Object Where Clause for each 
instance.

For example, you can run one instance of batch assignment for accounts that changed today and a 
different instance of batch assignment for accounts that changed yesterday. Use the Object Where 
Clause parameter to specify the following:

■ For the batch that processes accounts changed today: 

Object Where Clause: WHERE LAST_UPD = SYSDATE

■ For the batch that processes accounts changed yesterday:

Object Where Clause: WHERE LAST_UPD = SYSDATE - 1

To process mutually exclusive sets of records when running multiple instances of Assignment 
Manager simultaneously for the same assignment object, you should specify an Object Where Clause 
for each assignment task. You can also distribute the tasks on multiple Siebel Servers to enhance 
performance. For more information about the Object Where Clause parameter, see �ObjWhereClause� 
on page 188.

There are several instances where you should not run multiple simultaneous batch jobs:

■ If multiple Assignment batches are executed for the same object, then the results can potentially 
vary and may not be as desired
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■ If the batch jobs update rows on the same table or tables

■ If one batch job updates records in a table or tables used by another batch job as input

■ If the batch jobs use workload criteria to assign the same object

NOTE: If multiple assignment batches are executed for the same object using workload criteria, 
the results can potentially vary and may not be as desired.

Examples of when you should not run multiple simultaneous batch jobs include:

■ Contact and Contact Denormalization because the same tables are updated

■ Account and Contact Denormalization because Contact Denormalization uses Account team as 
input

■ Opportunity and Contact Denormalization because Contact Denormalization uses Opportunity 
team as input

NOTE: The ASGN_PROC_ID column in the S_ORG_EXT table is no longer used. If you have updated 
this column to run multiple batches of batch assignment in previous versions, note that as of version 
6.0 you can no longer do so.
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8 Advanced Assignment Manager 
Configuration
This chapter provides tasks for advanced assignment configuration. It covers:

■ �Considerations for Advanced Assignment Manager Configuration� on page 193

■ �Creating Assignment Rules to Assign Two Objects� on page 194

■ �Assigning Objects Based on the Primary Address� on page 195

■ �Reassigning Accounts to a Different Primary Position� on page 198

■ �Routing of Assignments to Mobile Users� on page 199

■ �Maintaining the Manually Assigned Primary Position� on page 200

■ �Stopping Assignment of the Default Organization� on page 201

■ �Stopping Assignment of Organizations for Accounts� on page 201

■ �Setting the Lock Assignment Default Value for Activity Assignment Objects� on page 202

■ �Configuring Assignment Objects to Copy Additional Columns to the Team Table� on page 203

For further information or assistance on any of the procedures in this chapter, contact Siebel 
Technical Support.

Considerations for Advanced 
Assignment Manager Configuration
Assignment Manager allows the creation of very advanced assignment configurations. This chapter 
is intended for users familiar with the preceding chapters and who require further information on 
refining their Assignment Manager deployment.

Before beginning any advanced configuration procedures, review background knowledge in the 
Siebel software architecture, Siebel Tools, and Siebel Workflow Manager. Consult the following 
documentation for this information: Going Live with Siebel eBusiness Applications, Using Siebel 
Tools, Configuring Siebel eBusiness Applications, and Siebel Business Process Designer 
Administration Guide.
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Creating Assignment Rules to Assign 
Two Objects
In some cases, you may want to create an assignment rule that assigns candidates to two objects 
while using only one object�s criteria. This section uses a specific scenario as an example in which 
you create an assignment rule to use only an Opportunity criteria to assign candidates to both the 
Opportunity and Account objects. This rule can be used to assign candidates to opportunities and 
their associated accounts.

To create assignment rules that assign two objects using only one object criteria, you need to create 
and map workflow policy components using Siebel Tools.

To define an assignment rule for two objects using one assignment criteria

1 Create an assignment rule and specify the assignment objects that are assigned using this rule.

For this example, create an assignment rule called Account/Opportunity and add the Account and 
Opportunity objects to this rule. For more information about creating assignment rules, see 
�Creating Assignment Rules� on page 130. 

2 Create an assignment criteria that applies to only one of the assignment objects in this 
assignment rule.

For this example, configure the Lead Quality Code assignment criteria (an Opportunity object 
criteria). For more information on creating assignment criteria, see �Creating Assignment Rules� 
on page 130.

3 After the assignment rule is defined, create a workflow policy component that maps to both 
objects.

For information on creating a workflow policy component, see �Phase 1: Creating a Workflow Policy 
Component for Both Objects� on page 122.

4 Map the workflow policy component you created with the column.

For information on mapping a workflow policy column, see �Phase 2: Mapping a Column to the 
Workflow Policy Component� on page 123.

5 Map the workflow policy component you created to the assignment attribute.

For information on mapping a workflow policy component to assignment attributes, see �Phase 
3: Mapping the Workflow Policy Component to the Assignment Attribute� on page 123.
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Figure 26 shows an example of defining an assignment rule for the Account and Opportunity objects 
using only the Lead Quality Code assignment criteria.

Assigning Objects Based on the Primary 
Address
An assignment rule with address criteria, by default, passes objects (Account, Contact, and 
Opportunities, for example) based on any one of the multiple addresses associated with the objects. 
However, Assignment Manager is configurable to assign based on only the primary address. This 
configuration is completed through Siebel Tools in the following procedure. The Account assignment 
object is used in this example.

NOTE: For Siebel Life Sciences, Assignment Manager can populate the Primary Address field for the 
system-assigned positions for the contacts on the intersection table (S_POSTN_CON).

To assign objects based on the primary address

1 Start Siebel Tools.

2 Select the assignment object.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Objects list, select Account.

3 Select the workflow policy component to change the Source Column and Target Column fields.

a In the Object Explorer, select Workflow Policy Component.

b In the Workflow Policy Component window, select Account Address.

c Change Source Column Name to ROW_ID (from OU_ID).

d Change Target Column Name to PR_ADDR_ID (from ROW_ID).

4 Repeat Step 2 and Step 3 for the Contact and Opportunity assignment objects.

Figure 26. Example of Defining an Assignment Rule for Two Objects Using One Assignment Criteria
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5 Check in the projects to the server.

For more information about checking in projects, see Using Siebel Tools.

6 Drop and regenerate triggers by running the Generate Triggers server component (if using 
dynamic assignment or workflow policies).

See �Generating Triggers for Dynamic Assignment� on page 176 for more information on stopping 
and restarting this server component. Alternatively, see Siebel Server Administration Guide.

Assigning Child Accounts Based on 
Parent�s Primary Address
A common business requirement involves the configuration of Assignment Manager to assign child 
accounts based on the primary account�s address. This configuration is completed through Siebel 
Tools using the following procedure.

To assign child Account objects based on the parent�s primary address

1 In the Object Explorer, select the Workflow Policy object and click the Account record; expand 
the Workflow Policy object in the Object Explorer and select the Workflow Policy Components 
object.

2 Create two new workflow policy components, Parent Account and Parent Account Address, with 
the following properties:

3 While the new Parent Account Address record is selected, expand the Workflow Policy Component 
object and click the Workflow Policy Component Column object. Create a new record with the 
following properties:

4 In the Object Explorer, select the Assignment Attributes object and create a new record with the 
following properties:

Source Column Name: ROW_ID ROW_ID

Target Component Name: Account Parent Account

Target Column Name: PAR_OU_ID PR_ADDR_ID

Alias Parent Account State

Data Type: Varchar

Pick List: PickList State

Pick Field: Value
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5 While the new assignment attribute Parent Account State is selected, expand the Assignment 
Attributes object and click the Assignment Attributes Column object. Create a new record with 
the following properties:

6 In the Object Explorer, select the Assignment Criteria object and create a new record with the 
following properties:

7 While the new assignment criteria Parent Account State is selected, expand the Assignment 
Criteria object and click the Assignment Criteria Attribute object; create a new record with the 
following properties:

After the configurations are complete, the project must be checked into the server, and various 
server administration procedures must be run. To update your deployment with these new 
configurations, see �Server Administration After Configuring Assignment Manager� on page 125.

For more information on compiling projects, see Using Siebel Tools. For information on distributing 
the siebel.srf file, see Siebel Anywhere Administration Guide.

An assignment rule can now be created that assigns child accounts based on the parent�s primary 
address.

NOTE: Make sure the child account has a value in the PAR_OU_ID column pointing to a parent 
account that has the primary address.

Assignment Object Account

Workflow Object: Account

Workflow Component: Parent Account Address

Workflow Component Column: Parent Account State

Sequence: 1

Display Name Parent Account State

Use Expertise FALSE

Assignment 
Attribute:

Parent Account State

Store Column: 1

Display Sequence: 1

Display Name: Parent Account State
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Reassigning Accounts to a Different 
Primary Position
To reassign Account assignment objects to another position, use the following procedure. This 
procedure provides an example of mapping the PR_POSTN_ID column of the Account�s base table 
(S_ORG_EXT) to a new assignment attribute named Account Primary Position. Configuration in 
Siebel Tools is required for this process.

NOTE: The following procedure can be employed anytime you want to use a base table column as 
an assignment attribute.

To reassign accounts to a different position

1 Start Siebel Tools (see Using Siebel Tools for more information on proper Siebel Tools 
configuration procedures).

2 In the Object Explorer, select the Workflow Column object and create a new record with the 
following properties:

■ Name: Account Primary Position Id

■ Table: S_ORG_EXT

■ Column: PR_POSTN_ID

3 Select Workflow Policy Object > Account > Workflow Policy Component > Account record; drill 
down to the Workflow Policy Component Column and add a new record called Account Primary 
Position Id.

4 In the Object Explorer, select Assignment Attribute and create a new record called Account 
Primary Position; drill down to Assignment Attribute Column and add a new record with the 
following properties:

■ Name: Account: Account Primary Position Id

■ Assignment Object: Account

■ Workflow Policy Object: Account

■ Workflow Component: Account

■ Workflow Policy Component Column: Account Primary Position Id

■ Sequence: 1

5 In the Object Explorer, select Assignment Criteria and create a new record called Account Primary 
Position; drill down to the Assignment Criteria Attribute and create a new record called Account 
Primary Position Id with the following properties:

■ Name: Account Primary Position Id

■ Assignment Attribute: Account Primary Position Id

■ Store Column: 1

■ Display Sequence: 1

■ Display Name: Id
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6 Check in the project to the server, compile changes to the siebel.srf file, and distribute it to your 
users.

a Choose Tools > Compile.

b In the Object Compiler dialog box, select the Assignment project.

c Select the Siebel client repository file (default is siebel.srf file) located in the Objects 
subdirectory within the Siebel client root directory.

d Click Compile.

7 In the updated Client, create a new assignment rule based on the assignment object Account; 
add a new criterion for this rule, and select the Account Primary Position; under the values 
applet, select the ROW_ID of the position you want to reassign.

8 Navigate to the Positions view of this new Assignment Rule; select the new position that is to 
replace the previous position.

9 Release assignment rules by clicking Release in the Assignment Rules view.

10 Run a Batch Assignment against a test account that includes the old position; use the following 
parameters:

■ Object: Account

■ Object WHERE clause: WHERE ROW_ID=�<your_value>�

11 Confirm that the test account is reassigned and then run a Batch Assignment to reassign the 
other accounts to the new position; use the following parameters:

■ Object: Account

■ Object WHERE clause: WHERE PR_POSTN_ID=�<your_value>�

Thoroughly test this assignment rule before applying it to your production environment. After 
your Accounts have been reassigned, it is recommended that you expire this rule.

12 Depending on your situation, run Contact Denormalization to update the contact access list.

13 To set up Position in the Values applet as a picklist, select the appropriate picklist and applet 
when configuring the Workflow Column and Assignment Criteria Attribute for the Account Position 
Id. 

Routing of Assignments to Mobile Users
The component parameter LogTxnChgOnly controls whether transactions with no change to 
Assignment primary or team members are routed to mobile or remote users. This parameter has a 
default setting of TRUE for Batch Assignment, Interactive Assignment (Assignment Manager), and 
implicitly Dynamic Assignment (Workflow Monitor Agent). As a result, transactions with no change 
to Assignment primary or teams are not routed to mobile users. To change the LogTxnChgOnly 
parameter for dynamic assignment, use the following steps. This procedure requires configuration in 
Siebel Tools.
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To route assignments to mobiles users by changing the LogTxnChgOnly parameter

1 Stop the Workflow Monitor Agent processing the assignment policies.

2 Start Siebel Tools (see Configuring Siebel eBusiness Applications for more information on proper 
Siebel Tools configuration procedures).

3 In the Object Explorer, select the Workflow Policy Program and select Assignment Request (In 
Process).

4 Drill down to Workflow Policy Program Arguments in the Object Explorer and select the 
LogTxnChgOnly parameter.

5 Change the value to TRUE or FALSE.

If TRUE, transactions with no change to the assignment primary or teams are not routed to 
mobile users.

6 Check in the project to the server.

7 Restart the Workflow Monitor Agent. 

NOTE: You do not need to recompile the .srf file.

Maintaining the Manually Assigned 
Primary Position
Assignment Manager maintains an object row�s manually-assigned primary position when the Keep 
Manual Primary Position property is set to TRUE, but only when PR_REP_MANL_FLG=Y on the object 
row. By default, this value is set to N.

For example, when an assignment opportunity object is created in the Siebel UI, the creator is added 
to the opportunity object�s team as the primary. For this position to be recognized as the manually 
assigned primary by Assignment Manager, an employee with Data Administration rights must set this 
property in the appropriate administrative screen. This action changes PR_REP_MANL_FLG to Y so 
Assignment Manager does not reset the primary when run.

To maintain the object�s primary position

1 Start your Siebel application. 

2 Access the Administration - Data screen. (Check your responsibility if this screen is not visible.)

3 Navigate to the Opportunity (or other assignment object) screen.

4 Locate and select the assignment object of interest.

5 Click the Sales Team select button to launch the Sales Team window.

6 Click the Primary check box of another position in the list; then reselect the Primary check box 
of the original position.

This process changes the system PR_REP_MANL_FLG value to Y and updates PR_REP_SYS_FLG 
to N. 
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This procedure can also be used to add positions to the object or delete system-assigned positions 
from the object. 

Stopping Assignment of the Default 
Organization
If you want to override the assignment of all organizations to an assignment object, you must 
remove the assignment property Org Primary Column from a selected assignment object. The default 
value is set to BU_ID. After this value is set to null, Assignment Manager does not assign any 
organization to the assignment object. The following procedure details this configuration. The 
account assignment object is used as an example.

To stop assignment of the default organization to Account object

1 Start Siebel Tools and select the appropriate project.

2 In the Object Explorer, expand Workflow Policy Object.

3 Select Assignment Object.

4 Select the Account Record.

5 In the Properties Window, find the property called Org Primary Column.

6 Delete the value for this property. (The default value is BU_ID.)

After the assignment object is modified, various server administration procedures must be run to 
make sure your configurations are recognized by Assignment Manager.

■ If you are using Batch Assignment, start a new task.

■ If you are using Dynamic Assignment, stop and restart the Workflow Monitor Agent. 

■ If you are using Interactive Assignment, stop and restart the Assignment Manager Server 
Component.

NOTE: It is not necessary to recompile the .srf file when configuring an assignment object to stop 
assignment of the default organization. 

Stopping Assignment of Organizations 
for Accounts
If you do not want Assignment Manager to reassign the organizations that you have setup for an 
account, you must change the default values for the Account assignment object properties in Siebel 
Tools. 

To stop reassignment of organizations for accounts

1 Start Siebel Tools.
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2 In the Object Explorer, expand Workflow Policy Object.

3 In the Workflow Policy Object list, select Account.

4 In the Object Explorer, click Assignment Object.

5 In the Assignment Objects list, set the following values:

■ Default Organization = <blank> 

■ Org Primary Column = <blank>

■ Org Table = <blank>

■ Set Primary Org = FALSE

NOTE: Where <blank> is a null value.

After these values are set, Assignment Manager does not reassign any organizations for 
accounts.

6 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the �To update your deployment with new configurations� 
procedure.

NOTE: It is not necessary to recompile the .srf file. However, you should check-in the changes 
to the server database.

Setting the Lock Assignment Default 
Value for Activity Assignment Objects
Assignment objects contain a lock assignment feature that, when activated by checking the Lock 
Assignment column on the object's list applet in Siebel Tools, prevents Assignment Manager from 
assigning or reassigning a position or candidate to that object. You can use this feature to exclude 
an object (such as Account or Opportunity object) from being reassigned by Assignment Manager. 
By setting the column defined in the Exclude Column for the assignment object, Assignment Manager 
excludes (ignores) the object for assignment.

The Lock Assignment parameter for activity objects is, by default, set to TRUE. This setting does not 
allow Assignment Manager to assign these objects. Therefore, Assignment Manager does not assign 
activity records. However, the Field Service Activity object is the one exception and is, by default, 
available for assignment (the Lock Assignment parameter is set to FALSE). Other activity objects 
must have the Lock Assignment parameter set to FALSE or null for assignment to occur. (The lock 
assignment feature for activity records in the Siebel application, except for Field Service activity 
records, defaults to �Y�.) This behavior is due to a setting in the Post Default Value property for the 
Action business component's Assignment Excluded field (Business Component > Field > Assignment 
Excluded). The value in the property is: 

Expr: "IIf ([Class] = LookupValue(""FS_ACTIVITY_CLASS"", ""Field Engineer Activity"") 
OR [Class] = LookupValue (""FS_ACTIVITY_CLASS"", ""Repair Activity"") OR [Class] = 
LookupValue(""FS_ACTIVITY_CLASS"", ""Preventive Maintenance""), ""N"", ""Y"")"

Using Siebel Tools, you can implement assignment of all types of activities by setting the default 
value of the Assignment Excluded field to FALSE at the business component level.
Siebel Assignment Manager Administration Guide Version 7.7202 ■



Advanced Assignment Manager Configuration ■  Configuring Assignment Objects to
Copy Additional Columns to the Team Table
The following procedure explains how to set the Lock Assignment default value so that Assignment 
Manager assigns activity objects. A similar procedure can be used for other assignment objects.

To set the lock assignment default value to assign activity objects

1 Start Siebel Tools.

2 In the Object Explorer, expand the Business Component object.

3 In the Business Components list, select Action.

4 In the Object Explorer, click Field. 

5 In the Fields list, select Assignment Excluded, and change the Post Default Value field to �N�.

6 Check-in the changes to the server.

For more information about checking in changes, see Using Siebel Tools.

7 Recompile the .srf file.

For more information about recompiling the .srf file, see �To update your deployment with new 
configurations� on page 125.

8 Make sure that all Siebel clients that create activity records have the new .srf file.

NOTE: This step applies only to mobile or dedicated clients.

Assignment Manager now assigns activity records based on the defined assignment rules.

Configuring Assignment Objects to Copy 
Additional Columns to the Team Table
When an item, such as an account or opportunity, is assigned to a team of people, the team field 
(the actual name of the field varies depending on the view) for that record shows a list of the people 
assigned to that item. This list of names is known as the team table for the given record. When 
making assignments, Assignment Manager passes information about the team members to the team 
table, such as the name of the person, that person�s position and user ID, and so on. This section 
explains how to configure assignment objects to add additional information about team members to 
the team table.

Using Siebel Tools, you configure assignment objects to copy additional columns to the team table. 
The following procedure details this configuration. As an example, copying columns to the team table 
S_ORD_CRDT_ASGN of the Order (Sales Credit Assignment) assignment object is considered; data 
is copied from the S_ASGN_GRP_POSTN rule group position table.

To configure an assignment object to copy additional columns to the team table

1 Start Siebel Tools.

2 Select the assignment object for which you want to copy additional columns to the team table.

a In the Object Explorer, expand Workflow Policy Object.
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b In the Workflow Policy Object window, select the object.

For this example, select Order.

c In the Object Explorer, expand Assignment Object, and then select Assignment User Prop.

3 In the Assignment User Properties window, choose Edit > New Record to define user properties 
for the assignment object.

a In the Name field, type a name for the property starting with PositionTeamDenorm followed by 
a digit (for example, PositionTeamDenorm1, PositionTeamDenorm2). 

b In the Value field, use the following syntax to enter values (for value descriptions, see Table 39 
on page 204):

source column,destination column,flag,default value

For this example, the following table shows the valid user properties for the Order (Sales 
Credit Assignment) assignment object:

Table 39 provides descriptions for each field of the assignment user property values.

Name Value

PositionTeamDenorm1 DATE1,START_DT,N

PositionTeamDenorm2 CHAR2,SLS_TERR_ID,Y

PositionTeamDenorm3 CHAR1,CRDT_RULE_ID,N

PositionTeamDenorm4 NUM1,ALLOC_PCT,N

PositionTeamDenorm5 CHAR3,FROM_BTM_NODE_FLG,N

PositionTeamDenorm6 NUM2,ROLLUP_PCT,N

Table 39. Assignment User Property Values

Value Description

source column The name of the column in the assignment rule group position table whose value 
is copied to the destination column of the team table. There are 7 boolean 
columns, 19 string columns, 7 number columns, and 3 date columns available for 
copying.

For this example, the values are copied from the S_ASGN_GRP_POSTN table.

destination 
column

The name of the column in the team table where the values are copied. The 
destination column must be one of the user data columns in the team table of the 
assignment object.

For this example, SLS_TERR_ID is one of the columns of the S_ORD_CRDT_ASGN 
table, which is the team table of the Order assignment object.
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When Assignment Manager runs, the user property values are copied to the team table. For more 
information about running Assignment Manager using the copy columns features, see Chapter 7, 
�Running Assignment Manager.�

For more information about team tables, see �About Assignment Scoring� on page 39, �About Contact 
Denormalization� on page 46, and �Configuring Assignment Objects for Team Scoring� on page 105.

flag Indicates whether or not (Y = TRUE) the respective destination column is part of 
the user key of the team table. Without this flag specified, duplicate positions 
cannot be inserted in the team table. For more information about duplicate 
positions, see �AllowDupPostn� on page 188.

default value Specifies the values that are inserted in the destination columns if the assignee 
is the default.

For this example, the default values are null.

Note: This value is optional if the default position is not specified.

Table 39. Assignment User Property Values

Value Description
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9 Version Compatibility
This chapter provides a summary of the changes and compatibilities between Territory Assignment 
in Version 4.x and Assignment Manager in version 5 and higher. Major differences between Territory 
Assignment and Assignment Manager covered in this chapter include:

■ �Assignment Manager System Preferences Compatibility� on page 207

■ �Assignment Manager Tables Version Compatibility� on page 208

■ �Assignment Manager Command Line Options Version Compatibility� on page 209

NOTE: The Territory List and Detail views will eventually be phased out from the Assignment 
Administration screens. If your configuration currently uses these views, note that they can migrate 
to the existing Assignment Rule views with no loss of functionality or data. For further information, 
contact Siebel Technical Support. 

Assignment Manager System 
Preferences Compatibility 
Territory Assignment System Preferences (Version 4.x) are no longer used in Version 5 and higher; 
these preferences are referred to now as assignment object properties. Assignment Manager 
preferences are now set in Siebel Tools by navigating to Workflow Policy Object in the Object 
Explorer. Each assignment object is defined as a Workflow Policy Object. To define the preferences 
for an assignment object, expand the corresponding Workflow Policy Object, select Assignment 
Object, and locate the preference. Preferences appear as assignment object properties. Object 
preferences are similar to System preferences but allow you to define how Assignment Manager 
behaves for each object, rather than system preferences that apply to all objects. 

Table 40 shows the system preferences used in Territory Assignment and the system preferences 
used in Assignment Manager. 

Table 40. Comparison of Assignment Manager System Preferences

Territory Assignment 
System Preferences 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)

Allow User Exclusive Lock Assignment Column in Siebel Tools Assignment Object

Assignee of Unowned Default Employee, Default Employee, or Default Organization

Copy Opportunity Revenue Position Team Copy Columns in Assignment Object

Keep Creator Keep Creator Flag

Keep Manually Assigned Keep Manual Assigned Flag
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Assignment Manager Tables Version 
Compatibility
Table 41 shows the tables used in Territory Assignment and the tables used in Assignment Manager. 

(Re)determine Primary Rep Set Primary Position or Set Primary Employee Flag

Update or Add To Add Team Members Flag

Table 41. Comparison of Assignment Manager Tables

Territory Assignment 
Tables (Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)

S_TERR S_ASGN_GRP

S_TERR_ITEM S_ASGN_RULE and ASGN_RULE_ITEM 

Table 40. Comparison of Assignment Manager System Preferences

Territory Assignment 
System Preferences 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)
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Assignment Manager Command Line 
Options Version Compatibility
Table 42 shows the command-line options used in Territory Assignment and the corresponding 
options used in Assignment Manager. 

Table 42. Comparison of Assignment Manager Command Line Options

Territory 
Assignment 
Command-Line 
Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)

/Address 0

/Address 1

/Address 2

Set in Assignment Attribute columns. For the Opportunity Workflow Policy 
Object, you can specify workflow components for the Opportunity�s primary 
address or the Opportunity�s primary account address.

To generate the same results as using:

■ /Address 0 (use both Opportunity and Account primary addresses), set 
Workflow Components Opportunity Primary Address to Active, and set 
Primary Account Address to Active.

■ /Address 1 (use Opportunity primary address only), set Workflow 
Components Opportunity Primary Address to Active, and set Primary 
Account Address to Inactive.

■ /Address 2 (use Account primary address only), set Workflow 
Components Opportunity Primary Address to Inactive, and set Primary 
Account Address to Active.

You must also inactivate the corresponding Assignment Attribute columns of 
the component under the workflow policy object. After this step is finished, 
recompile the .srf file and, if you are using dynamic assignment, regenerate 
triggers. 

In Version 4.x, Territory Assignment uses the Account primary address for 
assignments of the Account object. In Version 5 and higher, Assignment 
Manager uses all addresses for assignments of the Account object.

/Bypass Use Batch Assignment to reassign existing objects.

/Group Use Batch Assignment with WHERE clauses.

/Ignore Ignore the Extra Attributes flag on Siebel Tools Assignment Object.
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/Indirect Set in Assignment Attribute columns. For the Opportunity Workflow Policy 
Object, you can specify workflow components for the Opportunity�s indirect 
accounts.

To generate the same results as using:

■ /Indirect YES (use attributes from the opportunity�s indirect accounts), 
set all Workflow Components named Indirect Account to Active.

■ /Indirect NO (do not use attributes from the opportunity�s indirect 
accounts), set all Workflow Components named Indirect Account to 
Inactive.

Note: You need to change this option for the Account ID Assignment 
Attribute. The default value for Opportunity's indirect accounts 
(Opportunity/Indirect Account and Indirect Account Synonym) are inactive 
in the Assignment Attribute Column. Also, the Opportunity/Indirect Account 
and Indirect Account Synonym Workflow Components for the Opportunity 
Workflow Object are active by default.

/KeepCreator Set the Keep Creator flag on Siebel Tools Assignment Object.

/Mode Use one or more Workflow Monitors to process requests for assignment 
objects.

Use the Group Name parameter to specify the name of the assignment policy 
group to assign. The assignment policy group specifies the list of assignment 
objects to dynamically assign.

When running Batch Assignment, use the assignment object parameter to 
specify the name of the assignment object to assign.

/OutputFile No longer applicable. Output goes to Siebel Server trace files.

/NumRec Use Workflow Monitor to specify the number of requests per iteration.

/Phase Not used at this time. Use Workflow Monitor to detect requests.

/PrimaryAddressId Not used at this time.

/PrimaryRep Set Primary Position or Set Primary Employee Flag on Siebel Tools 
Assignment Object.

/RecID Use batch mode with a WHERE clause.

/RollBack Use the SIEBEL_ROLLBACK_SEG environment variable to specify rollback 
segments for Siebel Server tasks.

/RunTotal No longer applicable.

Table 42. Comparison of Assignment Manager Command Line Options

Territory 
Assignment 
Command-Line 
Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)
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/Sleep Now applicable only in Dynamic Assignment, and the parameter is Sleep 
Time in Workflow Monitor.

/Synch No longer applicable.

Table 42. Comparison of Assignment Manager Command Line Options

Territory 
Assignment 
Command-Line 
Options 
(Version 4 or 4.x) Assignment Manager Compatibility (Version 5 and Higher)
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A Assignment Manager Error 
Messages
This appendix explains the error codes and associated text that Assignment Manager may generate 
during processing.

Understanding Assignment Manager 
Error Messages
Table 43 lists the error codes, the message text, and a description of each error that Assignment 
Manager may generate during processing. For each error, Assignment Manager writes this 
information to the Assignment Manager log file (if you specified that one be used).

Table 43 provides the Assignment Manager error codes.

Table 43. Assignment Manager Error Codes

Error Code Error Text1 Resolution2

ERR_ASG_ALREADY_ASSIGNED Assigned this object %1 
(more recently than 
requested %2).

This is just information.

ERR_ASG_ASSIGN_REPLY Selected %3 rules, 
%5 organizations, and %4 
people for %1 (%2).

This is just information.

ERR_ASG_BASSIGN_REPLY Assigned %1 rows for %2. This is just information.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1.

The configuration of the 
assignment object is not 
correct. Use Siebel Tools to 
check the configuration of the 
assignment object.

ERR_ASG_BDENORM_REPLY Denormalized %1 rows for 
%2.

This is just information.

ERR_ASG_CANNOT_ASSIGN_
LOCKED_ROW 

Cannot assign this item 
because it is in a locked state. 
(Object Name = %1, Object 
Row Id = %2.)

If you want to assign this 
object, please uncheck the 
Lock Assignment field for the 
object being assigned. 
Otherwise, this is just 
information.

ERR_ASG_DENORM_REPLY Denormalized %1 rows for 
%2.

This is just information.
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ERR_ASG_DUP_CONFLICT Unable to update row (%1) 
because updated values 
violate unique index with an 
existing row (%2).

Check the data on your team 
table on the object row_ID 
where it failed.

ERR_ASG_INVALID_BU_
DFLT_NAME

Default organization %1 for 
assignment object %2 is not 
found in the organizations 
table. Please check that 
Default Organization - %1 is 
a valid organization.

Use Siebel Tools to set the 
Default Organization 
parameter for the assignment 
object to a valid organization in 
the database.

ERR_ASG_INVALID_EMP_
DFLT_NAME 

Default employee %1 for 
assignment object %2 is not 
found in the employees table.

Use Siebel Tools to set the 
Default Employee parameter 
for the assignment object to a 
valid employee in the 
database.

ERR_ASG_INVALID_POSTN_
DFLT_NAME 

Default position %1 for 
assignment object %2 is not 
found in the positions table.

Use Siebel Tools to set the 
Default Position parameter for 
the assignment object to a 
valid position in the database.

ERR_ASG_INVALID_STORE_
COL_NUM

Assignment criteria attribute 
%1 has an invalid store 
column.

Check the Store Column value 
for your assignment criteria 
attribute and make sure it lies 
between 1 
and 4.

ERR_ASG_INVALID_WF_
LINK_COL

Assignment attribute column 
(%1) references invalid 
workflow component column 
(%2).

Check the Workflow Policy 
Component Column property of 
the assignment attribute 
column, and make sure it 
points to a valid and active 
workflow policy component 
column.

ERR_ASG_ITEM_ATTR_HAS_
NO_ATTR

Assignment Criteria %1, 
Assignment Criteria Attribute 
%2 has no attribute defined. 
Verify in Siebel Tools that the 
Assignment Criteria %1 has 
an assignment criteria 
attribute defined and active. 
Recompile the server 
repository file to apply 
changes made on assignment 
criteria configuration if 
necessary.

Table 43. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_ITEM_ATTR_HAS_
NO_ITEM

Item(%2) not found for item 
attribute (%1). Please make 
sure that the item(%2) is 
active.

Make sure that the Parent 
Assignment Item Type of the 
Assignment Criteria 
Attribute(%1), points to a valid 
and active assignment criteria.

ERR_ASG_ITEM_NOT_
FOUND

Assignment Criteria %1 has 
an invalid assignment 
attribute. Please check the 
assignment criteria 
configuration on Siebel Tools 
using the Validate tool, and 
note that it is a requirement 
to recompile the server SRF 
after adding or deleting 
assignment criteria records.

ERR_ASG_LOADING_GROUP Unable to load assignment 
rule %1 from the database. 
Please check the assignment 
rule definitions to make sure 
that all the required 
information is correct and 
press the Release button to 
recreate the rule cache data 
file.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1." 

Check the configuration of the 
assignment object.

ERR_ASG_LOV_VALUE_NOT_
FOUND

No LOV value found for 
Type [%1], Value [%2].

Make sure expertise values for 
skills are valid, belonging to 
LOV type EXPERTISE_CD 
(defined through Application 
Administration screens).

ERR_ASG_MATCHASSIGN_
REPLY

Qualified and selected %3 
rules, %5 organizations, and 
%4 people for %1 (%2).

This is just information.

ERR_ASG_MATCH_REPLY Qualified %3 rules, %5 
organizations, and %4 people 
for %1 (%2).

This is just information.

ERR_ASG_NO_OBJ_COL_FOUND Assignment object %1 has no 
columns.

Table 43. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_NOT_EMP_POSTN Employee or Position not 
specified for assignment 
object %1.

If person-based assignment, 
make sure that at least one of 
the four properties (Position 
Table, Position Primary 
Column, Employee Table, 
Employee Primary Column) for 
assignment object %1 has a 
valid non-null value. If 
organization-based 
assignment, make sure that at 
least one of the two properties 
(Org Table, Org Primary 
Column) for assignment object 
%1 has a valid non-null value.

ERR_ASG_NO_WF_COLS_
IN_ATTR

Assignment attribute %1 has 
no workflow columns.

ERR_ASG_NO_WF_OBJECT No workflow object available 
for assign object = %1.

Make sure that the Parent 
Workflow Object property of 
the Assignment Object % 
points to a valid workflow 
object.

ERR_ASG_OBJECT_NOT_FOUND Assignment object %1 is not 
registered in the Siebel 
repository. Please make sure 
that %1 is a valid assignment 
object name and the value 
you input is identical to what 
you see in the application. 
Please review the Assignment 
Manager documentation for 
details on the required 
parameters before running an 
Assignment Manager task.

ERR_ASG_PERSON_OBJECT_
NUM_ATTR_MISMATCH

Number of attributes do not 
match with assignment object 
for person object %1.

ERR_ASG_PR_TBL_ROW_
NOT_FOUND 

RowId [%1] in table [%2] not 
found.

Make sure that request 
submitted is for a valid Row Id 
in table (%2).

ERR_ASG_UPDATE_FAILED Unable to update row %1 
(%2).

Check the log file for database 
related error, and correct the 
error.

Table 43. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_PARSING_VALUE Unable to parse criteria value 
%1.

ERR_ASGN_KEY_NO_MATCH Assignment Key %1 does not 
match the Request Key.

Make sure that the AsgnKey 
parameter is set to the Row Id 
of one of the assignment 
groups mapped to the server.

1. The error text that appears in Table 43 is generic. However, for most errors, Assignment Manager generates more specific 
information about the exact cause of the error. Both the generic and the specific error messages appear in the Server Process Log; 
while only the specific error message appears in the Assignment Manager log file.

2. If the Resolution column is blank, this means either the error code is no longer applicable or the text of the error code is informative 
enough not to warrant a separate explanation for resolution.

Table 43. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
Siebel Assignment Manager Administration Guide Version 7.7 ■ 217



Assignment Manager Error Messages ■  Understanding Assignment Manager Error 
Messages
Siebel Assignment Manager Administration Guide Version 7.7218 ■



Index
Symbols
.srf file, compiling 125

A
account object examples

assigning two objects 194
child accounts, primary parent 

address 196
primary address assignments 195
reassigning positions 198

accounts
organization, stopping assignment for 201
territories, roles of 62
territory definition list, modifying 63

ActionAgent parameter, about 179
ActionInterval parameter, about 179
activity assignment objects, setting lock 

assignment default value 202
activity-based assignment, email and 

assignment rules 42
administrative tasks

organization skills, associating with 154
skills, assigning to positions and 

responsibilities 153
skills, associating with an employee 153

All, Above Minimum method, about 20
All, Must Assign method, about 20
AllowDupPostn parameter

batch assignment command-line interface 
parameter, about 187

interactive assignment command-line 
interface parameter, about 174

SRVRMGR utility, about running from batch 
assignment mode 188

applet classes in interactive 
assignment 98

AsgnBatch command
batch assignment mode, additional parameter 

characteristics 187
batch assignment mode, running from (about 

and parameters) 187
AsgnKey parameter

batch assignment command-line interface 
parameter, about 187

interactive assignment command-line 
interface parameter, about 174

SRVRMGR utility, about running from batch 

assignment mode 188
AsgnMode parameter

batch assignment command-line interface 
parameter, about 187

interactive assignment command-line 
interface parameter, about 174

AsgnObjName parameter
batch assignment command-line interface 

parameter, about 187
interactive assignment command-line 

interface parameter, about 174
AsgnSrvr command, using to run interactive 

assignment mode from 174
Assign option, configuration example 97
Assignee Filter type, table of 59
assignee, determining primary 60
Assignment Attribute Column object type

about 88
configuring 111
properties of (table) 112

Assignment Attribute object type
about 88
overview 109
properties (table) 110

assignment attributes
assignment criteria configuration 107
column-based vs. skill-based 107
configuring assignment attributes 108
creating 109
definition 109
disabling 117
mapping workflow components 123
multilingual list of values (MLOV), configuring 

for 110
multiple attributes, about basing on 

columns 108
new configurations, activating 125
overview 35
triggers, generating 109
Values picklist, specifying 108
warning about adding or changing 87

assignment criteria
assignment methodology, role in 57
assignment rules without criteria, role 

of 29
attribute object definition, about 109
combining rules, developing 64
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comparison methods, example 30
comparison methods, table of 28
configuration warning 107
configuring, about 113
configuring, creating 113
configuring, overview 107
creating 134
creating, example of 114
creation process overview 107
expertise codes, role of 37
inclusion methods (table) 29
mapping workflow components 123
multiple assignment attributes, about basing 

on columns 108
multiple object assignments 194
new configurations, activating 125
nonrequired assignment criteria 33
object definition properties 116
object definition properties, about 114
primary address, assignments based 

on 195
properties (table) 114
queries, creating 134
required assignment criteria 33
required when available, about and 

example 33
seed assignment criteria, removing 108
single value to multiple fields 107
skills comparison methods 37
values, comparison method 34
values, creating 137
warning about adding or changing 87

assignment criteria attributes
configuring 115
creating 116
list columns, relation to 115
object properties (table) 117
object type, about 88

assignment criteria object type, about 88
assignment criteria values

creating, example 139
criteria values, creating as skills 139
expertise codes, using 139
sorting and storage 138
wildcard characters as literals 138
wildcard characters, about 138

Assignment Manager
Assignment Manager component, 

configuring 166
child accounts, parent primary address 

example 194
command line options, compatibility with 

Territory Assignment (table) 209
component configuration, overview 86, 

109
component parameters, configuring, 

importance of 167
components of, listed 13
components, starting 166
configuration concepts 87, 114
contact denormalization 46
customizing, about 12
data sources 163
event log configuration 168
parameters, configurable (table) 166
post-configuration tasks 170
preferences, setting 207
running multiple instances 190
Server Request Broker components, 

checking 165, 171
table compatibility with Territory 

Assignment 208
trace and error flags, about using 168

Assignment Manager, modes
batch assignment mode, running in 184
dynamic assignment mode 175
interactive assignment mode 171
mobile assignment mode, running in 183

assignment methodology, assigning 
candidates 57

assignment modes
dynamic assignment mode, overview 175
dynamic assignment, disabling and 

enabling 181
independent assignment 66
interactive assignment mode, running in 

overview 171
mobile mode, running in 183
organization and person-oriented assignment, 

about 67
organization-oriented assignment, if 

multitiered assignment is set 67
person-oriented assignment, if multitiered 

assignment is set 66
server requirements 170

assignment object modes
batch assignment mode, multiple record 

assignments 45
batch mode assignment, overview 184

assignment object object type, about 88
assignment object properties

See also configuration; configuration, 
advanced

assignment objects
assigning multiple records 45
assignment attributes, mapping to 111
assignment rules, about developing 61
candidates, role of 16
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configuration overview 91
configuring 92
default organization assignment 152
default organization, suppressing assignment 

of 201
dynamic assignment mode, role of 175
expertise codes 37
interactive assignment, configuring 98
interactive assignment, overview 97
matching requirement for workload 

rules 143
multiple object assignments 194
multitiered assignment, configuration 104
new configurations, activating 125
no-criteria rule 134
original assignment objects, configuration 

warning 89
position and employee-based assignments, 

creating 91
positional visibility, about 150
predefined assignment rules, definition 

requirement 127
predefined definitions, list of 91
primary address criteria 195
primary position, maintaining 200
reassigning positions, example 198
repository migration, warning 87
role in defining assignment criteria 113
setting preferences 207
Siebel Tools, role of 87
system-assigned positions, deleting 151
team scoring, configuration 105
team table, configuring to copy additional 

columns to 203
team-based criteria 143
wildcard characters, use of 138
workflow policy object, adding to 92
workflow policy objects, relation to 91

assignment objects, availability-based 
assignment

about configuring for 100
configuration example 102
configuring for 101
visibility 103

assignment policies
actions, creating 182
activating 181
batch assignment mode deactivation 

requirements 185
contact denormalization, activating 182
deactivating 182
dynamic assignment mode and predefined 

assignment policies 180
workflow group, setting 181

workflow groups, role of 180
Workflow Monitor Agent, role of 180

Assignment Results BusComp user 
property 99

assignment rule groups
assignment rules, sequencing 26
creating 128
key-based routing 23
overview 22

assignment rules
See also territories
assigning candidates to two objects 121
assignment methodology, role in 57
assignment object configuration 

overview 91
availability-based rules, overview 149
combining criteria, developing rules 64
complex rule, example 194
creating 130
definition requirement 127
developing, about 61
emails, as activities 42
employees, about visibility for assigned 

object 150
employees, adding to (procedure) 147
Enterprise Integration Manager, loading 

with 185
migrating, about 127
multiple criteria, about creating rules that 

combine 64
multiple object assignments 194
multitiered assignment mode, using with sales 

assignment rules 66
multitiered assignment, about 43
no-criteria rule 134
object assignment 28
organizations, adding to 151
overview and example 19
positions, adding to 150
predefined 91
process overview 11
releasing 154
required assignment criteria 33
rule cache, recreating 154
rulecache.dat file, about updating 164
scoring formula 58
sequence, defining 133
sequences of rules, evaluating 26
sequences of rules, examples 26
tasks, listed 127
without criteria, role of 29

assignment scoring
overview 39
team member scores 40
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assignment strategy
assignment rules, about developing 61
assignment skill, associating with an 

organization 154
sales organizations, assignment in 61
skills, associating with a position 153
skills, associating with an employee 153

Assignment Type business component, user 
property 98

attributes, about defining assignment 
criteria and using 113

availability-based assignment
assignment objects, configuring 102
assignment objects, visibility 103
assignment rules, overview 149
availability criteria, activating 149
overview 42

B
batch assignment mode

about 45
assignment rules without criteria 29
command line, additional parameter 

characteristics 187
command line, running from (about and 

parameters) 187
interaction with dynamic assignment 

mode 185
mobile users, routing assignments to 199
multiple instances, running 190
Object WHERE Clause, using when starting 

server task 188
overview 184
performance tuning 189
record updating, inadvertent 185
running 185
SRVRMGR utility, additional parameter 

characteristics 187
SRVRMGR utility, running from (about and 

parameters) 187
wildcards, using in SQL statements 188

BatchMode parameter, about 179
BatchSize parameter

batch assignment command-line interface 
parameter, about 187

description, about 174
performance considerations 189

business components
Assignment Rule compared to Assignment 

Group 113
interactive assignment 98

C
cache size, LastUsrCacheSx parameter, 

about 180
candidates

assignment criteria, using to determine 
qualified candidates 28

assignment methodology 57
evaluation methods, about 28
organizations, about and example 17
positions, about and example 16
potential assignees list 59
qualifying 28
teams, about and example 17
two objects, assigning to 121
types, described 16
workloads, balancing 40

Check Calendar box, about using 149
Check version iterations parameter, 

about 167
CheckLogCacheSz parameter, about 180
child accounts

PAR_OU_ID column, about value point 
to 197

parent�s primary address, assigning based 
on 196

primary parent address 194
classes, confirming for interactive 

assignment 98
column-based assignment attributes, 

about 107
command-line interface

interactive assignment mode, running 
from 174

Territory Assignment and Assignment 
Manager, compatibility (table) 209

Compare Object to Organization
assignment criteria values, about 37
comparison method, about 28

Compare Object to Person
comparison method, about 28
expertise codes, use of 37
skill matching 37

Compare to Object
assignment criteria values, about 37
comparison method, about 28
criteria values, about using 137
criteria values, assignment criteria 34
expertise codes, use of 37

Compare to Organization
assignment criteria values, about 37
comparison method, about 28
criteria values, about using 137

Compare to Person
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assignment criteria values, about 37
comparison method, about 28
criteria values, about using 137
criteria values, assignment criteria 34
expertise codes, use of 37

configuration
See also configuration, advanced
Assign option, using to invoke Interactive 

Assignment 97
Assignment Manager post-configuration 

tasks 170
assignment objects for multitiered 

assignment 104
availability-based assignment, extending 

Service Request�s base table 
for 101

availability-based assignment, 
overview 100

configurable features 87
event logs, about and types of 168
event logs, setting log level 169
interactive assignment, configuring for an 

assignment object 98
interactive assignment, overview 97
new configurations, activating 125
original assignment objects, changing 89
process overview 86
Siebel Dedicated Web Client, parameters for 

interactive assignment mode 
(table) 171

team scoring example 105
configuration, advanced

See also configuration
activity assignment objects, setting the lock 

assignment value 202
assignment objects, configuring to copy 

additional columns 203
assignment rules, creating to assign two 

objects 194
assignments, routing to mobile users 199
child account, assigning based on parent�s 

primary address 196
default organization, stopping assignment 

of 201
organization, stopping assignment for 

accounts 201
primary address, assigning objects based 

on 195
primary position, maintaining manually 

assigned 200
primary position, resigning accounts 198

contact denormalization
activating 182
assignment operation mode, about 46

criteria
See assignment criteria

Criteria list column, using to configure 
assignment criteria 113

criteria values
configuration warning 87
criteria value scores, calculation of 137
duplicate criteria values 138
methods used 137

CSSBCBase, about configuring for interactive 
assignment 98

D
data visibility, about controlling visibility 

between organizations 17
database triggers, about generating 45
default organization, suppressing 

assignment of 201
default parameters, modifying 92
Default Tasks parameter, about 167
DeleteSize parameter, about 180
denormalization, about using Contact 

Denormalization mode 46
Detail views, about phasing out 207
dynamic assignment mode

See also Workflow Monitor Agent
about 44
assignment objects, enabling and disabling 

for 181
database changes, refreshing display 183
error message 176
generating triggers, about 175
GenTrig command-line interface command, 

running using 178
interaction with batch assignment 

mode 185
mobile users, routing transactions to 199
overview 175
performance tuning 183
triggers, generating 176

E
eBusiness Integration Manager (EIM), 

loading assignment rules 185
email and assignment rules, activity-based 

assignment 42
employee-based assignment objects, 

about 42
employees

assignment rules, adding to 
(procedure) 147

availability-based assignment rules, 
overview 149
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availability-based assignment, about 42
multitiered assignment, about and 

example 148
position and employee-based assignments, 

creating 91
skills, associating with 153
visibility, about for assigned object 150
workload criteria definition example 145
workload criteria, defining 144

error flags, about using 168
error messages

dynamic assignment mode, attempting to 
modify a record 176

IgnoreError parameter, about 180
event logs

about configuring and types of 168
log level, setting 169

EventDate parameter
batch assignment command-line interface 

parameter, about 187
interactive assignment command-line 

interface parameter, about 174
Exclude method, about 31
EXEC parameter, about 178
expertise codes

creating 140
creating, example 141
criteria values, using with 139
overview 37
predefined expertise codes, about 37
weighting factors example 142
weighting factors, about applying to 38
weighting factors, defining 141

Expertise list column, about 116

F
field service

assignment rules, creating 72

G
Generate Triggers server component, 

about 45
Generate Triggers, running 176
GenReqRetry parameter, about 180
GenTrig command-line interface command, 

using 178
GroupName parameter, about 180

I
IgnoreCache parameter

batch assignment command-line interface 
parameter, about 187

interactive assignment command-line 

interface parameter, about 174
IgnoreError parameter, about 180
Include All Matching method, about 31
Include All method, about 30
Include method

assignment criteria inclusion method, 
about 30

criteria values, about using 137
inclusion-exclusion assignment criteria 

table 29
independent assignment mode, and 

multitiered assignment 
disabled 66

interactive assignment mode
about 44
applet classes, allowable 98
assignment objects, configuring for 97
business components, restrictions on 98
command-line interface, running from 174
configuring 98
running in overview 171
service requests, running for example 171
Siebel Dedicated Web Client, running 

Assignment Manager in 171
Siebel Dedicated Web Client, server 

component requirements 171

K
KeepLogDays parameter, about 180
key-based routing, about and use of 23

L
language

code criteria example 35
LastUsrCacheSz parameter, about 180
list columns, relation to assignment criteria 

attributes 115
lock assignment

activity assignment objects, setting 202
log level, setting 169
Log txn only on change parameter, 

about 167
LogTxnChgOnly parameter

batch assignment command-line interface 
parameter, about, 187

interactive assignment command-line 
interface parameter, about 174

mobile users, routing assignments to 199

M
MailServer parameter, about 180
MailTo parameter, about 180
Maximum MT Servers parameter, 
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about 167
Maximum Tasks parameter, about 167
MaxSkillsAge parameter, about 174
migrating assignment rules, about 127
Minimum MT Servers parameter, 

about 167
MinMTServers parameter, about 

setting 166
MLOV

See multilingual list of values (MLOV)
mobile assignment mode

about 45
mobile users, routing transactions to 199
running in 183

Mode parameter, about 178
multilingual list of values (MLOV)

assignment attributes. configuring for 110
workload criteria, about 41

multitiered assignment
See also multitiered assignment mode
employees, adding example 148
organization assignment, about 152
position assignment, about 151

multitiered assignment mode
See also multitiered assignment
independent assignment 66
organization and person-oriented assignment, 

about 67
organization-oriented assignment, if 

multitiered assignment is set 67
overview 66
person-oriented assignment, if multitiered 

assignment is set 66
multitiered assignment objects

about 43
configuration 104

N
nonrequired assignment criteria

about using 33

O
object types

configurable object types 88
field value and property relationships, 

diagram 90
hierarchy relationship diagram 89

Object WHERE Clause
creating 188
performance considerations 190
role of 188
running multiple Assignment Manager 

instances 190

ObjWhereClause parameter
batch assignment command-line interface 

parameter, about 187
interactive assignment command-line 

interface parameter, about 175
SRVRMGR utility, about running from batch 

assignment mode 188
One, Best Fit, assignment rule, about 20
One, Random, assignment rule, about 20
opportunities

territories, role of 62
territory definition list, modifying 63

Opportunity base table scoring configuration 
example 105

opportunity object example 194
Opportunity Workflow Policy Object

deactivated components 124
Org Primary column, using to stop 

assignment 201
organization and person-oriented 

assignment mode, and multitiered 
assignment 67

organization objects, role in visibility 17
organization-oriented assignment mode, 

and multitiered assignment 67
organizations

accounts, stopping assignment for 201
assignment rule, adding organizations 

to 151
comparison method, about 28
default assignment 152
default organization, suppressing 

assignment 201
denormalization of 47
employee multitiered assignment, about and 

example 148
multitiered assignment rules, using with sales 

assignment rules 66
multitiered assignment, about 152
overview 17
positions, about assigning based on parent 

organization 151
positions, assigning organizations based on 

and example 152
skills, associating with 154
workload criteria, defining for 145

P
PAR_OU_ID column, about value pointing to 

parent account 197
parameters

default parameters, modifying 92
parent�s primary address, assigning based 
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on child account 196
parent-child hierarchy, relationship 

diagram 89
performance tuning

assignment rules without criteria 29
batch assignment mode 189
dynamic assignment mode 183

person-oriented assignment mode, and 
multitiered assignment 66

picklists
assignment attribute, specializing in 108
Criteria list column, about using 113

position object
examples 198

positions
assignment rules, adding to 150
described 16
indirect positions 46
multitiered assignment, about 151
organization, assigning based on 152
parent organization, based on 151
position and employee-based assignments, 

creating 91
predefined objects, using 16
primary position, determining 46
skills, setting up 153
system-assigned positions, deleting 151
visibility for assigned object 150
workload criteria definition example 145
workload criteria, defining 144

post-configuration tasks, server 
administration requirements 170

predefined objects
sales objects, use of 16

Price List table, organization 
denormalization 47

primary address
assigning child accounts based on 194
assignment based on 195

primary position
determining 46
different position, reassigning accounts 

to 198
manually assigned primary position, 

maintaining 200
Product Defect Priority criteria value 139
Product Denormalization

mode, about and using 47
products, associating to organizations and 

price lists 47

Q
queries, assignment criteria 134

R
ReloadPolicy parameter, about 180
Remove parameter, about 178
repository

repository file, compiling 125
Requests parameter, about 180
rulecache.dat file

assignment rules, releasing 154
updating, about 164

S
sales organizations

assignment in 61
multiple criteria, about creating rules that 

combine 64
multitiered assignment rules, using with sales 

assignment rules 66
position candidates, use of 16
team candidates, about 17
territory definition list, modifying 63
territory-based assignment rules, 

creating 62
territory-based assignment rules, 

developing 64
territory-based assignment rules, 

example 62
sales team

See teams
Sample database, predefined assignment 

rules 91
Score list column, about 116
scoring

assignment scoring 39
criteria score 28
formula for assignment rules 58
sequences of rules, evaluating 26
sequences of rules, examples 26
team member scores 40
without criteria, role of 29
workload scoring, about 40

security, about controlling an organization 
security 17

seed assignment criteria, removing 108
server administration

Assignment Manager post-configuration 
tasks 170

dynamic mode requirements 175
interactive assignment mode, server 

component requirements 171
requirements by assignment mode 170

server key maps
about and used of 23
new server key map, defining 133
Siebel Assignment Manager Administration Guide Version 7.7226 ■



Index ■  T
Server Request Broker components
checking 165
interactive mode, checking server 

components 171
service organizations

assigning, about 68
Service Request base table, extending for 

availability-based assignment 101
Service Request object

configuring for interactive assignment 97
service requests

assigning, about 68
interactive assignment mode, running 

for 171
Siebel Dedicated Web Client

Assignment Manager, running in interactive 
mode 171

service requests, running interactive 
assignment mode in 171

Siebel Server, concurrent components, 
number of 166

Siebel Web Client
service requests, running interactive 

assignment mode in 171
skill scores, weighting 141
skill-based assignment attributes, 

about 107
skills

See also expertise codes
Assignment Manager, assigning a service 

request example 120
comparison methods 37
creating with expertise codes, 

example 140
criteria values, creating as skills 139
employee skills, associating with 153
new skill, creating 119
organization skills, associating with 154
position skills, setting up 153
predefined skills, viewing 118
role of 37
skill table, using 120
weighted expertise codes, defining 141

SmartScript, role in interactive 
assignment 97

.srf file, compiling instructions for 125
SRVRMGR utility

batch assignment mode, additional parameter 
characteristics 187

batch assignment mode, running from (about 
and parameters) 187

dynamic assignment mode, using to 
run 178

interactive assignment mode, using to 

run 174
system preferences, compatibility 

comparison 207

T
table compatibility used in Territory 

Assignment and Assignment 
Manager 208

TAMode parameter, about 178
teams

availability-based assignment rules, 
overview 149

availability-based assignment, about 42
described and example 17
team member assignment scores 40
team table, configuring assignment objects to 

copy additional columns to 203
territories

See also assignment rules
criteria, about creating rules that combine 

criteria 64
location and revenue-based, example 64
multitiered assignment, using with sales 

assignment rules 66
organization and person-oriented assignment, 

about 67
realignment, impact of 61
role in opportunity and account 

distribution 62
sales assignment rules, creating based on 

territories 62
sales assignment rules, creating that combine 

criteria 64
territory definition list, modifying 63
territory-based assignment rules, 

creating 62
views being phased out 62

territory assignment criteria, example of 
creating 138

territory assignment rules
creating 154
example of creating 137

Territory List, about phasing out 207
trace flags, about using 168
TrigFile parameter, about 178
triggers

assignment attributes 109
checking and editing 176
custom triggers, about creating 177
Generate Triggers, running 176
generating, about 175

tuning
batch assignment mode, performance tuning 
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in 189
dynamic assignment mode, performance 

tuning in 183

U
Use Expertise property, about setting 116
UseForUpdate parameter

batch assignment command-line interface 
parameter, about 187

interactive assignment command-line 
interface parameter, about 175

user properties
assignment criteria attributes (table) 117
Assignment Results BusComp, about showing 

additional properties 99

V
Values list

about and example 108
list column set, creation of 115

version comparisons
command line options used in Territory 

Assignment and Assignment Manager 
(table) 209

system preferences, between Territory 
Assignment and Assignment 
Manager 207

tables, compatibility of Territory Assignment 
and Assignment Manager 
tables 208

visibility, organizations, role of 17

W
weighting factors

defining, about and procedure 141
example 142
expertise codes, about applying to 38

wildcard characters

batch assignment mode SQL 
statements 188

criteria value, using with 138
workflow groups, setting for assignment 

policies 181
Workflow Monitor Agent

assignment policies, role in 180
role of 45
running 178
workflow groups, role of 180

workflow policy components
assignment attribute, mapping to 123
assignment criteria, mapping to 123
creating 122
Opportunity Workflow Policy Object, 

deactivated components 124
overview 121
record updating, inadvertent 185

workflow policy objects
assignment objects, adding 92
assignment objects, relation to 91

workload criteria
about 40
defining 142
employees and positions example 145
employees and positions, defining for 144
multilingual list of values (MLOV) 41
organizations, defining for 145
predefined fields (table) 145
predefined rules 143
team-based criteria 143

workload rules
assignment object matching 

requirement 143
creating 142
creating example of 143

workload score
about 40
formula 58
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